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WARNING
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WinCC/WebNavigator 1
1.1 WinCC/WebNavigator Installation Notes

1.1.1 General information

Product package   
You can find the following components for WinCC/WebNavigator on the WinCC DVD:

● WebNavigator server

● WebNavigator client

● WinCCViewerRT

● WebNavigator diagnostics client

● Web View Publisher

● WebNavigator Plug-In Builder

● Documentation

● Release notes

Note
Installation of WinCC/WebNavigator V7.4 is only released on the basis of WinCC V7.4

You cannot install the WebNavigator server/client of V7.4 on a computer with WinCC versions 
earlier than V7.4. Nor can a WebNavigator server/client version older than V7.4 be installed 
on a computer with WinCC V7.4.

Note that mixed use of European and Asian versions of WinCC and WebNavigator is not 
permitted in the configuration.

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
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1.1.2 Requirements

1.1.2.1 Hardware and Software

Introduction 
This section describes the hardware and operating system requirements for WinCC/
WebNavigator. 

Windows 10: Restricted release
Windows 10 only has restricted release. You can find detailed information in the Product 
Support under the entry number="109482899":

● Internet: Windows 10 for WinCC V7.4 - FAQ (http://support.automation.siemens.com/WW/
view/en/109482899)

Microsoft Internet Information Service (IIS)
Before installing the WebNavigator Server, you must first install the Internet Information 
Service (IIS).

Note

A WebNavigator server cannot be operated on a WinCC client without a project of its own.

WebNavigator client

Hardware

 Minimum Recommended
CPU Dual core CPU; 2 GHz Multi core CPU; 3 GHz
Work memory 1 GB 2 GB

WinCC/WebNavigator
1.1 WinCC/WebNavigator Installation Notes
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Software

Operating system Windows 10 64-bit (restricted release)
Windows 8.1 32-bit 
Windows 8.1 64-bit
Windows 7 SP1 32-bit
Windows 7 SP1 64-bit
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 R2 Standard 64-bit
Also other operating systems via MS Terminal Services
Windows Embedded Standard 7 P SP1 together with Panel PC 477E and IPC 427E

Software Internet Explorer as of V10.0 (32-bit)
WebNavigator client: For installation via Intranet/Internet, the latest cumulative security update for 
Internet Explorer must be installed. Additional information is available in the Microsoft Update 
KB3072449 (https://support.microsoft.com/en-us/kb/3072449).
If you want to use .NET and XAML controls, you will need to install .NET Framework 4.0.

Other Access to the intranet/Internet
or a TCP/ IP connection to the WebNavigator server
Operation of the WebNavigator client via Wireless LAN has been approved with SIMATIC Mobile 
Panel PC 12" only.

WebNavigator server on a WinCC single-user system

Hardware

 Minimum Recommended
CPU Dual core CPU; 2.5 GHz Multi core CPU; 3.5 GHz
Work memory 2 GB > 4 GB

Software

Operating system Windows 10 64-bit (restricted release)
Windows 8.1 32-bit 
Windows 8.1 64-bit
Windows 7 SP1 32-bit
Windows 7 SP1 64-bit
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 R2 Standard 64-bit

Software Internet Explorer as of V10.0 (32-bit)
WinCC basic system V7.4

Other Access to the intranet/Internet 
or a TCP/IP connection to the WebNavigator client 

WinCC/WebNavigator
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WebNavigator server on WinCC server or WinCC client with its own project

Hardware

 Minimum Recommended
CPU Dual core CPU; 2.5 GHz Multi core CPU; 3.5 GHz
Work memory 4 GB 8 GB

Software

Operating system Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 R2 Standard 64-bit

Software Internet Explorer as of V10.0 (32-bit)
WinCC basic system V7.4

Other Access to Intranet/Internet
If you wish to publish on the Intranet , you will need a system that converts computer names into 
IP addresses. This step allows users to use alias names instead of IP addresses when connecting 
to the server.
You will need DNS registration for your IP address if you wish to publish on the Internet . This step 
allows users to use alias names instead of IP addresses when connecting to the server.

WebNavigator diagnostics client

Software

Operating system Windows 10 64-bit (restricted release)
Windows 8.1 32-bit 
Windows 8.1 64-bit
Windows 7 SP1 32-bit
Windows 7 SP1 64-bit
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 R2 Standard 64-bit

Software Internet Explorer as of V10.0 (32-bit)
Other Access to Intranet/Internet

See also
https://support.microsoft.com/en-us/kb/3072449 (https://support.microsoft.com/en-us/kb/
3072449)

Internet: Windows 10 for WinCC V7.4 - FAQ (http://support.automation.siemens.com/WW/
view/en/109482899)

WinCC/WebNavigator
1.1 WinCC/WebNavigator Installation Notes

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
10 System Manual, 02/2016, A5E37537386-AA

https://support.microsoft.com/en-us/kb/3072449
https://support.microsoft.com/en-us/kb/3072449
http://support.automation.siemens.com/WW/view/en/109482899
http://support.automation.siemens.com/WW/view/en/109482899


1.1.2.2 Licensing

WebNavigator client    
No license is required for the PC on which the WebNavigator client is running, as server 
licenses are available on the WebNavigator server. 

WebNavigator server
As a prerequisite for the WinCC basic system, the WinCC RT basic license is required. No 
WinCC server license is required if no local WinCC clients are to be operated. Even when 
operating a WinCC client as a dedicated web server, you do not require a WinCC server license 
for the WinCC client. 

Licenses are available for 1 / 3 / 10 / 30 / 100 clients. If you have upgraded a WebNavigator 
version prior to V7.4, there may also be licenses for 5 / 25 / 50 / 150 clients.

The packages are version-independent and can be combined. Up to 150 clients can access 
the WebNavigator server simultaneously. 

A message will appear if the number of licensed clients is exceeded during a login attempt by 
a WebNavigator client. No further logins will be possible.

WinCC/WebUX clients
If the WinCC/WebUX option is also used in the WinCC system, a WebUX client can also occupy 
a WebNavigator license. This reduces the number of available WebNavigator licenses.

You can find more information in the documentation for WinCC/WebUX.

Test mode
If there is no WebNavigator license or if the license has been removed, the WebNavigator 
server runs in Test mode.

Test mode runs for a maximum of 30 days from the date of installation. Once 30 days have 
expired after the installation, the WebNavigator server can only be started with an installed 
license.

WebNavigator diagnostics client
A "Diagnostics client" license is required on the client computer for the diagnostics client. 

The diagnostics client can access on the WebNavigator server in the following cases:

● When the maximum number of simultaneous accesses has been reached on WebNavigator 
server.

● When no WebNavigator license is installed on the WebNavigator server.

WinCC/WebNavigator
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Note
Diagnostics client without corresponding license

If the diagnostics client is installed without the corresponding license, a message will appear 
about one hour after each start-up of the computer. Install the diagnostics client license or 
remove the diagnostics client software.
Computer with WinCC basic system and diagnostics client

If you install a diagnostics client on a computer with the WinCC basic system, you will have to 
reinstall the diagnostics client after removing WinCC.

Overview of licenses for WebNavigator server and client
You can combine WebNavigator and diagnostics licenses.

Server Client has no license 1) Client has diagnostics client 
license 1)

No WinCC license
No WebNavigator license

Client in test mode
Unlimited number

Client in test mode
Unlimited number

WinCC license
No WebNavigator license

Client in test mode
Unlimited number

Diagnostics client
One license per diagnostics 
client

WebNavigator license
No WinCC license

Client in test mode
Unlimited number

Client in test mode
Unlimited number

WebNavigator license
+ WinCC license

WebNavigator client
Number up to maximum of the 
server license

Diagnostics client
One license per diagnostics 
client

WebNavigator license
+ WinCC license
+ "Load Balancing" license

WebNavigator client
Number up to maximum of the 
server license

Diagnostics client
One license per diagnostics 
client

WebNavigator license
+ WinCC license
+ WinCC Redundancy license
+ "Load Balancing Step-Up" license

WebNavigator client
Number up to maximum of the 
server license

Diagnostics client
One license per diagnostics 
client

1) Note the behavior in test mode. Test mode runs for a maximum of 30 days from the date of installation.

Restarting the WebNavigator client after license modification
If the WebNavigator licenses on the WebNavigator server are modified, e.g. to a different 
number of clients, Internet Explorer must be restarted on each connected WebNavigator client, 
and the WebNavigator client must log in again. Otherwise, the WebNavigator client will switch 
to demo mode. This also applies to automatic reconnection of the WebNavigator client.

WinCC/WebNavigator
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Using WebNavigator versions prior to V7.4
WebNavigator versions up to V7.3 do not recognize licenses from WebNavigator V7.4 and 
higher.

Once you install the WebNavigator V7.4 licenses on a computer, a WebNavigator installation 
of a version prior to V7.4 can no longer be licensed.

This also applies if you upgrade to the new cumulative licenses through an upgrade license. 
The upgraded licenses are no longer recognized by WebNavigator V7.3 or earlier versions.

The upgrade to WebNavigator V7.4 cannot be reversed.

1.1.2.3 Requirements for the Use of Terminal Services
The WebNavigator client is released for Windows Terminal Services.  

A maximum of 150 sessions per terminal server are permitted.

Terminal server

Hardware

 Minimum Recommended
CPU Dual core CPU; 2 GHz Multi core CPU; 3 GHz
Work memory 1 GB 2 GB

Note

Each terminal client will increase the memory requirements and the processor load. You must 
therefore ensure that the terminal server has adequate memory and processor load capacity. 

Software

Operating system Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 R2 Standard 64-bit
It must be possible to repeatedly call and execute applications that 
are to be executed on the clients.

Miscellaneous: If many users want to access the server, you will need to use a high-
performance network card. 

Terminal client

Minimum requirement: Network card with TCP/IP
Terminal client RDP 5.0
Display or monitor
Pointing device

WinCC/WebNavigator
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Note

As with Windows Server CAL, there are two different CAL terminal services:
● The TS device CAL enables a device to run user-independent Windows sessions on a 

Windows Server.
● The TS user CAL enables a user to run device-independent Windows sessions on a 

Windows Server.

A Windows Server Terminal Server CAL "TS CAL" is required for every user or every device. 

Please go to "http://www.microsoft.com/resources/sam/lic_cal.mspx" for more information.

See also
http://www.microsoft.com/resources/sam/lic_cal.mspx (http://www.microsoft.com/resources/
sam/lic_cal.mspx)

1.1.3 Installing a WebNavigator server

1.1.3.1 Overview

Requirements
● The software requirements for the Windows operating system have been met.

● Local administrator rights.

● The WinCC basic system is installed.

NOTICE

WebNavigator server: Using a secure connection over HTTPS

To increase the security of your communication, configure the WebNavigator server in such 
a way that only HTTPS connections are supported. You need a digital certificate for your 
WebNavigator server for this. For more information, refer to "How to Set Up an HTTPS Service 
in IIS" in Microsoft Support:
● http://support.microsoft.com/kb/324069 (http://support.microsoft.com/kb/324069)

WinCC/WebNavigator
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Installation Overview
1. Installation of the Internet Information Server (IIS).

2. Installation of the WebNavigator server.

Note
WinCC options previously installed

If you have already installed other WinCC options prior to the installation of WinCC/
WebNavigator, you may have to re-install these options.

See also
Installing the Internet Information Server (IIS) (Page 15)

Installing the WebNavigator server (Page 17)

http://support.microsoft.com/kb/324069 (http://support.microsoft.com/kb/324069)

1.1.3.2 Installing the Internet Information Server (IIS)

Settings       
Before installing the WebNavigator server, you must first install the Internet Information Service 
(IIS). You specify the settings for the WebNavigator server during installation.

Activate the following settings:

● Web management tools:

– IIS management service

– IIS management console

– IIS management scripts and tools

– Compatibility with IIS Metabasis and IIS 6 configuration

– Compatibility with WMI for IIS 6

● WWW Services > Common HTTP Features or Shared HTTP Features:

– Standard document

– Static content

WinCC/WebNavigator
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● WWW services > Application development features:

– .NET extendibility

– ASP

– ASP.NET

– ISAPI extensions

– ISAPI filters

● WWW Services > security:

– Request filtering

– Basic Authentication

– Windows authentication

Note

If the logging functions are active with IIS, the log files must be monitored and deleted, if 
necessary. The event views should be configured so that the log files do not become too large.

Requirements
● Administrator rights

● Write access for the registration database

Procedure
1. Select "Programs and Features" from the Control Panel.

2. Click "Turn Windows features on or off" or "Add/Remove Windows Components".

3. Activate the settings specified above.

4. Close the dialog box with the "OK" button. The required data is transferred and the IIS is 
configured accordingly.

Alternative procedure
Alternatively, you can use the command line "Start > Run > cmd" to install the IIS components 
located on the installation data medium:

pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-
StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-ASP;IIS-
ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-WindowsAuthentication;IIS-
ManagementConsole;IIS-ManagementService;IIS-IIS6ManagementCompatibility;IIS-
Metabase;IIS-WMICompatibility
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Procedure for Windows Server 2008 R2 / 2012 R2
Configure the settings in the Server Manager using the "Webserver (IIS)" role in the associated 
role services.

1.1.3.3 Installing the WebNavigator server

Requirements           
● Local administrator rights

● The Internet Information Server is installed.

Procedure
1. Insert the WinCC DVD in the drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the autorun 
function is not activated, start the program Setup.exe on the DVD.

2. In the "Installation Type" dialog, select "Package Installation".

3. Select the "WebNavigator Server" installation.

4. Before the installation, the security settings that are adapted for WinCC are displayed in 
the "System Settings" dialog. The firewall is configured automatically. Confirm the changes 
to the system settings.

5. Start the installation.
You can track the status of the installation in the displayed dialog. Select "Cancel" to cancel 
the installation.

6. You can transfer the license key for the product after installation of the WebNavigator 
server. To do so, click on "Transfer License Key". Select "Next" if you have already 
transferred the license key or want to install it at a later time.

Note

License keys will not be transferred automatically. You will have to transfer missing license 
keys during or after installation with "Automation License Manager" .

7. Restart the computer when prompted to do so by setup.

Result
The WebNavigator server is installed and is displayed in the navigation window of the WinCC 
Explorer.
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1.1.4 Installing the WebNavigator client

1.1.4.1 Installing the WebNavigator client

Introduction               
You can install the WebNavigator client as follows: 

● Installation from the WinCC product DVD.
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation via the Intranet/Internet.
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation without user interaction:

– Using the Windows user rights of the current user

– Or in networks, using group policy-based software distribution

In addition, you can also install the WebNavigator client on the WebNavigator server. This is 
useful, for example, if you want to check the WinCC project locally on the server in Internet 
Explorer.

Note
.Net controls on the WebNavigator client 

If you wish to use .Net controls on the WebNavigator client, you need to install the .Net 
Framework 4.0 on the client from the WinCC product DVD.

WinCCViewerRT
The web viewer "WinCCViewerRT" is installed upon installation of the WebNavigator client.
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Procedure
1. Entry and check of the settings of the client computer in Internet Explorer.

2. Installation of the WebNavigator client.

Note

If you are installing from the DVD or using software distribution based on group policy, you 
can directly upgrade an older version of the WebNavigator client without having to remove 
the older client first.
If you install the WebNavigator server on a PC after the WebNavigator client, you will have 
to install the client again.
Plug-in reinstallation

The plug-ins "User Archive Control", "FunctionTrend Control", "Hardcopy" and "Web Client" 
are already integrated in the WebNavigator client as of version V7.0 upon installation.

If a WebNavigator client as of V7.0 is connected to a WebNavigator server older than V7.0 
(e.g. V6.2 SP3), you will be offered these plug-ins for installation in the download area of 
the Web navigation user interface.

The plug-ins are already installed. Do not reinstall these plug-ins.

Information on the setup and installation of the WebNavigator client:
● Before downloading and installing a new version on the WebNavigator client, check the 

languages installed on the client and connected server. Only the languages of the 
connected server will be available on the client computer following client installation by 
download.

● WebNavigator client setup will be interrupted with the error message "WinCC Active" if the 
local WinCC project is open or has been opened since the PC was last restarted. Restart 
the computer. Check whether WinCC has been included in the Autostart directory. Remove 
the entry if necessary and then restart the computer to execute WebNavigator client 
installation.

● You will need at least 70 MB of free memory space on the local hard disk to install the 
WebNavigator client. Otherwise, the MSI setup will cancel installation with a corresponding 
error message.

● When installing the WebNavigator client by downloading it from the Intranet/Internet, you 
can select to either "Open" or "Save" the setup file. The procedure you select upon initial 
installation of the WebNavigator client must also be selected for the subsequent installation 
of plug-ins or ActiveX controls. Otherwise, the "MSI Installer" service will output the error 
message "Error 1316".
Prior to installation via download, the latest cumulative security update for Internet Explorer 
must be installed. Additional information is available in the Microsoft Update KB3072449 
(https://support.microsoft.com/en-us/kb/3072449).

● In the download area of the Web Navigation user interface, the Plug-Ins which can be 
installed are displayed. The same minimum user rights are required for installing these plug-
ins as for installation of the WebNavigator client. If you select a plug-in in the Web 
Navigation user interface, WebNavigator client setup will start. You will have to confirm the 
selected plug-in again.
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Upgrading the WebNavigator client from a previous version
You can download and install the demo project from the "WinCC/WebNavigator and WinCC/
DataMonitor Demo Access" page at "www.wincc.de". The system checks whether the latest 
version of WebNavigator client is installed. If an older version is present, the WebNavigator 
client is also upgraded when you access the demo project.

Upgrade from WinCC V6.2 SP3
Perform a repair installation after upgrading from WinCC V6.2 SP3. To do so start the WinCC/
WebNavigator client installation with "Settings > Control Panel > Software" and select "Repair". 
Otherwise, controls may be reinstalled during operation. Restart the computer.

Installing the WebNavigator client under Windows Server
Installation of the WebNavigator client under Windows Server with a lower user authorization 
than "Administrator" is not possible in the default setting of group policies. 
Enable the installation of the WebNavigator client in the group policy by

● Assigning and making the software public

● Or activating the setting "Always install with elevated privileges" under "Administrative 
Templates / Windows Components / Windows Installer". You must activate "Never" for the 
"Deactivate Windows Installer" option.

See also
https://support.microsoft.com/en-us/kb/3072449 (https://support.microsoft.com/en-us/kb/
3072449)

1.1.4.2 User rights and user groups

Windows user rights required for installation and initial registration of the WebNavigator client
"Administrator" rights are required for installing the WebNavigator client via Intranet/Internet 
or using the product DVD. The initial registration of the client on the WebNavigator server must 
take place with the user identification used during installation and the same or higher Windows 
user rights. The connections must be established successfully. All subsequent logins can then 
be performed by users with different Windows user rights, which may be more restricted.

Windows user groups "SIMATIC HMI" / "SIMATIC HMI VIEWER"
Following WinCC installation, WinCC automatically establishes the following local groups in 
Windows User and Group Administration: 

SIMATIC HMI These members may create local projects, and may process, start, and access 
these projects remotely. Access to the WinCC database is limited to the minimum 
rights necessary (read/write).

SIMATIC HMI 
Viewer

These members have read access only to configuration and runtime data in the 
WinCC database.
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In the following cases you must add users of the WebNavigator client to a Windows user group:

● The WebNavigator client is installed on a PC on which WinCC is already installed:
Users of the Web client must be members of the user group "SIMATIC HMI VIEWER" or 
"SIMATIC HMI".

● The WebNavigator client accesses the WebNavigator server as "Remote Desktop" user:
Users of the Web client must be members of the user group "SIMATIC HMI VIEWER".

Installing the WebNavigator client with limited Windows user rights
The MSI technology used allows you to install the WebNavigator client even with limited 
Windows user rights. This procedure can be set during the installation using the group policy 
based software distribution in networks.

Even the add-ins and plug-ins for the WebNavigator client can be installed. "Administrator" 
rights are required for the installation of plug-ins that were created with the WinCC Plug-In 
Builder.

Installation for a configured group of users or computers
Using the Microsoft Systems Management server or group policy on a Domain Controller, it is 
possible to install a group of users or computers configured by the Administrator.

● For this the MSI file "WinCCWebNavigatorClient.msi" is published at the Domain Controller 
and enabled for a user group. Installation is then performed either during login of the defined 
users or when the computer is started, depending on the configuration of the group policy-
based software distribution.

● When using a Microsoft Systems Management Server, the installation is configured by the 
administrator, triggered and executed when the relevant computer boots.

Group policy-based software distribution
Software is normally installed with the access rights of the current Windows user. When using 
MSI technology, the installation is performed by an operating system service with a higher 
level of rights. This enables installations for which the Windows user does not have the 
necessary rights. Applications which require higher rights for installation are referred to as 
"privileged installations" in MSI technology. Installation of these applications is possible when 
a Windows user is assigned the "Always install with elevated privileges" permission. 

A group policy is created in the domain controller for use of group policy-based software 
distribution. The software to be distributed is then assigned or made public using Active 
Directory. 

● Assignment: Software distribution can be assigned to a user or a computer. The software 
to be distributed is automatically installed when the user logs in or the computer is started.

● Publication: The software distribution can be published for individual users. When the user 
logs on to the client computer, the software to be distributed appears in a dialog and can 
be selected for installation.
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1.1.4.3 Internet Explorer Settings

Introduction    
You have to adapt the Internet Explorer security settings in order to utilize full functionality of 
the WebNavigator Client. 

Procedure
1. Click "Tools > Internet Options" in Internet Explorer.

2. Select the "Security" tab.
Select the corresponding zone, for example, "Local Intranet" or "Internet".

3. Click "Custom Level...".

4. Enable the "Script ActiveX controls marked safe for scripting" and "Download signed 
ActiveX controls" options.

5. Enable "Active Scripting" under "Scripting".

6. Click "OK". Carry out the modifications in the subsequent dialog.

7. Click the "Trusted Sites" icon.
Click the "Sites..." button to open the "Trusted sites" dialog.

8. Enter the address of the WebNavigator Server in the "Add this website to the zone" field. 
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".
Deactivate the "Require server verification (https:) for all sites in this zone" option. 
Click "Add". Click "OK".

9. Click the "Trusted Sites" icon.
Click the "Standard level" button and then the "Custom Level" button. 
Enable "Initialize and script ActiveX controls not marked as safe". Click "OK".

10.Click on the "General" tab.
Click in the "Settings" area on the "Temporary Internet Files" button.
Enable the "Automatic" option under "Check for newer versions of stored pages:". 
Click "OK".

11.Close the "Internet Options" dialog by clicking "OK".

1.1.4.4 Installation from the DVD

Requirements   
● For the installation and use of the WebNavigator client, the information in Internet Explorer 

Settings (Page 22) applies.

● Depending on the operating system, specific minimum user rights are required to install 
the WebNavigator client; see User rights and user groups (Page 20).
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Procedure
1. Insert the WinCC DVD in the drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun 
function is not activated, start the program Setup.exe on the DVD.

2. In the "Installation Type" dialog, select "Package Installation".

3. Select the "WebNavigator Client" program package.

4. Before the installation, the security settings that are adapted for WinCC are displayed in 
the "System Settings" dialog. The firewall is configured automatically. Confirm the changes 
to the system settings.

5. Start the installation. You can track the status of the installation in the displayed dialog. 
Select "Cancel" to cancel the installation.

6. Restart the computer when prompted to do so by setup.

Result
The WebNavigator client is now installed and has been added as a function to the navigation 
window of the WinCC Explorer.

1.1.4.5 Installation via the Intranet/Internet

Requirements    
● For the installation and use of the WebNavigator client, the information in Internet Explorer 

Settings (Page 22) applies.

● Depending on the operating system, specific minimum user rights are required to install 
the WebNavigator client; see User rights and user groups (Page 20).

● The WebNavigator server must be installed on a computer. The Internet Information Server 
must be configured with the WinCC Web Configurator. The users must be registered in the 
WinCC User Administrator. The WinCC project must be in runtime.

● The latest cumulative security update for Internet Explorer must be installed. This applies 
to all installed versions of Internet Explorer.
See the following Microsoft article:

– https://support.microsoft.com/en-us/kb/3072449 (https://support.microsoft.com/en-us/
kb/3072449)

Procedure
1. Go to the address bar of Internet Explorer and enter the URL "http://www.servername" of 

the WebNavigator server. For installation in a virtual directory, the address can be as 
follows: "http:// www.servername/WebNavigator/".

2. Type in the user name and password.
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3. The first time you access the WebNavigator server, you will be prompted to install the 
WebNavigator client. Click the "Click here to install" link. Click the "Save" button in the "File 
Download" dialog to store the client setup on the target computer. It is recommended to 
save the Setup file because, in the event of a restart of the client computer being necessary, 
the Setup need not be downloaded again.

Note

If you have already installed the WebNavigator client and wish to install a more recent 
version via the Intranet/Internet, open the client setup straight away. You do not need to 
save the installation file on the target computer. Remove the old installation file first if you 
wish to save the new one. Alternatively, you can save the new version of the file in a different 
directory.

4. Leave the Internet Explorer open and open Windows Explorer. Navigate to the directory in 
which you saved the setup file. Start setup by double-clicking on the file.

5. Follow the instructions on the screen and enter the information and settings necessary. 
The client-side controls of the WebNavigator will be installed. Close the Setup dialog.

Result
Following successful installation, the WebNavigator client connects to the WinCC project 
currently in runtime. 

Note

If you want to use the on-screen keyboard, you also have to install .net 4.0. If you install the 
WebNavigator client from the WinCC DVD, .net 4.0 is already included.

See also
https://support.microsoft.com/en-us/kb/3072449 (https://support.microsoft.com/en-us/kb/
3072449)

1.1.5 Installing the WebNavigator diagnostics client

Introduction   
The software for the WebNavigator diagnostics client is installed on the client computer from 
the DVD.

Requirements
● To do this, you must have administrator rights.
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Procedure
1. Insert the WinCC DVD in the drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun 
function is not activated, start the program Setup.exe on the DVD.

2. In the "Installation Type" dialog, select "Custom Installation".

3. Select the "Diagnose Client" program in the Web Navigator" program group.

4. Before the installation, the security settings that are adapted for WinCC are displayed in 
the "System Settings" dialog. The firewall is configured automatically. Confirm the changes 
to the system settings.

5. Start the installation. You can track the status of the installation in the displayed dialog. 
Select "Cancel" to cancel the installation.

6. Restart the computer when prompted to do so by setup.

Result
The WebNavigator diagnostics client is now installed.

1.1.6 WebNavigator Demo Project

Introduction   
The WinCC Demo Project can be downloaded as a self-extracting ZIP file from:

● http://support.automation.siemens.com/WW/view/en/93148272 (http://
support.automation.siemens.com/WW/view/en/93148272)

Installation
To install the project, copy the file in a local target directory and start the decompressing 
process by double-clicking the file.

The following logins are already configured in the demo project:

WinCC Login Password
WebNavigator German winccd winccpass
WebNavigator English wincce winccpass
WebNavigator French winccf winccpass
WebNavigator Italian wincci winccpass
WebNavigator Spanish winccs winccpass
Terminal PocketPC PocketPC winccpass
Terminal Mobic Mobic winccpass
Terminal MP370 MP370 winccpass
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See also
http://support.automation.siemens.com/WW/view/en/93148272 (http://
support.automation.siemens.com/WW/view/en/93148272)

1.1.7 Deinstallation

Introduction
You can remove the WebNavigator server and WebNavigator client in the usual way, as in 
Windows. 

Procedure: Uninstalling via the WinCC Product DVD
1. Start the WinCC product DVD.

The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun 
function is not activated, start the program Setup.exe on the DVD.

2. Follow the on-screen instructions.

3. Select "Remove" as the setup type. 

4. Select the components that you want to remove.

Alternative procedure: Uninstalling via the Control Panel
1. Open the Windows "Control panel" under the Start menu.

2. Double-click on the "Programs" icon.

3. Click the "Change or Remove Programs" icon.

4. Select the WebNavigator server or client and click "Remove". Follow the instructions on 
the screen.

Result
The WebNavigator Server or WebNavigator client has now been removed from the computer.
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1.2 WinCC/WebNavigator Release Notes

1.2.1 Information about WebNavigator

Introduction
These release notes contain important information.

The statements in these release notes take precedence over information provided in the 
manuals and in the online help.

Please read these release notes carefully as they contain useful information.

Notes on the security of the system
For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should also 
be considered. You will find more information about industrial security under http://
www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity).

Security restrictions with the WebNavigator client

NOTICE

Security restrictions and response times in Internet Explorer

Please note the Internet-specific security restrictions when using the WebNavigator client. 
The WebNavigator client may take significantly longer (>20 seconds) than a regular WinCC 
client to recognize that the WebNavigator server is down or that the communication is faulty.

Using a secure connection over HTTPS
To increase the security of your communication, configure the WebNavigator server in such a 
way that only HTTPS connections are supported. 

You need a digital certificate for the WebNavigator server for this. Also use the SSL certificate 
on the WebNavigator client.

Detailed information is available in the Microsoft Support under "How To Set Up an HTTPS 
Service in IIS" (http://support.microsoft.com/kb/324069/EN-US (http://support.microsoft.com/
kb/324069)).
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Communication via proxy server
Please note the following for communication using a proxy server:

● The WebNavigator client must be a member of the server domain.

● If the users registered on the WebNavigator client have no access to the proxy server, logon 
to the proxy server with NTLM authentication is as follows:
1. The logon dialog for the proxy server appears.
2. The logon dialog for the WinCC user appears.
3. The logon dialog for the proxy server appears again.

Avoid cross-site request forgery for the WebNavigator
Cross-site request forgery is similar to the vulnerability caused by cross-site scripting (XSS, 
Cross Site Scripting). 

The attack is triggered when an authenticated user clicks on a malicious link. This vulnerability 
exists even if scripting is deactivated in the browser.

Siemens recommends:

● Do not work with other applications or services that have anything to do with the Internet.

● Log off when you do not need the WebNavigator any longer 

Defense in depth
See the notes on "Industrial Security" on the Siemens website:

● http://www.industry.siemens.com/topics/global/en/industrial-security/concept/Pages/
defense-in-depth.aspx (http://www.industry.siemens.com/topics/global/en/industrial-
security/konzept/Seiten/defense-in-depth.aspx)

General information about WebNavigator

Uninstalling WinCC: WebNavigator client must be installed later
If you uninstall WinCC, you will need to post-install the WebNavigator client.

Security settings in Internet Explorer: Installation via SSL connection
If you want to download the WebNavigator from an ASP portal via an SSL connection, note 
that the download is not possible under certain conditions. You can correct this with one of the 
following settings:

● Deactivate the "Do not save encrypted pages to disk" option in the "Advanced" tab for the 
Internet options of the Internet Explorer.

● Deactivate the "Internet Explorer Enhanced Security Configuration" option in the "Control 
Panel/Add/Remove Programs/Windows Components".
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Message after installation of a plug-in
The Program Compatibility Wizard may possibly output an message during installation of a 
plug-in. The plug-in is installed correctly. You may therefore acknowledge this message with 
"The program was installed correctly."

Project Change
Following a change of projects, a sporadic inoperable period of the Internet Information 
Services (IIS) may occur. The computer must then be restarted.

WebNavigator server: Configure a port other than the standard port "80"
When configuring the port in the WinCC Web Configurator, use "8080", for example, rather 
than the standard port "80".

WebNavigator server: Using the Trend Micro virus scanner in Windows 7 / Windows Server 2008 SP2
Operation of the Trend Micro "Office Scan" Corporate Edition V10.5 virus scanner in 
Windows 7 or Windows Server 2008 SP2 may have a negative impact on the performance of 
your WebNavigator Server.

WebNavigator client: Connection with the WebNavigator server with Windows Server 2008
In order to connect a WebNavigator client to a WebNavigator server as a "user", you must add 
the WebNavigator server as a trusted site.

WebNavigator client: Internet Explorer setting with Windows Server 2012
To allow the start screen to be loaded on Windows Server 2012 with the WebNavigator client, 
you need to disable the setting "Do not save encrypted pages to disk" in Internet Explorer 
under "Tools > Internet Options > Advanced".

WebNavigator client: "Protected Mode" with Windows 7
"Protected Mode" is not supported for the WebNavigator client under Windows 7.

WebNavigator client: Display of ActiveX controls in Internet Explorer       
ActiveX controls are disabled in Internet Explorer by default. For this reason, the WinCC 
controls are not displayed correctly in Internet Explorer on a WebNavigator client.

To display the WinCC controls correctly, add the Web server as a trusted website and enable 
the ActiveX controls only for the "Trusted sites" zone.

To continue protecting Internet Explorer from foreign ActiveX controls, check that the restricted 
security settings still apply to the other zones after making the changes.
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For more information, refer to the following documentation: 

● WinCC/WebNavigator: "WinCC/WebNavigator Installation Notes > Installation of 
WebNavigator Client > Settings in Internet Explorer"

WebNavigator client: Firewall settings for printing from WinCC controls
To be able to print out on the client, you need to define the following Firewall settings for the 
profiles used. The procedure is outlined based on the example of Windows 7:

1. Open "Control Panel > System and Security > Windows Firewall".

2. In the navigation bar, click "Allow a program or feature through Windows Firewall".

3. In the "Allowed programs and features:" list, activate the entry "File and printer sharing" for 
the relevant profile.

4. Return to the Windows Firewall start page. 

5. In the navigation bar, click "Turn Windows Firewall on or off".

6. If the Firewall is enabled, disable the setting "Block all incoming connections, including 
those in the list of allowed programs".

WebNavigator client: WinCC Computer with "Basic Process Control"
The plug-in "WinCC Basic Process Control" must be installed on the WebNavigator client if 
the client is connected to a computer with WinCC Basic Process Control. Without the plug-in, 
the functionality of WinCC Basic Process Control will not be available on the WebNavigator 
client. For example, the relevant ActiveX controls and the group display will not be available.

The plug-in is on the WebNavigator server in the "<wincc_installationpath>\WebNavigator
\Server\Web\Install\Custom" directory. You can download the plug-in via the WebNavigator 
navigation user interface from the download area.

A description of supported and non-supported functions may be found in WinCC Information 
System under "Options for Process Control > System Overview Process Control Options > 
Configuration in PCS 7 Environment > Web Client". 

If the WebNavigator client is to be installed on a dedicated web server with WinCC Basic 
Process Control, the plug-in "WinCC Basic Process Control" must be installed immediately 
after installation of the WebNavigator client. The download page for the plug-in is displayed. 
You will only be able to exit this page after installation of the plug-in for displaying the process 
pictures.

For more information on the supported functionalities of the WebNavigator client when 
connected to a PCS7 OS, please refer to the PCS7 documentation.  

WebNavigator client: Updating pictures with faceplates
To enable updating of changes to pictures with faceplates, you must enable the setting "Every 
time I visit the webpage" in the settings for temporary Internet files in Internet Explorer.
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WebNavigator client: Manual logoff with ODK function as of WinCC V7.2
Users can now also be logged off manually from the WebNavigator client with the ODK function 
"PWRTLogout()". You will find a description of this function in the ODK documentation under 
"ODK UserAdministrator/Functions for logging in/out".

WebNavigator client: ODK function "PWRTCheckPermissionOnPicture"
In order to use the ODK function "PWRTCheckPermissionOnPicture" on a WebNavigator 
client, install the plug-in "WinCC Basic Process Control" and "Advanced Process Control".

WebNavigator client: WinCC Alarm Control on a WebNavigator server in WinCC ServiceMode

Initial Situation
The WebNavigator client is connected with a WebNavigator server operated in WinCC 
ServiceMode.

Behavior
If you are using WinCC Alarm Control prior to WinCC V7 that is connected via a server prefix, 
you will not be able to open the selection dialog.

Solution
Use the WinCC AlarmControl that is offered as of WinCC V7.

WebNavigator client: Diagnostics file "WebNavReconnnect.log"
After installation of the WebNavigator client, the diagnostics file "WebNavReconnnect.log" will 
be saved in the "<User>\Application Data\Siemens\SIMATIC.WinCC\WebNavigator\Client" 
directory. The diagnostics file will be saved into the respective user profile so that this user no 
longer requires administrator rights. Under Windows 7 the directory will be available under 
"LocalLow". 

WebNavigator client: "FLAG_COMMENT_DIALOG" of the "GCreateMyOperationMsg" function
The WebNavigator client does not support the parameter "FLAG_COMMENT_DIALOG" for 
the "GCreateMyOperationMsg" function.
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Custom ActiveX controls (Industrial X)
Compatibility with WinCC and WebNavigator server or WebNavigator client must be ensured 
if custom ActiveX controls (Industrial X) are used:

● Direct installation of the ActiveX control on the computer with WinCC and WebNavigator 
server or client. You must install the ActiveX control before installing WinCC and the 
WebNavigator server or client. If the ActiveX control does not function without errors after 
this step, there is no compatibility.  

● Installation as a plug-in via the Web Navigation user interface on the WebNavigator client. 
If the ActiveX Control is packaged in a plug-in and installed via download, an upgrade of 
WinCC and the WebNavigator server or client will also require the generation of a new plug-
in using this ActiveX control. Ensure compatible binaries (DLL, OCX, etc.) are used when 
creating the plug-in.

See also
http://support.microsoft.com/hotfix/KBHotfix.aspx?kbnum=959658 (http://
support.microsoft.com/hotfix/KBHotfix.aspx?kbnum=959658)

http://support.microsoft.com/kb/959658 (http://support.microsoft.com/kb/959658)

http://support.microsoft.com/kb/324069 (http://support.microsoft.com/kb/324069)

http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity)

http://www.industry.siemens.com/topics/global/en/industrial-security/concept/Pages/defense-
in-depth.aspx (http://www.industry.siemens.com/topics/global/en/industrial-security/konzept/
Seiten/defense-in-depth.aspx)

1.2.2 Service and Support

1.2.2.1 Warnings

Safety notes
This manual contains information that must be observed to ensure your personal safety and 
to prevent property damage. Notices referring to your personal safety are highlighted in the 
manual by a safety alert symbol; notices referring to property damage only have no safety alert 
symbol. Depending on the hazard level, warnings are displayed in a descending order as 
follows:

DANGER

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.
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WARNING

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.

CAUTION

indicates that minor personal injury may result if proper precautions are not taken.

NOTICE

indicates that damage to property may result if proper precautions are not taken.

Note

is an important information about the product, the way to handle the product or the respective 
part of the documentation and we wish to especially bring this to your notice.

If multiple levels of hazards can occur, the warning is always displayed with the highest possible 
level. If a warning with a warning triangle is to be indicate physical injury, the same warning 
may also contain information about damage to property.

Qualified Personnel
The corresponding machine/ system may only be set up and operated with the help of this 
documentation. A device/system must only be commissioned and operated by qualified 
personnel. Qualified persons in the sense of safety instructions in this documentation stand 
for persons who are authorized to operate, earth and mark machines, system and electrical 
circuits according to safety standards.

Proper use
Please observe the following:

WARNING

Proper use

The machine may only be used for the application instances that have been described in the 
catalog and the technical description and only in combination with third-party devices and 
components recommended and/or approved by Siemens. Smooth and safe operations 
demand proper transport, proper storage, installation and assembling as well as careful 
operations and maintenance.

Brands
All names identified by ® are registered trademarks of Siemens AG. Third parties using for 
their own purposes any other names in this document which refer to trademarks might infringe 
upon the rights of the trademark owners.

WinCC/WebNavigator
1.2 WinCC/WebNavigator Release Notes

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 33



Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly that 
you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should also 
be considered. For more information about industrial security, visit

● http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity)

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit

● http://support.automation.siemens.com (http://support.automation.siemens.com)

Disclaimer of liability
We have checked the contents of the description to ensure that it matches with the hardware 
and the software it describes. Nevertheless, we cannot assume responsibility for any 
deviations that may arise. The details outlined in this description are checked regularly and 
the required corrections are done in the subsequent editions. Suggestions for improvement 
are welcomed.

The statements in the online documentation are more binding than the statements in the 
manuals and PDF files.

Please follow the Release Notes and Installation Notes. The information in these Release 
Notes and Installation Notes has priority over that in the manuals and online help with regard 
to legal validity.

Copyright © Siemens AG 2016
Änderungen vorbehalten / All rights reserved

It is prohibited to transfer, copy, evaluate or communicate this document in full or part unless 
the same has been explicitly approved. Violation of this rule can lead to claims for damage 
compensation. All rights reserved, especially for granting patents or for GM registration.

Siemens AG

Digital Factory

SIMATIC Human Machine Interfaces

P.O. Box 4848

D-90026 Nuremberg, Germany
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See also
http://support.automation.siemens.com (http://support.automation.siemens.com)

http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity)

1.2.2.2 Customer Support

Customer Support and Technical Support           
You can reach the SIMATIC hotlines at the times specified in the following table. The SIMATIC 
hotline employees speak German and English. The Authorization hotline offers French, Italian 
or Spanish customer support in addition to German and English.

Technical support

Nuremberg (GMT +1:00)
Service HoursMonday - Friday, 8:00 to 17:00 (CET/CEST)
Phone +49 (0)911 895 7222
Fax +49 (0)911 895 7223
E-mail http://www.siemens.com/automation/support-request  (http://

www.siemens.com/automation/support-request)

An overview of the Technical Support is available at the following URL:

● http://support.automation.siemens.com/WW/view/en/16605032 (http://
support.automation.siemens.com/WW/view/en/16605032)

Automation Value Card (AVC)
The Automation Value Card (AVC) provides extended Technical Support and is available 24 
hours every day of the week. Information on the AVC can be found at the following URL:

● http://support.automation.siemens.com/WW/view/en/28448132 (http://
support.automation.siemens.com/WW/view/en/21981898)

SIMATIC Customer Online Support 

Service and Support 
An overview of the support offering for our products is available at the following URL:

● http://www.siemens.com/automation/service&support (http://www.siemens.com/
automation/service&support)

In Product Support, for example, you will find downloads of firmware updates, service packs 
and useful utilities.

Online Help is available so that you can successfully use the Support offering. Open the Online 
Help by selecting the corresponding button on the Internet site or at the following URL:

● http://support.automation.siemens.com/WW/support/html_00/help/Online_Hilfe.htm (http://
support.automation.siemens.com/WW/support/html_76/help/Online_Hilfe.htm)
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WinCC FAQs
WinCC Online Support with information on FAQs (Frequently Asked Questions) may also be 
found at the following URL:

● http://support.automation.siemens.com/WW/view/de/10805548/133000 (http://
support.automation.siemens.com/WW/view/en/10805583/133000)

Technical Forum
The Technical Forum supports exchange with other SIMATIC users. It is available at the 
following URL:

● http://www.siemens.com/automation/csi/forum (http://www.siemens.de/automation/csi_en/
forum)

Technical documentation for SIMATIC products
You can find a guide to the technical documentation provided for individual SIMATIC products 
and systems at the following URL:

● http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-
doku-portal)

Contact person database
To contact your local agent, search our contact database at the following URL:

● http://www.automation.siemens.com/partner/index.asp (http://
www.automation.siemens.com/partner/index.asp?lang=en)

Product Information 

SIMATIC WinCC
Go to the following URL for additional information about WinCC products:

● http://www.siemens.com/wincc (http://www.siemens.com/wincc)

SIMATIC Products
Go to the following URL for additional information about SIMATIC products:

● http://www.siemens.com/simatic (http://www.siemens.com/simatic)

See also
Internet: Support Request (http://www.siemens.com/automation/support-request)

Internet: Technical support (http://support.automation.siemens.com/WW/view/en/16605032)

Internet: Automation Validation Card (AVC) (http://support.automation.siemens.com/WW/
view/en/21981898)

Internet: Service and Support (http://www.siemens.com/automation/service&support)

Internet: WinCC FAQs (http://support.automation.siemens.com/WW/view/en/
10805583/133000)

Internet: Support Technical Forum (http://www.siemens.de/automation/csi_en/forum)
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Internet: Support Search (http://www.siemens.de/automation/csi_en/km)

Internet: Support Online Help (http://support.automation.siemens.com/WW/support/html_76/
help/Online_Hilfe.htm)

Internet: Technical documentation for SIMATIC products (http://www.siemens.com/simatic-
tech-doku-portal)

Internet: Contact person database (http://www.automation.siemens.com/partner/index.asp?
lang=en)

Internet: Information about WinCC (http://www.siemens.com/wincc)

Internet: SIMATIC Products (http://www.siemens.com/simatic)

1.2.2.3 Support Request
Dear customer

In order to provide you with fast and effective support, please complete the "Support Request" 
form online on the Internet. Describe the problem in as much detail as possible. We would 
appreciate if you would provide us with all project data, so that we can reproduce the error 
situation or shorten the turn-around time.

Before filling out the support request, check whether your configured quantity structure is within 
the range of tested quantity structures (see topic "Performance Data").

Support Request form
The Support Request form is available at the following URL:   

● http://www.siemens.com/automation/support-request (http://www.siemens.com/
automation/support-request)

When filling out the report, you will be guided through several steps, which will ask about all 
required information.

A detailed description of the Support Request can be found at the following URL:

● http://support.automation.siemens.com/WW/view/en/16605654 (http://
support.automation.siemens.com/WW/view/en/16605654)

Procedure
1. Open the "Support Request" form using the link on the Internet. Step 1 "Select product" is 

displayed:

2. Enter the project name in the "Product/Order number" box. Upper/lower case is not relevant.
Search for parts of the product name or enter the full product name in the correct order. 
You can e. g. search for the following terms:
- "WinCC Runtime"
- "WinCC DataMonitor"
- "wincc webnavigator"
- "Connectivity"
The found products are offered in the "Product selection" field. 

3. Select the desired product and click on "Next" to switch to step 2 "Select use case".
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4. Select a use case or describe your specific use case in the "Other use case" field.

5. Press "Next" to switch to step 3 "Our solutions".
Suggested solutions and FAQs for the selected key words are listed.
Once you have found a suggested solution for your problem, you can close the form in the 
browser.
If you did not find any applicable suggested solutions, press "Next" to switch to step 4 
"Describe problem".

6. Describe your problem as exactly as possible in the "Details" field.
Pay particular attention to the following questions and comments. Please also check the 
WinCC installation and configuration with regard to the following references.
If you have any idea what has caused the error, please let us know. No detail should be 
omitted, even if you consider it unimportant.
- Was the configuration data created with older WinCC versions?
- How can the error be reproduced?
- Are other programs running simultaneously with WinCC?
- Have you deactivated the screen saver, virus checker and power management function?
- Search the computer for log files (WinCC\Diagnose\*.log, drwatson.log, drwtsn32.log). 
The log files are needed for error analysis. Thus, be sure to send the log files as well.

7. Use the "Search" button to upload your affected project and the log files (e. g. as a Zip file) 
to the Support Request.
Press "Next" to switch to step 5 "Provide contact information".

8. Enter your contact information.
Read the privacy notice and choose whether your personal data should be permanently 
saved.
Press "Next" to switch to step 6 "Summary & Send".

9. Press the "Print" button if you would like to print the support request.
You close the support request by clicking the "Send" button.
Your data will be transmitted to Customer Support and processed there.

Thank you for your cooperation. We hope that we can be of assistance in solving your problems.

Your WinCC Team 

See also
Internet: Error Report (http://www.siemens.com/automation/support-request)

Internet: Overview of Support Request  (http://support.automation.siemens.com/WW/view/en/
16605654)
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1.3 WinCC/WebNavigator Getting Started

1.3.1 First Web Project

Introduction 
WinCC/WebNavigator provides a solution for operator control and monitoring of the automation 
system via the Intranet and Internet. WinCC/WebNavigator offers you an easy and efficient 
way of implementing the operator control and monitoring functions of the WinCC project.

The optional "WinCC/WebNavigator" package consists of server components that you install 
on the WebNavigator server. You need the WebNavigator client components on the computer 
that you are using to control and monitor the process pictures that are displayed as in the 
WinCC basic system. For this purpose, use Internet Explorer or the "WinCCViewerRT" Web 
Viewer on the client.

WinCC/WebNavigator also contains the "WebNavigator Diagnostics Client" component. The 
functionality of this Diagnostics Client is no different from that of a WebNavigator client. The 
Diagnostics Client provides cost-effective and reliable access to one or several WebNavigator 
Servers for diagnostics purposes. 

Overview
This Getting Started is based on the WinCC demo project. For this example project, WinCC, 
WebNavigator Server and WebNavigator Client are installed on the same computer. 

Edit the WinCC project on the WebNavigator Server. Use the WebNavigator Client if you 
access the project with Internet Explorer or "WinCCViewerRT". 

Requirement
● The WinCC basic system is installed.

● You have installed the WinCC demo project. Information about its installation is available 
in the chapter "Information about installation of the WinCC demo project (Page 25)".

● WebNavigator Server is installed. Information about its installation is available in the 
"Information about installation of the WebNavigator Server" chapter.

WinCC/WebNavigator
1.3 WinCC/WebNavigator Getting Started

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 39



Procedure
Perform the following steps for the first Web project:

● Configure the WinCC project

– Publish the WinCC process pictures for web access

– Administer the users for WebNavigator Client

● Configuring the WebNavigator Server

– Configure the WebNavigator web page

– Configure the firewall

– Check the activated web page

● Operating the WinCC project

– Configure the Internet Explorer settings

– Install the WebNavigator Client and operate the WinCC project using Internet Explorer

– Set up WinCCViewerRT and operate the WinCC project using WinCCViewerRT

● Creating a new process picture and displaying it on the WebNavigator client

See also
Creating a new process picture (Page 60)

Installing the WebNavigator Client (Page 55)

Administering the users for WebNavigator Client (Page 46)

Starting the demo project (Page 48)

Installing a WebNavigator server (Page 14)

1.3.2 Configuring the WinCC project

1.3.2.1 Publishing process pictures

Introduction
If you wish to display WinCC process pictures on the WebNavigator Client, you must publish 
them first. For publishing the pictures, use the Web View Publisher, which automatically makes 
the necessary adjustments to the project data. 
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Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer.

Select the "Web View Publisher" command from the shortcut menu. The WinCC Web 
Publishing Wizard is now launched.

2. Click "Next".
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3. Select the WinCC project folder under "Path to your WinCC project".
Select the target folder for the published pictures under "Publishing folder of the WinCC 
Web". 
Accept the proposed folder within the WinCC project folder.
Click "Next". 
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4. Move the pictures that you wish to publish to the "Selected files" list.

Click "Next".
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5. Move the necessary C project functions to the "Selected files" list.

Click "Next".
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6. Move the graphics used in the process pictures to the "Selected files" list. The referenced 
files are in the "GraCS" folder or in subfolders of "GraCS".

Click "Next".

7. To start publishing the pictures, click "Finish".
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Result
The results list displays the status of all published objects. You can click an object to view 
additional object information. 

You have successfully published the pictures and functions.

1.3.2.2 Administering the users for WebNavigator Client

Introduction
In order to enable a user to access a WinCC project via a WebNavigator Client, you must 
assign the appropriate authorizations to the user in the WinCC User Administrator. You can 
select a different start picture and runtime language for each user. 
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Procedure
1. Right-click "User Administrator" in the navigation window of the WinCC Explorer. Select 

the "Open" command from the shortcut menu. 

2. You can use an existing user for the Web project. Select the user named "winccd" who has 
been assigned the login "winccd" and password "winccpass", for example, or create a new 
user based on this template.

3. If you want to create a new user, select the "New User" command in the shortcut menu of 
a group in the navigation area.

4. Specify the password for the new user in the "Password" column.

5. Select the new user in the table window of the User Administrator.

6. Select the "WebNavigator" check box in the data window. 

7. Select the start picture for the user, e.g. "winccPic.pd_", in "Web start picture" via the 
dropdown list. You can only select published pictures as start pictures.  

8. Select the Runtime language for the user in "Web language" via the dropdown list. The 
languages created in the Text Library are available for selection.
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9. Select the new user in the navigation window of the User Administrator. Select the required 
user rights by clicking in the "Authorization" column of the table window. If system 
authorization "Web access - monitoring only" has been enabled, the user is only allowed 
to monitor the WinCC project when acting as WebNavigator Client.

10.Close the User Administrator.

1.3.3 Configuring the WebNavigator Server

1.3.3.1 Starting the demo project

Introduction
You have copied the WinCC demo project to the computer. In this step, you set up the Web 
project for the computer that acts as both WebNavigator Server and WebNavigator Client.   

Procedure
1. Start WinCC by selecting "SIMATIC > WinCC > WinCC Explorer" in the Windows Start 

menu.

2. Open "DemoProjectV7".

3. Click "Start server locally" in the next dialog. The WinCC project can only be activated if 
your computer has been entered as an available server in the computer list.

4. Right-click "Computer" in the navigation window of WinCC Explorer and select 
"Properties...".

5. Click the "Properties" button in the dialog.

6. Enter the computer name in the "Computer name" field.

7. Click "OK". Restart the project to activate your changes.

8. Close the project by selecting "File > Exit".

9. Reopen the demo project to configure the WebNavigator Server.

See also
Configuring the WebNavigator web page (Page 48)

1.3.3.2 Configuring the WebNavigator web page

Introduction
The WinCC Web Configurator is used to set up and manage the Microsoft Internet Information 
Service (IIS). You will be creating a default web page in this step.
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Requirement
● The WebNavigator Server is installed.

● The Windows "Internet Information Service" component is installed.
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Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer.

Click the "Web Configurator" command in the shortcut menu. 
Click "Next" on the start page.

2. Enable the "Create a new standard web page (standalone)" option and then click "Next".
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3. Enter the name "WebNavigator" for the web page.

4. Select the default port "80" in the "Port" field.

5. Select an "IP address". Use only the addresses that are available in the selection list.
Select "All not assigned" to enable Intranet and Internet access to the computer.

6. Select "WebClient.asp" as the default web page.

7. Click "Finish" if you have not activated a Firewall.
Click "Next" if you have installed a Firewall.

Result
You have created the Web folder and activated the web page.   

1.3.3.3 Configuring the firewall

Introduction  
The chapter describes how to activate "HTTP" and "HTTPS" services for port "80" in Windows 7 
or in Windows Server 2008 R2.

Consult your network administrator if you want to set up the Windows Firewall with advanced 
security or for a different port.
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Requirement
● You have created a default web page with Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".

Procedure for the default port
1. Click the "Windows Firewall" button in the " WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Windows 7: Click "Allow a program or feature through Windows Firewall".
Windows Server 2008 R2: Click "Allow a program to communicate through Windows 
Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.
The server configuration is completed.
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1.3.3.4 Check the activated web page

Procedure for Windows 7 / Windows Server 2008 R2  
1. Select "All programs > Administration > Internet Information Services (IIS) Manager" from 

the Windows Start menu.

2. Click the computer name in the "Connections" field.

3. Click "Default Web Site".

4. Check the view of the web pages.
If the status "Stopped" is displayed next to the required web page, for example, 
"WebNavigator", start the web page.
Select the "Start" command from the shortcut menu to launch the web page.

5. Close the "Internet Information Services (IIS) Manager". The web page is activated.
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1.3.4 Operating the WinCC project

1.3.4.1 Operating the WinCC project with Internet Explorer

Internet Explorer Settings

Introduction    
You have to adapt the Internet Explorer security settings in order to utilize full functionality of 
the WebNavigator Client. 

Procedure
1. Click "Tools > Internet Options" in Internet Explorer.

2. Select the "Security" tab.
Select the corresponding zone, for example, "Local Intranet" or "Internet".

3. Click "Custom Level...".

4. Enable the "Script ActiveX controls marked safe for scripting" and "Download signed 
ActiveX controls" options.

5. Enable "Active Scripting" under "Scripting".

6. Click "OK". Carry out the modifications in the subsequent dialog.

7. Click the "Trusted Sites" icon.
Click the "Sites..." button to open the "Trusted sites" dialog.

8. Enter the address of the WebNavigator Server in the "Add this website to the zone" field. 
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".
Deactivate the "Require server verification (https:) for all sites in this zone" option. 
Click "Add". Click "OK".

9. Click the "Trusted Sites" icon.
Click the "Standard level" button and then the "Custom Level" button. 
Enable "Initialize and script ActiveX controls not marked as safe". Click "OK".

10.Click on the "General" tab.
Click in the "Settings" area on the "Temporary Internet Files" button.
Enable the "Automatic" option under "Check for newer versions of stored pages:". 
Click "OK".

11.Close the "Internet Options" dialog by clicking "OK".
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Installing the WebNavigator Client

Introduction
This chapter describes how to install the WebNavigator Client on the WebNavigator Server 
via Intranet/Internet.

Requirement
● The WebNavigator Server is installed.

● The "WinCC WebNavigator" license is installed.

● The WinCC project is in Runtime.

● The WinCC pictures are configured and published for web access.

● A user for the WebNavigator Client has been created in WinCC.

● Internet Explorer

Procedure
1. Go to the address bar of Internet Explorer and enter the URL "http://www.<servername>" 

of the WebNavigator Server.

2. Type in the user name and password, for example, "winccd".
The first time you access the WebNavigator Server, you are prompted to install the 
WebNavigator Client. Click on the link "Click here to install". 

3. Click "Save" in the "File Download" dialog to save the client setup to the target computer. 
Saving the client setup to the client computer saves you from having to download the data 
once again if you have to restart the client computer.

4. Select the destination folder for the setup file of the WebNavigator Client in the next dialog. 
 

5. Without closing Internet Explorer, open Windows Explorer. Navigate to the folder in which 
you saved the Setup file. Start the setup by double-clicking on setup.exe.

6. Follow the instructions on the screen and make the necessary entries and settings.

7. Select the "Complete" option in the "Setup type" dialog to install all components of the 
Client. Click "Next".

8. Click "Install" in the next dialog.

9. Click "Finish" in the "Install Wizard completed" dialog.

Result
On successful installation, the WebNavigator Client connects to the WinCC project currently 
in Runtime. The standard web page is displayed with the picture that you specified for the user 
in the User Administrator.
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During installation of the WebNavigator client, the "WinCCViewerRT" Web viewer is also 
installed. "WinCCViewerRT" is a viewing program that you can use in place of Internet Explorer 
to visualize the WinCC project.

1.3.4.2 Operating the WinCC project using WinCCViewerRT

Configuring WinCCViewerRT

Introduction           
WinCCViewerRT is a program for visualizing WinCC projects. You can configure 
WinCCViewerRT for operation with the WebNavigator Server and Graphics Runtime.

Requirement
● On the server

– The WebNavigator Server is installed.

– A WinCC/WebNavigator license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

● On the client

– The WebNavigator Client is installed.
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Procedure
1. Double-click the link "WinCCViewerRT.exe" in the "Webnavigator\Client\bin" installation 

folder.
The configuration dialog opens if you reconfigure WinCCViewerRT. 
WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> 
key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:

– Server address: http://<server name> or http://<IP address>

– User name and password, if you want to specify a default user for the login dialog.

– The user settings you configured in the User Administrator will be activated if you enable 
the "Apply project settings" option.

3. Specify the Runtime language in the "Parameters" tab.
If necessary, disable any key combinations with which the user switches to other programs. 
If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open 
the WinCCViewerRT configuration dialog.
Define a key combination with which a user can log off and a new user can log on. The key 
combination can only be used if no default user has been set in the "General" tab.
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4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
- Start picture
- Configuration file for user-defined menus and toolbars
- Window attributes
- Impermissible user actions

5. Specify additional user actions in the "Runtime" tab:

● Activating the screen keyboard

● <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating system 
via the screen keyboard.

● Auto-logoff settings

● Activating Direct2D to accelerate graphics representation.

● Specification of the printer with which you can print from the WinCC Controls using the 
configured print job. 

Close the dialog with the "OK" button.

Result
WinCCViewerRT is configured. The connection to the WebNavigator Server is set up after you 
close the dialog. The settings are saved to the "WinCCViewerRT.xml" configuration file. The 
configuration file settings are used at the next start of WinCCViewerRT. WinCCViewerRT 
applies the user interface language from WinCC.

The configuration file is saved in the folder "Documents and Settings\<User>\Application Data
\Siemens\SIMATIC.WinCC\WebNavigator\Client". You can rename the file, for example, to 
"User1.xml". You can also start WinCCViewerRT by means of the command line with the user-
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specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for 
different configurations, depending on the logged-on user. 

The WinCCViewerRT configuration dialog opens at the start if you rename or delete 
"WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

Note

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut 
or hide the "Close" button. Function in the C-Script: DeactivateRTProject; function in the 
VBScript: HMIRuntime.Stop.

Operating the WinCC project

Requirement       
● On the server

– The WebNavigator Server is installed.

– The "WinCC WebNavigator" license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

– The user is created in WinCC.

● On the client

– WinCCViewerRT is configured.

Procedure
1. Start "WinCCViewerRT" in the Windows Start menu with "Programs > Siemens Automation 

> Options and Tools > HMI Tools".

2. Log on to the WebNavigator Server:

– A login dialog is not displayed if the user name and password is preset in the 
"WinCCViewerRT" configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
"WinCCViewerRT" configuration dialog. Enter the user name and password of the 
WinCC user. Passwords are case-sensitive. Click "OK".

3. To change the user, use the specified key combination for "WinCCViewerRT" login/logoff. 
The previous user is logged off. Enter the user name and password of the new WinCC user 
in the login dialog. Passwords are case-sensitive. Click "OK".
The key combination can only be used if no default user has been set.
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Result
WinCCViewerRT automatically connects to the activated WinCC project. The start picture that 
is configured for the user is displayed. 

The user may operate or monitor the project, depending on authorizations. Users assigned 
system authorization No. 1002 "Web access - monitoring only" in the User Administration are 
only allowed to monitor the WinCC project.

The "View Only Cursor" indicates that process-related operations are not possible. 

Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, 
are still possible. 

You can also use your own cursor icon as a "View Only Cursor", if required. For more 
information, refer to "Configuring Runtime settings (Page 85)".

The <F5> key triggers a reselection of WinCCViewerRT.

1.3.5 Creating a new process picture and displaying it on the client

1.3.5.1 Creating a new process picture

Introduction
Configure a new process picture for the web project on the server. Create a trend window that 
displays the measured values from the archive of the WinCC demo project. 

Requirement
●  The WinCC demo project is open.
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Procedure
1. Click "Graphics Designer" in the navigation window of WinCC Explorer. Right-click in the 

data window and select the " New picture" menu command.

2. In the object palette of Graphics Designer, double-click "WinCC OnlineTrendControl" on 
the "Controls" tab. The control is inserted into the picture and the configuration dialog opens.
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3. Click the "Trends" tab. Click  at the tag name in the "Data connection" field. Select the 
"Measured values" archive and "T01" tag in the "Archive/tag selection" dialog.

4. Click "OK". The measured values from "T01" are linked to the trend.

5. If required, configure additional properties of the trend or control.

6. Save the control under the name "NewTrend.pdl" and close Graphics Designer.

WinCC/WebNavigator
1.3 WinCC/WebNavigator Getting Started

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
62 System Manual, 02/2016, A5E37537386-AA



Result
You have successfully created a trend window in a picture on the WebNavigator Server. In 
order to display the trend window on the WebNavigator Client, you must publish the picture 
and assign it to a user as start picture. 

See also
Configuring a new process picture for the web (Page 63)

1.3.5.2 Configuring a new process picture for the web

Introduction
In order to display the trend window on the WebNavigator Client, you must publish the picture 
and assign it to a user as start picture.

Requirement
● The WinCC demo project is open.

● You have successfully created a trend window in a picture on the WebNavigator Server.

Procedure
1. Right-click "WebNavigator" in the navigation window of the WinCC Explorer. Select the 

"Web View Publisher" command from the shortcut menu.

2. Select the new "NewTrend.pdl" picture in the "Files" field of the "Select pictures" dialog of 
the Publishing Wizard. Move the file to the "Selected files" list.

3. Follow the further instructions of the Publishing Wizard. The picture is published after you 
have completed the Wizard.

4. Right-click "User Administrator" in the navigation window of WinCC Explorer and select the 
"Open" command from the shortcut menu.

5. Select the user with whom you wish to display the new trend window from the navigation 
window of the User Administrator.

6. Select the "WebNavigator" check box in the table window. The "Web Options" area is 
displayed.

7. Click "..." to select the "NewTrend.pd_" start picture.

8. Close the User Administrator.

Result
You have successfully configured the picture that contains the trend window for visualization 
on the WebNavigator Client.   
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See also
Displaying the process picture on the WebNavigator Client (Page 64)

Administering the users for WebNavigator Client (Page 46)

Publishing process pictures (Page 40)

1.3.5.3 Displaying the process picture on the WebNavigator Client

Introduction  
You want to display the new process picture on the WebNavigator Client Use the 
"WinCCViewerRT" Web Viewer for this example.

Requirements
● The WebNavigator Server and the "WinCC WebNavigator" license are installed.

● The user is created in WinCC.

● A process picture is created in WinCC.

● The process picture is published and assigned to the user as start picture.

● The WinCC project is in Runtime.

● WinCCViewerRT is configured.

Procedure
1. Select the "Start > Programs > Siemens Automation > Option and Tools > HMI Tools > 

WinCCViewerRT" command in the Windows Start menu.

2. Log on to the WebNavigator Server:

– A login dialog is not displayed if the user name and password are set in the 
"WinCCViewerRT" configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
"WinCCViewerRT" configuration dialog.
Enter the user name and password in the "General" tab. Click "OK".

3. You can use the preset <Ctrl+Alt+P> key combination to change the user. The 
"WinCCViewerRT" configuration dialog opens.
Enter the user name and password in the "General" tab. Click "OK".
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Result
The trend window is displayed in the "WinCCViewerRT" Web Viewer. The trend values are 
loaded from the archive.

See also
Configuring WinCCViewerRT (Page 56)

Operating the WinCC project (Page 59)
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1.4 WinCC/WebNavigator Documentation

1.4.1 Function overview

Introduction             
WinCC/WebNavigator provides a solution for operator control and monitoring of the automation 
system via the Intranet and Internet. WinCC/WebNavigator offers you an easy and efficient 
way of implementing the operator control and monitoring functions of the WinCC project.

Current Internet security methods are supported. Use SSL encryption to increase Internet 
security.

The optional "WinCC/WebNavigator" package consists of the following components: 

● WebNavigator server

● WebNavigator client

● WebNavigator diagnostics client

WebNavigator server
All necessary WinCC pictures and functions that are displayed on the WebNavigator Client 
are stored on the WebNavigator Server. The Web View Publisher automatically makes the 
required adaptations to the project data that is necessary for the web. This ensures the best 
possible performance.

The WebNavigator Server needs Microsoft Internet Information Service (IIS) for 
communication with the WebNavigator Clients. The IIS is set up and managed using the 
WinCC Web Configurator.

The "Load Balancing" function allows you to automatically distribute the WebNavigator Clients 
evenly to different WebNavigator Servers, in accordance with the respective server license.

WebNavigator client
The WebNavigator Client is started in Internet Explorer with enabled ActiveX controls. You 
can operate and monitor a current WinCC project without the entire WinCC basic system 
having to be installed on the computer.

You control access of the WebNavigator Clients in the user administration. A different start 
picture and language can be selected for each user. You can enable scalable access to 
different project areas and functions for individual users by assigning user authorizations. 

The "WinCCViewerRT" Web Viewer program is used for visualization of web projects only. 
The program can be used in place of Internet Explorer to visualize the WinCC project.
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WebNavigator diagnostics client
The WebNavigator Diagnostics Client is particularly useful for the following activities:

● Remote diagnostics and operator control of multiple unmanned WinCC stations.

● Central remote maintenance using a Diagnostics Client to monitor several WebNavigator 
Servers.

● For Power Users who need guaranteed server access at all times. 

The functionality of this Diagnostics Client is no different from that of a WebNavigator client. 
However, the Diagnostics Client provides guaranteed access to the WebNavigator Servers at 
all times. Access is independent of the number of users already logged on to the WebNavigator 
Server.

The Diagnostics Client licensing provides you with a cost-effective solution for accessing many 
WebNavigator Servers using one or a few WebNavigator Clients. You can combine 
WebNavigator and diagnostics licenses.

1.4.2 Possible applications of WinCC/WebNavigator

1.4.2.1 WebNavigator Server on the WinCC Server

Linking WebNavigator Clients and WinCC projects via Intranet/LAN     
The WinCC Server and the server component of the Web Navigator are installed on the same 
computer. The WebNavigator Clients operate and/or monitor the current server project via 
Intranet/LAN in an isolated solution.

This cost-effective solution allows you to set up computer stations, for example, for the purpose 
of monitoring or maintenance. It is not necessary to install the complete WinCC system on 
these computers.

Linking the WebNavigator Clients and WinCC projects via Internet and Intranet
The WinCC Server and the server component of the Web Navigator are installed on the same 
computer. The WebNavigator Clients are able to operate and/or monitor the current server 
project via Internet and Intranet.

Two Firewalls are employed to protect against malicious attacks from the Internet. The first 
firewall protects the WebNavigator Server against an attack from the Internet. The second 
Firewall provides additional security for the Intranet.
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1.4.2.2 Separation of the WinCC and WebNavigator servers

Communication via a channel       
A group of automation systems is assigned to the WinCC Server. The project includes all data 
such as programs, configuration data and miscellaneous settings. On the computer that 
contains the WinCC and WinCC WebNavigator servers, the WinCC project is mirrored 1:1 and 
not networked with the automation systems.

Data is synchronized via the OPC channel. For this purpose, the WinCC WebNavigator Server 
needs a license for the number of OPC tags.

Two firewalls are employed to protect the system against unauthorized access. The first firewall 
protects the WebNavigator Server against an attack from the Internet. The second firewall 
provides additional security for the intranet.
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Communication via the process bus
On the computer that contains the WinCC and WinCC WebNavigator servers, the WinCC 
project is mirrored 1:1. Data is synchronized via the process bus. Two firewalls are employed 
to protect the system against unauthorized access.

1.4.2.3 Dedicated Web Server

Introduction    
Installation of a dedicated web server is advantageous in larger-scale systems for the central 
data supply to the WebNavigator Clients. The dedicated web server processes and optimizes 
client access and is available to the clients as a proxy of the WinCC servers. 

The functionality of the dedicated web server is provided by the installation of the 
WebNavigator server on a WinCC client.
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Advantages of using a dedicated web server
● The load can be distributed over several dedicated web servers in order to enhance the 

performance of the complete system.

● The physical separation of the dedicated web server and the WinCC server on different 
computers increases security.

● Operation of the servers on different stations also permits the separation of operational 
functions, for example, plant support and the IT department.

● The dedicated web server is able to provide simultaneous access to several subordinate 
WinCC servers. Users logged on to the dedicated web server can access several WinCC 
projects, without having to log on separately for each project.

● The dedicated web server supports redundancy switchover between two subordinate 
WinCC servers with WinCC Redundancy.
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1.4.2.4 WinCCViewerRT

Overview
You run the "WinCCViewerRT.exe" application instead of Internet Explorer on the 
WebNavigator Client. WinCCViewerRT is installed with the WebNavigator Client.

The example of WinCCViewerRT is that you do not need the browser. You therefore protect 
the system against virus or Trojan attacks.

The viewer only displays the pictures that you configured for web access and published on the 
WebNavigator Server. The user may operate or monitor the project, depending on 
authorizations. Users assigned authorization 1002 "Web access - monitoring only" in WinCC 
are only allowed to monitor the project. The WebNavigator Client is therefore a so-called "View 
Only Client". 

The "View Only Cursor" indicates that process-related operations are not possible. Certain 
operations, such as opening the properties dialog of the WinCC OnlineTrendControl, are still 
possible. 

You can also use WinCCViewerRT as terminal services application. For more information, 
refer to "Configuring terminal services for WebNavigator Server".

See also
Configuring terminal services for WebNavigator (Page 129)

1.4.2.5 WebNavigator Diagnostics Client

Overview         
The WebNavigator Diagnostics Client provides cost-effective access to several WebNavigator 
Servers. Several Diagnostics Clients and standard clients can be used simultaneously.

Licensing
This process does not demand an additional license for WebNavigator Server. Licensing is 
handled on the Diagnostics Client.

The diagnostics client can always access the WebNavigator server, regardless of whether or 
not the maximum number of simultaneous logins to the WebNavigator server has been 
reached. Diagnostics Client access to the WebNavigator Server is always guaranteed.

Applications
Possible applications include:

● Remote maintenance: The Diagnostics Client is used for consecutive access to different 
WinCC systems for the purpose of service and maintenance.

● Central maintenance: The Diagnostics Client is used for simultaneous access to several 
servers.
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1.4.2.6 Terminal services and WebNavigator

Introduction      
The terminal services of Windows server operating systems provide access to the desktop of 
a Windows server. The Terminal Client provides screen output while the application, for 
example, WinCCViewerRT, is active on the Terminal Server.

The Terminal Services only transfer the user interface of the application to the clients. Each 
client's keyboard inputs and mouse operations are returned back to the server.

For information on redundant system configurations with the Terminal Services, refer to the 
corresponding Microsoft documentation.

Advantages of the Terminal Services
● Use of robust hardware with low memory requirements for the clients, for example, without 

fans and hard disk in a dusty environment.

● Use of mobile clients with limited power consumption, e.g. handhelds, Palmtops, or PDAs.

● All applications are located on the server in a secure environment.

● Simple, central administration and system maintenance.

● Support of different operating systems, e.g. Windows CE, Windows 95.
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1.4.3 Configuring the WebNavigator system

1.4.3.1 Overview of the configuration steps

Requirement     
● The server and client are interconnected via TCP/IP.

● On the server

– Internet Information Service is installed.

– The WebNavigator Server is installed.

– A license key is installed.

– WinCC is installed.

● On the client

– Internet Explorer is installed.
or

– WinCCViewerRT is installed.

Basic procedure
It is necessary to complete the following configurations in order to set up the WebNavigator 
system:

1. Configuration of the WinCC project.

– Publish the WinCC process pictures for web access

– Configure web settings

– Create and administer users for access of the WebNavigator Client.

2. Configuration of the WebNavigator Server.

– Configure the WebNavigator web page.

– Configure the "Load Balancing" function, if necessary.

3. Consideration of the differences compared to the WinCC basic system and of restrictions.
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1.4.3.2 Configuring the WinCC project

Publishing WinCC process pictures

Publishing WinCC Process Pictures

Introduction         
If you wish to display WinCC process pictures on the WebNavigator Client or DataMonitor 
Client, you have to publish the pictures. For publishing, you use the Web View Publisher, which 
automatically makes the necessary adaptations to the project data. 

Overview
The Web View Publisher enables the following types of publishing: 

● Publishing on the local computer.
The current WinCC project folder is the source folder.
The target folder is a subfolder, for example, "Projectname/WebNavigator/Pictures".

● Publishing on a dedicated web server with a server prefix.
The source folder is the WinCC project folder on another WinCC computer that is defined 
by the server prefix.
The target folder is located in subfolder ".../WebNavigator/Pictures" of the WinCC project 
on the WinCC Client. The pictures of your own project are saved with the name 
"<picturename>.PD_", while the pictures of other projects are saved with the name 
"<serverprefix>_ _<picturename>.PD_".

● Remote publishing.
The source and target folders can be located on the same or different web servers.
You can start the Web View Publisher on the web server with the source and target folder 
or on a third web server.

● Remote publishing on a dedicated web server or WinCC Client from a different remote 
station.
The project folder of the WinCC project must be released in Windows on the dedicated web 
server/WinCC Client. You can start the Web View Publisher remotely by opening the WinCC 
project of the web server/WinCC Client on the remote computer. On the remote station, 
you publish the WinCC pictures from other WinCC Servers to the dedicated web server.

The Web View Publisher performs the following adjustments:

● Compression of the data for optimizing performance on the Internet.

● Removal of project-specific data that is not required for the operation.

● Conversion of picture windows into an ActiveX component.

● Conversion of scripts so that they can be run on the Client.
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Publication of pictures with faulty scripts
If warnings or errors are generated during publishing, the process pictures affected are marked 
in the output field of the Web Publishing Wizard. The pictures with errors in the scripts are 
nonetheless published. However, errors can still occur in Runtime and are reported by the 
WebNavigator Client. 

The "PdlPad" tool can be started directly in the Web View Publisher in order to check and, if 
necessary, correct the scripts used in the published pictures.

Publishing Without Project Functions
Publishing without project functions can be an additional source of error. When publishing with 
the Web View Publisher, the selected project functions are always published. When published 
without project functions, the pictures no longer contain any project functions. The project 
functions of the last publishing process are always available in the published pictures and, 
therefore, on the client. 

The selection of project functions in the Publisher is independent of the pictures published in 
the same process. If , for example, you modify selected project functions but not their 
interfaces, you need to publish all necessary project functions. In this case, you do not have 
to publish the picture.

Changing the process picture in Graphics Designer
Process pictures that you edit in runtime in Graphics Designer on the WebNavigator Server 
must be published once again. This is required for the process picture to be displayed on the 
WebNavigator Client.

When using a dedicated web server, open the WinCC project on that server from a remote 
station in order to transfer the changes to the WebNavigator Client. On completion, open and 
save the modified picture in Graphics Designer. Publish the picture in the next step using Web 
View Publisher on the dedicated web server. 

If you have modified a large number of pictures, you can simplify this process. For this purpose, 
call the "Convert pictures" function in the shortcut menu of Graphics Designer. On completion, 
you once again have to publish the pictures.

See also
How to publish WinCC process pictures using Web View Publisher (Page 77)

Requirements for publishing pictures (Page 76)

Requirements for publishing pictures

General requirements             
● The picture names may not contain double underscores, e.g. "__furnace_overview.pdl". 

The string before the double underscore will be interpreted as server prefix.

● The package names and/or symbolic computer names may not contain any double 
underscores.
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● The package names and/or symbolic computer names may not end in an underscore.

● Moreover, the name cannot begin with a single underscore if you are using Basic Process 
Control. When using Picture Tree Manager, the name string of higher-level pictures will 
have a "@PTN_" prefix. With the leading underscore, the picture name will then have a 
double underscore.

● If two header files of the same name exist in the project path and in the installation path of 
WinCC, Web View Publisher will use the header file from the installation path.

Requirements for publishing on a dedicated web server
● The Web Navigator Server is installed on the WinCC Client.

● The C and VB scripts of all WinCC servers to which the WinCC Client has access have 
been copied to the WinCC Client.

● The WinCC server packages that the WinCC Client can access are loaded on the WinCC 
Client.

● If you wish to publish projects on other computers, these computers must be linked by 
means of network drive before you start Web View Publisher. This procedure enables the 
display of your projects in the selection dialog of the Publisher. You cannot enter the path 
directly.

Requirements for remote publishing
● Access to the target and source folders is enabled for Web View Publisher.

WinCC configures these Windows enables by default. Verify that these enables are not 
restricted, for example, valid for specific users only.

● If you wish to publish projects on other computers, these computers must be linked by 
means of network drive before you start Web View Publisher. This procedure enables the 
display of your projects in the selection dialog of the Publisher. You cannot enter the path 
directly.

See also
Publishing WinCC Process Pictures (Page 75)

How to publish WinCC process pictures using Web View Publisher (Page 77)

How to publish WinCC process pictures using Web View Publisher

Introduction                       
Use Web View Publisher to publish the process pictures that you created in Graphics Designer. 
The WinCC Web Publishing Wizard supports you during publishing. 
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Procedure
1. Select "Web Navigator" in the navigation window of WinCC Explorer.

Select the "Web View Publisher" command in the shortcut menu.
The WinCC Web Publishing Wizard is now launched.

2. Click "Next".

WinCC/WebNavigator
1.4 WinCC/WebNavigator Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
78 System Manual, 02/2016, A5E37537386-AA



3. Activate the "Server prefix" option if you want to publish the pictures on a dedicated web 
server.
Select the prefix of the WinCC Server that contains the WinCC project from the selection 
list. The list displays the prefixes of the servers whose packages are loaded on the WinCC 
Client.
Deleting a prefix from the selection changes the paths displayed in the fields below.

4. Under "Path to your WinCC project", select the WinCC project folder containing the pictures 
you want to publish.
The folder has the following format for publication on a dedicated web server:
"\\<servername>\<serverprefix>_ _<projectname>".
If you want to publish from a remote station, select the source project containing the pictures.
The source project is displayed by its enable name on the other WinCC Server.
The folder has the following format:
"\\<computer name>\<enable name>".

5. Select the target folder for the published pictures under "Publishing folder of the WinCC 
web".
Accept the proposed folder within the WinCC project folder.
Do not change the path specification unless you want to transfer pictures to a different 
project, for example. In this case, the prefix selection list will be expanded accordingly.
Verify the specified target project to which the published pictures are saved during remote 
publishing.   
The path definition will be updated when you select the source project.
Should the target project be located on another WinCC server, select the corresponding 
project.

WinCC/WebNavigator
1.4 WinCC/WebNavigator Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 79



6. Select the "Display hidden objects" option to show hidden objects that are published 
automatically in the results list.

7. Click "Next". Move the pictures that you wish to publish to the "Selected files" list.
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8. Click "Next". Move the C project functions which you use in the published pictures to the 
"Selected files" list. You cannot publish individual VB scripts.

Click "Next". 
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9. Move the referenced graphics that you wish to publish to the "Selected files" list. The 
referenced files are in the "GraCS" folder or in subfolders of "GraCS".

Click "Next". 

10.Click "Exit" to start publishing the pictures.
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Result
You have successfully published the pictures and functions. The results list displays the status 
of all published objects. You can click an object to view additional object information. 

You can trace publishing using the "<projectfolder>\WebNavigator\WizardLog.txt" file.
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Checking the scripts using "PdlPad"
The "WizardLog.txt" log file contains information about errors in the scripts used. You can also 
find errors using the "PdlPad" debugger. 

1. Open "PdlPad" by double-clicking on the affected object in the results list of Web View 
Publisher. The script of the published picture is displayed.

2. Click  in order to check the script.

3. You can temporarily correct and save the scripts. These corrections are only saved to the 
published pictures, not in the process picture of the WinCC project.

"PdlPad" can also be opened in the Windows Start menu via "SIMATIC > WinCC > 
WebNavigator-Server".

See also
Publishing WinCC Process Pictures (Page 75)

Requirements for publishing pictures (Page 76)
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Configuring web settings

Configuring runtime settings

Introduction         
You can configure the behavior in Runtime in the "WinCC web settings" dialog.

Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web 

settings" command from the shortcut menu.

2. Change to the "Runtime" tab in the "WinCC web settings" dialog.
Select the required settings. Close the dialog with "OK".
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Use "WinCC Classic" design
Select this option to improve the performance of the WebNavigator Client. The original style 
of WinCC V6 is now used.

"Monitoring only" cursor
A default cursor shows that the user of the WebNavigator Client is not allowed to operate 
Runtime. The user has been assigned system authorization no. 1002 - "Web access - 
monitoring only" in the WinCC User Administrator.

If you want to use your own cursor, enter its path and file name. You can also use the "..." 
button to navigate to the file of the selected cursor.

Maximum number of simultaneous connections
Specify the maximum load on the WebNavigator Server. Specify the maximum number of 
connections for simultaneous access to the server. The number of configured gadgets is 
included in the count.

The number of simultaneous connections can exceed the number of WebNavigator licenses 
if, for example, several tabs are opened in the browser window. A limitation of "50" is necessary, 
since the server guarantees a maximum of 50 connections in normal operation without 
additional loads. The value must not be less than the actual number of WebNavigator licenses.

Maximum number of tabs per browser
Specify the maximum number of tabs per browser window. Multiple tabs in a browser window 
are counted as one WebNavigator license.

Activate WinCC system messages
The system messages "No. 1012400" or "No. 1012401" are output and archived at the login/
logoff of a WebNavigator Client.

Enable event log messages
A successful session login or logoff is recorded in the Windows event viewer.

Disable local groups of SIMATIC Logon
The WebNavigator Server can only be accessed by groups in the same domain.

Hardware accelerated graphics representation
The Direct2D representation is activated for the entire project on the WebNavigator clients.

WinCC pictures as gadget

Overview   
Gadgets are mini applications for the Windows Sidebar. On a WebNavigator Client, you can 
display published WinCC process pictures in a gadget.

Specify the WinCC pictures for the gadget. In Runtime, the WebNavigator Server successively 
generates a cyclic snapshot image "pdlImage.jpg" of each picture. The file is saved to the 
"\WinCC\Webnavigator\Server\Web\image\_gadget" folder. The gadget accesses the file at 
cyclic intervals and displays the currently generated picture.
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The following objects are not displayed in a gadget:

● Global Script Diagnostics Window

● WinCC Media Control

● WinCC Controls from migrated projects that have been installed with versions before 
WinCC V7.0

Note

The pictures displayed cannot contain any user interaction. This includes calling login 
dialogs or notice dialogs by means of functions, for instance.

You cannot operate the picture that is displayed in the gadget. 

NOTICE

Short update cycles place a high load on the WebNavigator system

Set a sufficiently long update cycle rate when an AlarmControl is displayed or a large 
number of process values for trend views are updated in the gadget.

If a process value has not yet been read from the controller at the time of the snapshot, 
the gadget displays the start value instead of the actual process value.

Requirement
● The Windows operating system must support the use of gadgets.

● The WebNavigator Client must be installed on the WebNavigator Server to enable 
configuration of the gadgets.

WinCC/WebNavigator
1.4 WinCC/WebNavigator Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 87



Configuring the gadget on the WebNavigator Server 
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web 

settings" command from the shortcut menu.

2. Change to the "Gadget" tab in the "WinCC web settings" dialog.

3. Use the "..." button to select a published picture under "Name".

4. Specify the Runtime language for the selected picture.

5. Define the clipping of the selected picture that is displayed in the Gadget. As a rule, the 
process picture is too large for display in the Gadget. Ensure that the clipping has the same 
width and height as the gadget, or at least the same width/height ratio. Otherwise, the 
picture will be distorted in the gadget or displayed with a black frame.

6. Click "Add". The picture is inserted into the "Pictures" list. Repeat steps 3 to 6 for additional 
pictures.
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7. Select pictures for which you want to change the language or clipping from the list. Edit the 
settings and click "Change".

8. In the "Update cycle" field, specify the time interval that is to be used by the server for the 
cyclic update of the picture that is displayed in "pdlImage.jpg".
The new picture is accessed at the start of the time interval. The current process values 
are read from the controller. At the end of the interval the snapshot is created and stored 
in "pdlImage.jpg".
The following example shows two process pictures with an update cycle of "10 s".

Time [s] Image
10 Process_Picture_1 -> pdlImage.jpg
20 Process_Picture_2 -> pdlImage.jpg
30 Process_Picture_1 -> pdlImage.jpg
40 Process_Picture_2 -> pdlImage.jpg

1. Select the "Time stamp" option if you want the gadget to display the date and time of 
generation of the picture.

2. Close the dialog with "OK".

Displaying gadgets on the WebNavigator Client
A pre-configured gadget for displaying WinCC pictures is available in the installation folder at 
"\WinCC\Webnavigator\GADGET" on the WebNavigator Client.

To access the gadget with the WebNavigator Client, proceed as follows:

1. Double-click "WebNavigator.gadget" in the installation folder at "\WinCC\Webnavigator
\GADGET". The gadget is installed in the Windows Sidebar.

2. Specify the update cycle in which the gadget loads a picture from the WebNavigator Server.

3. Enter the address of the WebNavigator Server. The Gadget establishes a connection to 
the WebNavigator Server.

4. If necessary, drag-and-drop the Gadget onto the desktop.

Web settings for compatibility

Working with migrated projects     
The following restriction existed for C scripts in WinCC/Web Navigator prior to V6.2. Instead 
of the complete path and picture name, the following parameters and functions returned only 
the picture name on the WebNavigator Client: 

● Parameter "lpszPictureName"

● Function "GetParentPicture"

● Function "GetParentPictureWindow"

As of WinCC/WebNavigator V6.2, you can enable absolute addressing and therefore revoke 
this restriction for the WebNavigator Client, if required.
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Select the desired response for the execution of C scripts:

● Picture name: Absolute addressing is disabled by default. The functions or parameters only 
return the picture name. Compatibility with older versions of WebNavigator Client and the 
C scripts created for these is maintained.

● Picture name and path: The absolute picture name is returned with the complete path.
This response corresponds with the WinCC basic system. There is no need to modify the 
C-Scripts used on the WinCC basic system for execution on the WebNavigator Client.

Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web 

settings" command from the shortcut menu.

2. Change to the "Compatibility" tab in the "WinCC web settings" dialog.

3. Activate the desired response of the C-Scripts. 

4. Close the dialog with "OK".
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Administering the users for WebNavigator Client

Introduction                       
Assign authorizations to the user for operator control and monitoring for access to a WinCC 
project as WebNavigator Client.   You can select a start picture and Runtime language for each 
user. Use the "Automatic Logout" function to specify the timeout for access of the 
WebNavigator Client to the WinCC project. The user will then be logged off automatically.

Automatic logout
The automatic logout provides the following advantages on a WebNavigator system:

● Access from the WebNavigator client to the WinCC project is subject to timeout. This 
enhances system security, particularly when using unattended clients that access the 
WebNavigator Server.

● The license used by the client is released again after the automatic logout.

● The current load on the WebNavigator Server is reduced after the automatic logout.

Requirement
● The WinCC process pictures were published using Web View Publisher.

● WinCC User Administrator is open.

● A user is created.

● System authorizations of the user are specified.

● The domain-specific authorizations are specified if the WinCC option "Basic Process 
Control" is used.

WinCC/WebNavigator
1.4 WinCC/WebNavigator Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 91



Procedure 
1. Select the desired user in the navigation window.

2. The user's operating authorizations are displayed in the table window.
If system authorization "Web access - monitoring only" has been enabled, the user is only 
allowed to monitor the WinCC project when acting as WebNavigator Client.
If this system authorization is disabled, the other operating authorizations assigned to the 
user are valid. For this reason, check the settings of the other authorizations.
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3. If applicable, specify the time until automatic logout in the "Logout" field in the user 
properties. To get to the properties, select the user group in the navigation window, and 
then select the user in the table window.

– If "None" is entered, automatic logout is disabled.

– The time configured for automatic logout starts at the time of logon if you select the 
"Absolute" option. The time expires independent of user actions.

– If you select the "Inactive" option, the configured time starts with the last keyboard or 
mouse operation by the user. The user is automatically logged out after this period of 
inactivity.

The "Automatic logout: disconnected from server" message is displayed after the automatic 
logout. You can refresh the page by pressing "F5" and reconnect with the WebNavigator 
Server.

4. In the properties of the user, activate the "WebNavigator" option. 

5. Select the start picture for the user in "Web start picture" via the dropdown list. You can 
only select published pictures as start pictures.  

6. Select the Runtime language for the user in "Web language" via the dropdown list. The 
languages created in the Text Library are available for selection.  

7. Close the User Administrator.

Restrictions when using SIMATIC Logon
The WebNavigator Server supports SIMATIC Logon. However, the following restrictions apply:

● If the user is a member of several user groups, a random group in which a start picture is 
configured will be selected. You cannot configure which group should be selected. The 
authorizations of all groups in which the user is a member are taken into account.

● Add the domain prefix to the user name in the login dialog of Internet Explorer: "<domain>
\<username>".

● Password expiration during a client session has no influence on the operability of the 
WebNavigator Client.

● You can only change the password on the WebNavigator Server.

● The WebNavigator Client does not support the following functions when SIMATIC Logon 
is used on the WebNavigator Server:

– Scripts

– ODK functions

– User Administrator
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1.4.3.3 Configuring the WebNavigator Server

Configuring the WebNavigator web page

WinCC Web Configurator

Introduction                 
The WinCC Web Configurator is used to set up and manage the Microsoft Internet Information 
Service (IIS). 

Requirement
● The WebNavigator Server is installed.

● The Windows "Internet Information Service" component is installed.

Starting WinCC Web Configurator
● Select "WebNavigator" in the navigation window of WinCC Explorer.

Click the "Web Configurator" command in the shortcut menu.

● You can also click the "Web Configurator" shortcut on your desktop.

Initial configuration using WinCC Web Configurator
During the course of initial configuration, you specify whether you wish to create a new default 
web page or a new virtual folder. 
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If you only operate the Web Navigator web page on the server, select the "Create a new 
standard web page (standalone)" option.

To add the WebNavigator web page as subfolder to an existing web page, select the "Add to 
existing web page (virtual folder)" check option. This option may be necessary if the current 
default web page must remain active or if the operating system only supports operation of one 
web page.  

Note
Default Web Page on a 64-Bit Operating System

If you operate the default web page on a 64-bit operating system, you must allow 32-bit 
applications in the "DefaultAppPool" application pool in the advanced settings of the "Default 
Web Site" of IIS Manager.

Managing the configuration in WinCC Web Configurator
If IIS has already been configured, edit the settings of the existing web server or the virtual 
folder using the Web Configurator.

The Web Configurator automatically detects whether a configuration already exists. The dialog 
for editing the configuration opens if an existing configuration is found.

Note
Web folder was modified or deleted

If you have deleted the web folder, restart the computer before you create a new web folder 
with Web Configurator.

Note the following:
● If web communication fails after you have changed the web folder, the Web Configurator 

attempts to adjust the settings.
● If this action is unsuccessful, proceed as follows:

1. Exit the IIS console.
2. To delete the WebNavigator web page, enter the following command line in the window 
"Run":
"<wincc_installationpath>\WebNavigator\Server\bin\WinCCWebConfigurator.exe" 
deinstall="yes".
3. Start the desired web page from the IIS console, for example, the standard web page.

Creating a new default web page

Introduction     
You can create the standard web page using the WinCC Web Configurator. 
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Requirement
● The WebNavigator Server is installed.

● The Windows "Internet Information Service" component is installed.

● WinCC Web Configurator is started.

Procedure
1. Select the "Create a new standard web page (standalone)" option and then click "Next".

2. Select "Name of the web page" and enter the name.

3. Enter the number of the port used for access in the "Port" field. HTTP port "80" is set by 
default.
If you select a different port number, that number has to be appended to the server name 
in the address bar of Internet Explorer when a WebNavigator Client logs on, e.g. 
"http://<servername>:<portnumber>".

4. At "IP address", specify whether the computer is to be available on the Intranet or Internet 
or on both networks.
Use only the addresses that are available in the selection list. 
Select "All not assigned" to enable Intranet and Internet access to the computer.
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5. Select the default web page to be displayed on the WebNavigator Client after selection of 
the web server.

– MainControl.asp
Opens the WinCC Web Navigation interface and the start picture specified in the User 
Administration. You need the Web Navigation interface to download plug-ins, for 
example.

– WebClient.asp
Opens the start picture you specified in the User Administration.

6. Specify the time interval for automatic connection setup after a connection failure.
A time setting of "0" disables the "Automatic reconnection" function.

7. Specify whether the web page is started once the configuration is completed.

8. Click "Finish" if you have not activated a Firewall. Click "Next" if you have installed a Firewall.

Result
You have successfully created the web folder and activated the web page. 

Creating a virtual folder

Introduction   
You can create a virtual folder using the WinCC Web Configurator.

Requirement
● The WebNavigator Server is installed.

● The Windows "Internet Information Service" component is installed.

● WinCC Web Configurator is started.
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Procedure
1. Enable "Add to existing web (virtual folder)". Click "Next".

2. Select the active web page to which you want to add the virtual folder.

3. Click "OK" to close the dialog.
Click "Next" in the next dialog.

4. Select "Name of the web page" and enter the name.
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5. Web Configurator applies the IIS settings as port number and IP address.

6. Select the default web page to be displayed on the WebNavigator Client after selection of 
the web server.

– MainControl.asp
Opens the WinCC Web Navigation interface and the start picture specified in the User 
Administration. You need the Web Navigation interface to download plug-ins, for 
example.

– WebClient.asp
Opens the start picture you specified in the User Administration.

7. Specify the time interval for automatic connection setup after a connection failure.
A time setting of "0" disables the "Automatic reconnection" function.

8. Specify whether the web page is started once the configuration is completed.

9. Click "Finish" to complete the configuration.

Result
You have created the virtual web folder and the web page is activated. 

On the WebNavigator Client, add the name of the virtual web folder to the URL to enable 
access to the web page, e.g. "http://WebServer/WebNavigator".

No active web page
If no active web page is found, the Web Configurator terminates with a message.

Activate a web page before you restart the Web Configurator. For more information, refer to 
"Checking the activated web page".

See also
Check the activated web page (Page 101)

Configuring the firewall

Introduction  
The chapter describes how to activate "HTTP" and "HTTPS" services for port "80" in Windows 7 
or in Windows Server 2008 R2.

Consult your network administrator if you want to set up the Windows Firewall with advanced 
security or for a different port.

Requirement
● You have created a default web page with Web Configurator.

● The Firewall is activated.
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● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".

Procedure for the default port
1. Click the "Windows Firewall" button in the " WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Windows 7: Click "Allow a program or feature through Windows Firewall".
Windows Server 2008 R2: Click "Allow a program to communicate through Windows 
Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.
The server configuration is completed.
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Check the activated web page

Procedure for Windows 7 / Windows Server 2008 R2  
1. Select "All programs > Administration > Internet Information Services (IIS) Manager" from 

the Windows Start menu.

2. Click the computer name in the "Connections" field.

3. Click "Default Web Site".

4. Check the view of the web pages.
If the status "Stopped" is displayed next to the required web page, for example, 
"WebNavigator", start the web page.
Select the "Start" command from the shortcut menu to launch the web page.

5. Close the "Internet Information Services (IIS) Manager". The web page is activated.

Load Distribution Using the "Load Balancing" Function

Load balancing on WebNavigator Servers

Overview         
The "Load balancing" function allows you to automatically distribute the WebNavigator Clients 
evenly to different Web Navigator servers. All WebNavigator Servers can participate in load 
balancing using their respective server license. 
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A WebNavigator Server can act either as Load Balancing Server or only as participating 
WebNavigator Server. 

A Load Balancing Server is automatically a participating WebNavigator Server, too. 

Several Load Balancing Servers can be configured in a group of participating WebNavigator 
Servers. 

Load balancing sequence
Following the login of a WebNavigator Client, the Load Balancing Server transfers the client 
to the participating WebNavigator Server with the lowest load. 

The clients are allocated using the "LBConfig.xml" file. The file is available in the "Project folder/
WebNavigator". 

If the fewest clients are logged on to the Load Balancing Server, the new client remains 
connected to that server. 

If a participating WebNavigator Server fails, the clients logged on to it remain in the Reconnect 
Screen until this Webserver is available again. 

The address of a WebNavigator Server does not depend on whether it is activated as a Load 
Balancing Server. 

Licensing
The "Load balancing" function supports a maximum of 32 interconnected WebNavigator 
Servers. 

All participating WebNavigator Servers and Load Balancing Servers need a "Load balancing" 
license. 

No license is necessary on the WebNavigator Clients. 

When using WinCC computers with WinCC Redundancy, you can operate a Load Balancing 
Server or participating WebNavigator Server using the "WinCC Redundancy" and "Load 
Balancing Step-Up" licenses. 
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Example

In the figure, WebNavigator Servers 1 to 3 participate in "Load Balancing". A "Load Balancing" 
license is installed on the WebNavigator Servers. 

WebNavigator Servers 1 and 2 are configured as Load Balancing Server. 

When WebNavigator Client 1 logs on to WebNavigator Server 1 or 2, it is routed automatically 
to the server that is with the lowest load.

If the WebNavigator Server to which it is connected fails, Client 1 is re-routed to one of the 
remaining WebNavigator Servers. 
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WebNavigator Server 3 participates in "Load Balancing", but it is not configured as Load 
Balancing Server. 

In the case of a high load or on the failure of Server 1 or Server 2, the WebNavigator Clients 
can be re-routed to Server 3. If WebNavigator Server 3 fails, the client cannot be re-routed to 
Server 1 or 2, irrespective of any active connection.

WebNavigator Server 4 does not participate in "Load Balancing". A logon of WebNavigator 
Client 2 to this server will possibly fail because load limits are exceeded on the server. On 
failure of WebNavigator Server 4, the client cannot be re-routed to one of the WebNavigator 
Servers 1 to 3, irrespective of any active connection. 

Settings for the use of a proxy server
The use of a proxy server may have the effect that the target address "http://<servername>" 
of the participating WebNavigator Server or Load Balancing Server is replaced with "http://
<servername.proxyname>". 

The addressed WebNavigator Server will  not be found. For this reason, you must enter the 
target addresses on the servers involved of all other participating servers in Internet Explorer. 
Enter the addresses in "Tools > Internet Options > Connections > LAN Settings > Advanced", 
"Exceptions" field. 

See also
Configuring the "Load Balancing" Function (Page 104)

Configuring the "Load Balancing" Function

Introduction         
You need a license on each participating WebNavigator Server and Load Balancing Server. 

All Load Balancing Servers and participating WebNavigator Servers are included in the list of 
Load Balancing Servers. 

The order of all listed participating servers must be identical on all Load Balancing Servers. 

Set up the query interval and activate the "Load Balancing" function. 

A configuration is not necessary on the WebNavigator Clients.

Note
Identical lists of participating WebNavigator Servers

The lists on the Load Balancing Servers and all participating WebNavigator Servers must be 
identical to ensure uniform functionality in the case of the failure of a WebNavigator Server.
Settings for a migrated project

The "Load Balancing" settings are saved for each specific project. You need to save the 
settings once again in order to activate these for a migrated project. Start the configuration 
dialog and confirm the settings with "OK".
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Requirement
● The WinCC basic system, WebNavigator Server and a "Load Balancing" license are 

installed.

● The same users are configured on all participating WebNavigator Servers and Load 
Balancing Servers.

● The default web page for WebNavigator must have been created as "standalone" on the 
WebNavigator Server.

Procedure
1. In WinCC Explorer, select the "Load Balancing" command from the "WebNavigator" 

shortcut menu. The "Load Balancing Configuration" dialog is opened.

2. In the top field, enter the address of a WebNavigator Server that participates in "Load 
Balancing". Click "Add" to include the address in the list of servers.
Repeat the process for each WebNavigator Server that participates in "Load Balancing". 
Supplement the name of the Load Balancing Server in the list.
You can always remove a server name from the list. Select a name from the list and click 
"Remove".
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3. Select the "Enable Load Balancing" check box to activate the local WebNavigator Server 
as Load Balancing Server.
The check box remains deactivated on the participating WebNavigator Servers.
The list of servers is retained even when you clear the check box. 

4. In the "Polling Interval" field, select the time interval for polling the other participating 
WebNavigator Servers. The time interval is only relevant on a Load Balancing Server.

5. Click "Save".

6. Close the dialog with "OK".

7. Repeat the procedure on all participating WebNavigator Servers and Load Balancing 
servers.
The modifications take effect when WinCC Runtime is restarted.

1.4.3.4 Differences to the WinCC Basic System

Functional restrictions

Introduction     
The WebNavigator has certain functional restrictions compared to the WinCC basic system. 
You should therefore check your WinCC projects for these restrictions and adjust the project 
settings as required.

Overview
When you use functions that are not supported in a project, corresponding messages are 
generated in Runtime to draw your attention to the fact.

The following restrictions apply to the WebNavigator Client:

● The client provides only a view of the running WinCC project.
It is not possible to configure the WinCC Server projects.

● You can only use WinCC options and WinCC add-ons if specified explicitly in the 
documentation.

● Not all "Runtime API functions" are supported.
A list of supported functions is available at "Supported functions (Page 134)".

● For information on restrictions in combination with Basic Process Control, refer to "Options 
for Process Control > Overview of process control system options > Configuring in the PCS 
7 environment > Web Client in the WinCC Information System.

● The message archive and message system can only be operated and monitored. You 
cannot modify the selection of archives and tags for the visualization of the process values.

● The "WinCC Alarm Control" function does not support the "triggers an action" property for 
a message.
For the correct display of message blocks, the "Apply project settings" option cannot be 
activated. You can find this option on the "Message blocks" tab of the "WinCC AlarmControl" 
properties dialog.

WinCC/WebNavigator
1.4 WinCC/WebNavigator Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
106 System Manual, 02/2016, A5E37537386-AA



● The hotkeys configured in WinCC are not supported.
Operator control using the tab key is supported.

● The following objects contained in the "Global library/Operation/Operating panels" folder 
of the WinCC shared library are not supported:

– 1_Slider

– 2_Slider

– 4_Slider

● National special characters in names of process pictures or referenced graphics are not 
supported on the Internet.

● The overlap lock in process pictures is not supported.

● The advanced zoom functions cannot be disabled. If you do not want to employ the zoom 
functions, do not use a wheel mouse with "auto-scroll" setting on the client.

● The redundancy switch is only supported on the dedicated web server.

See also
Using the "Hardcopy" function (Page 123)

FAQ 21606152 (http://support.automation.siemens.com/WW/view/en/21606152)

Using Scripts

Scripts running exclusively for the WebNavigator        
In order to execute scripts only for the WebNavigator, use the pre-processor definition 
"RUN_ON_WEBNAVIGATOR" in the script. For example: 
void OnOpenPicture (char* lpszPictureName, char* lpszObjectName, 
char* lpszPropertyName)
{
#ifdef RUN_ON_WEBNAVIGATOR
// here you enter the code that is to be executed only in the 
WebNavigator
#else
// here you enter the code that is executed only in the WinCC basic 
system
#endif
}

Visual Basic Script
There are only slight restrictions imposed by unsupported functions when VBS is used. A list 
of these functions is available at "Unsupported functions (Page 144)".

Global Script
You configure the scripts on the WinCC Server in the server project. 

WinCC/WebNavigator
1.4 WinCC/WebNavigator Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 107

http://support.automation.siemens.com/WW/view/en/21606152


Global scripts cannot be executed on the WebNavigator Client. Global Scripts on the server 
are supported.

The scripts generated using the Dynamic Wizard cannot contain unsupported functions and, 
therefore, cannot be executed on the WebNavigator Client. Check and correct the scripts, if 
necessary. Add the following condition, for example: "#ifdef RUN_ON_WEBNAVIGATOR". 

Script with trigger tags
The WebNavigator queries tags at cyclic intervals of "1 second". The update cycle of trigger 
tag "upon change" is also one second. 

This may lead to an increased communication load between the AS and WinCC Server. Take 
increased loads into account if communication between the AS and WinCC Server is operated 
at load limits. 

If tag-triggered scripts request additional tags having a name that is generated using a string 
function, for example, unknown tags can only be read synchronously. Enter the tag names 
you are using in the trigger list in order to avoid extended selection times. 

Script for picture selection and deselection 
In contrast to the basic system, a picture is downloaded in asynchronous mode when 
WebNavigator is used. Account for this fact when using scripts that contain picture changes. 

If a picture selection for a picture window is initiated within a script, you cannot access the 
objects of the new picture within the same script afterwards. The picture is not yet loaded at 
this time. A time delay, e.g. "Sleep(2000)" is of no help since the script and Internet Explorer 
are waiting. You should then execute the next script elements in the "OpenPicture" function 
that is triggered after the picture is loaded.

Other functions called in the script following a picture deselection will be executed with errors 
or not at all. The picture context is lost due to the picture deselection.

Synchronous script functions
Synchronous script functions impose a heavy load on the system. 

You should therefore refrain from using the "SetTagxxx" function in cyclic scripts. The server 
will be overloaded when many clients call the "SetTagxxx" functions in a fast cycle, e.g. 1 sec 
or less.

Note that the following script functions and calls are transferred synchronously to the server:

● Functions that write a tag in synchronous mode and then wait for the result, e.g. "xxxWait"

● C-API calls

The frequent use of these scripting functions and calls has a negative effect on the performance 
of the WebNavigator Client. In the case of an Internet connection, the duration of these calls 
may even be in the seconds range.

Script functions that manipulate the objects in the displayed picture are of no concern since 
no data traffic takes place between the client and server.
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Picture in picture method and cyclic scripts 
Many synchronous calls in a picture may reduce performance, for example, in the following 
cases:

● More than ten windows are configured in a picture window.

● Cyclic scripts with synchronous calls, for example, "SetTagxxx", are used in the windows.

Execution of certain scripts may fail due to timeout. 

The following elements are supported in a window:

● 16 windows with cyclic scripts.

● 31 windows without cyclic scripts.

Using tags

Computer-local tags     
The WebNavigator Client supports computer-local tags with the following restrictions:

● When a dedicated web server is used, only the computer-local tags of that server are 
available on the client. The tags on the client cannot assume their own values.

● Computer-local tags of the subordinate WinCC servers cannot have their own values on 
the client.

● The start value of computer-local text tags can only contain characters that are allowed in 
tag names. If the start value of a text tag contains a colon, for example, the tag is not 
recognized on the client.

● Computer-local tags are not supported on the client when User Archives are used, because 
User Archives can only identify the local tags of the server, but not the tags of the 
WebNavigator Client.

Defining picture-local script tags
Do not use WinCC tags for WebNavigator if picture-specific data is stored in scripts. 

The reading or writing of data in scripts always generates data traffic to the server. This places 
a load on the communication. 

You can save picture-specific data as follows:

● Configure "hidden" graphic objects so that you can use their properties as picture-specific 
tags. Actions are executed at the object properties upon changes to the stored values.

● You have created the hidden "static text" object, for example. The "Text" property is used 
to store any texts, while the color properties are used to store any colors. The properties 
are read and/or written using scripts and influence the picture status without requiring a 
roundtrip to the server.
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1.4.4 Operating the WinCC project

1.4.4.1 General properties of the WebNavigator Client

Automatic connection setup after connection interruption               
If communication between the WebNavigator client and WebNavigator Server goes down, a 
message is output to the user on the client. 

The client performs an automatic connection establishment. Upon successful connection 
setup, the start page of the WinCC project is selected. Specify the time interval between 
attempts to set up a connection in the Web Configurator. 

If a firewall or proxy server is used in client/server communication, the client logon may be 
successful, but automatic reconnection does not work. When attempting to reconnect, the 
client uses "ICMP Ping", which may be blocked by the firewall or proxy server. In this case, 
deactivate the use of "ICMP-Ping" by the client for reconnection. The "Reconnect > Deactivate 
ICMP Ping" setting is available under "Settings > WebClient Properties" in the Web Navigation 
interface or via the "ClientConfig.asp" page.  

Contents of the address bar
Character strings which cannot be interpreted and are not relevant to the user are displayed 
on the address bar of Internet Explorer. For example, the "loadbalancing=no" entry may 
appear, but it does not represent a status indication for the servers participating in Load 
Balancing. 

Enter characters in the address bar when logging on and check the server name and port.

Login by means of direct input in Internet Explorer
The Microsoft Security Patches for Internet Explorer now prevent the WebNavigator client login 
by input of the user name and password in the address bar.

"AutoComplete" entries and links in the progress bar
The entries in the address bar of Internet Explorer are displayed as a link in the progress bar 
or suggested as "AutoComplete" entries for subsequent input. However, you cannot use these 
functions without verification when a WebNavigator client logs on to a WebNavigator Server 
with Load Balancing. 

At its initial login on a server with Load Balancing, the client is re-routed to a second server. 
Internet Explorer displays the address of the second server in the progress bar or as an 
"AutoComplete" entry. The link in the progress bar or the "AutoComplete" is applied without 
verification at the next client login. The client is then logged on to the second server.

WebNavigator client with several power users
Once a power user has installed a new WebNavigator client version on a computer, all other 
power users of this computer must upgrade to the new version.
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Inconsistency of the versions employed by power users may lead to problems.

This also applies when a power user connects to a server that hosts an older version of 
WebNavigator.

Persistency in Runtime
The persistency data for pictures and objects is stored in each case on the WebNavigator 
client. Observe the following points when working on the server with several projects that 
contain pictures or objects of the same name:

If you create a persistency for a project picture in Runtime, that persistency is also applied to 
the picture of the same name in other projects.

The persistency settings you defined once for a server picture on the dedicated web server is 
applied to the respective WebNavigator client.

Persistency for WinCC controls
In controls for WinCC V7 or later, reset the settings in the control properties in the "Online 
Configuration" tab.

The persistency files for controls prior to WinCC V7 are located in the folder "Documents and 
Settings/User/Application Data/Siemens/SIEMENS.WINCC/WebNavigator/Client" on the 
WebNavigator client. 

You have the following options of undoing the settings in the controls in which Runtime 
persistency was activated:

● Resetting individual settings in the control.

● Deleting the file.

Text changes in the text library
If you change a text from the text library in Runtime, the WebNavigator client does not 
automatically detect this. In order to refresh the displayed pictures, reload the picture in Internet 
Explorer using the "Refresh" icon or the "F5" key.

Language-dependent texts as text references
Language-dependent texts via text references are displayed on the WebNavigator client in the 
language currently set for the client in the "User Administrator" editor.

WinCC Slider control
Set the "Continuous_Update" property to "No" when using the WinCC Slider control. If you set 
this property to "Yes", the slightest change to the position generates an event trigger. This 
setting causes a heavy communication load on the WebNavigator client.
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Removing the ProTool/Pro software
The controls of the HMI Symbol Library are deregistered if you remove the ProTool/Pro 
software on a WebNavigator client. Reinstall the WebNavigator client in order to recover 
access to the controls.

Access of the WebNavigator client to a WinCC flexible Sm@rt Server
A WebNavigator client can call the "Change server" function using the Web Navigation 
interface to access a WinCC flexible Sm@rt Server. 

1.4.4.2 Process pictures on the WebNavigator Client

Picture change on dedicated web server 
If a picture with a server prefix was loaded on the dedicated web server, no picture of the local 
WinCC project can subsequently be displayed without server prefix. 

To display a picture of the local client project, use the server prefix "@local" for addressing, 
e.g. "@local::picture123.pdl". 

When executed, the OpenPicture() function opens the higher-level picture of the executing 
object on the dedicated web server.

Project functions in pictures
The project functions are loaded when a project is initially selected after the start picture has 
been loaded. 

For this reason, a delay may be generated between the initial display of the start picture and 
execution of operator actions. Although the picture is displayed, it cannot be operated until a 
delay of approximately 1 second has expired. 

Picture window on the WebNavigator client
After you rename a picture in a picture window, the "Object change" event of the picture window 
is executed several times on the WebNavigator client. 

The event is executed only once in the WinCC basic system. 

This response on the client is system-related, because the asynchronous operating principle 
of the Internet connection may trigger multiple updates of the picture window object. This 
response has no implications in terms of functionality.
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WinCC web browser OCX on the WebNavigator client
● The "Allow ActiveX controls" check box has to be activated in the "Security" tab in the 

Internet options of Internet Explorer.

● If you select a link in a process picture on the WebNavigator client using the WinCC web 
browser, the "Back" button does not work during the initial display of the linked page. The 
function is not properly executed until the page is called a second time. The incorrect 
behavior persists after a change of the process picture.

● The WinCC web browser serves to display static web contents or CHM documents in 
process pictures. Contents with scripting functionality are not supported.

● If you want to disable the right mouse button in the WinCC web browser to prevent the 
WinCC client from accessing the shortcut menu, proceed as follows:

– Use Microsoft "Group Policy Object Editor" (Gpedit.msc).

– Select the path "\Windows Components\Internet Explorer\Browser menus" and set the 
shortcut menu to "Disabled".

Performance when using WinCC UserArchiveControl         
Changes to a user archive trigger the update of the WinCC UserArchiveControl that is 
displayed. The following factors affect the performance of the process pictures with WinCC 
UserArchiveControls on the WebNavigator client:

● Reduce the number of WinCC UserArchiveControls that simultaneously access a user 
archive to the minimum.

● Do not configure more than the necessary number of cyclic changes in the user archive.

1.4.4.3 Operating the WinCC project with Internet Explorer

Operating the WinCC project with Internet Explorer

Requirement   
● On the server

– The WebNavigator Server is installed.

– The "WinCC WebNavigator" license is installed.

– The WinCC pictures are configured and published for web access.

– A user for the WebNavigator Client was created in WinCC User Administrator.

– A start picture was specified for the user in the User Administrator.

– The WinCC project is in Runtime.

● On the client

– The WebNavigator Client is installed.

– Internet Explorer is installed.
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Procedure
1. Go to the address bar of Internet Explorer and enter the address "http://

www.<servername>" of the WebNavigator Server.

2. Confirm your entries.

3. Type in the user name and password. Confirm your entries.

Note

Passwords are case-sensitive.

Result
The default web page is displayed. The view depends on the configuration:

● With "WebClient.asp" setting for the default web page, the WebNavigator Client starts with 
the start picture that is specified for the user.

● With "MainControl.asp" setting for the default web page, the WebNavigator Client starts 
with the start picture that is specified for the user plus the WinCC Web Navigation interface.

See also
Administering the users for WebNavigator Client (Page 91)
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Working with the WinCC Web Navigation interface

Menu of the WinCC Web Navigation interface   
In addition to the start picture, the WebNavigator Client displays the WinCC Web Navigation 
interface when "MainControl.asp" is configured as the default web page.

The Web Navigation interface provides a compilation of different web functions in its menus:

● "Change server": Changes to a different WebNavigator Server.

● "Used servers": Navigates to the web servers used previously.
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● "<Name of the current server>" (e.g. "MyProject", or "localhost"):

– Process pictures: Display or picture navigation of the current WebNavigator Server.

– Diagnostics: "Status.html" for diagnosing the WinCC project and the connection to the 
WebNavigator Server.

– Additional tools: Can be expanded by the user, e.g. "DataMonitor".

– Download area: Expansions for WebNavigator and plug-ins that were created using 
WinCC Plug-In Builder.
The plug-ins are available at "WebNavigator/Server/Web/Install/Custom" in the 
installation folder on the WebNavigator Server.

● "Settings": Setting for the WebNavigator Client, e.g. size of the process picture or activation 
of the screen keyboard. You specify the printer with which you can print from the WinCC 
Controls using the configured print job.

● "Current": Links to web pages such as "SIMATIC HMI", "WinCC", or "WinCC flexible".

● "Language": Language change function for the WinCC Web Navigation interface.
Five languages are available by default. You can customize the language options in the 
"Menu.xml" file. 
The languages are stored in CSV file format in the "_languages / <language_identifier>" 
subfolder on the WebNavigator Server. In order to add languages, reference the language 
files in the "mainControl.asp" file.

Expanding the WinCC Web Navigation interface

Introduction  
The menu of the Web Navigation interface may be expanded by additional entries and 
functions. 

Configure the expansion in an XML file. This file is saved to the "_custom_data" subfolder on 
the WebNavigator Server. You can give the file any name you choose, since all files with "XML" 
extension are processed in this folder.

Example
The following example adds the "My Private Menu" submenu to the "Server" menu. The 
submenu consists of three entries, namely "My Link", "Relative Link" and "Run Script". 

Code Description
<?xml version="1.0"?> Version information
<menu hook-on="server"> The "menu hook-on" command is used to reference the name 

"server" that defines the "Current Server" menu on the Web 
Navigation interface.

<caption><lng>My Private Menu</lng></caption> Defines an empty entry.
<command>
<caption>My Link</caption>
<open-url target="right">http://www.msdn.com</open-url>
</command>

Defines the "My Link" entry with a direct link.
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Code Description
<command>
<caption>Relative Link</caption>
<open-url target="right">project.asp</open-url>
</command>

Defines the "Relative Link" entry with a relative link.

<command>
<caption>Run Script</caption>
<run-script>alert("Hallo !")</run-script>
</command>

Defines the "Run Script" entry that is used to start scripts.

</menu> End of menu.

Diagnosis of the Connections with "Status.html"

Introduction
The "Status.html" page is used to diagnose the WinCC WebNavigator Server and its connected 
active clients.   

Overview
Call the diagnostics page as follows:

● Type in the address "http://<servername>/status.html" in Internet Explorer if WebNavigator 
is configured as the default web page.

● Type in the address "http://<servername>/<foldername>/status.html" in Internet Explorer if 
WebNavigator is configured as virtual web page.

● Select the "Status" command from the "Diagnostics" menu if the Navigation interface is 
available via "MainControl.asp".

Access to this page is restricted to the users created in the User Administrator.
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Structure of diagnostics information related to the WebNavigator Server

Field Description
Server version WebNavigator Server version
Server file date Date of the server version
License count Number of licenses on the WebNavigator Server
Runtime mode Status of WinCC Runtime
Last update Date and time of the last display refresh 
Connected WebNavigator Clients Number of connected WebNavigator Clients 
Connected Diagnostics Clients Number of connected Diagnostics Clients
Connected DataMonitor Clients Number of connected DataMonitor Clients 
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Structure of diagnostics information related to the connected clients
The diagnostics information starts with the name of the relevant client.

Field Description
Logged on users Number of connected clients 
Login Login name of the current user
Time Login time of the current user or time of the most recent automatic connection setup. 
Type Type of client, e.g. standard, DataMonitor
PID  Process ID of the instance of WebNavigatorRT.exe on the web server communicating 

with the client.

Note

You can save the status information that is displayed. To do this, use the "Save as" function 
in Internet Explorer and select the "(*.txt)" file type. If "(*.htm, *.html)" are selected, the contents 
displayed are not saved. 

1.4.4.4 Operating the WinCC project using WinCCViewerRT

Configuring WinCCViewerRT

Introduction           
WinCCViewerRT is a program for visualizing WinCC projects. You can configure 
WinCCViewerRT for operation with the WebNavigator Server and Graphics Runtime.

Requirement
● On the server

– The WebNavigator Server is installed.

– A WinCC/WebNavigator license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

● On the client

– The WebNavigator Client is installed.
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Procedure
1. Double-click the link "WinCCViewerRT.exe" in the "Webnavigator\Client\bin" installation 

folder.
The configuration dialog opens if you reconfigure WinCCViewerRT. 
WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> 
key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:

– Server address: http://<server name> or http://<IP address>

– User name and password, if you want to specify a default user for the login dialog.

– The user settings you configured in the User Administrator will be activated if you enable 
the "Apply project settings" option.

3. Specify the Runtime language in the "Parameters" tab.
If necessary, disable any key combinations with which the user switches to other programs. 
If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open 
the WinCCViewerRT configuration dialog.
Define a key combination with which a user can log off and a new user can log on. The key 
combination can only be used if no default user has been set in the "General" tab.
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4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
- Start picture
- Configuration file for user-defined menus and toolbars
- Window attributes
- Impermissible user actions

5. Specify additional user actions in the "Runtime" tab:

● Activating the screen keyboard

● <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating system 
via the screen keyboard.

● Auto-logoff settings

● Activating Direct2D to accelerate graphics representation.

● Specification of the printer with which you can print from the WinCC Controls using the 
configured print job. 

Close the dialog with the "OK" button.

Result
WinCCViewerRT is configured. The connection to the WebNavigator Server is set up after you 
close the dialog. The settings are saved to the "WinCCViewerRT.xml" configuration file. The 
configuration file settings are used at the next start of WinCCViewerRT. WinCCViewerRT 
applies the user interface language from WinCC.

The configuration file is saved in the folder "Documents and Settings\<User>\Application Data
\Siemens\SIMATIC.WinCC\WebNavigator\Client". You can rename the file, for example, to 
"User1.xml". You can also start WinCCViewerRT by means of the command line with the user-
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specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for 
different configurations, depending on the logged-on user. 

The WinCCViewerRT configuration dialog opens at the start if you rename or delete 
"WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

Note

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut 
or hide the "Close" button. Function in the C-Script: DeactivateRTProject; function in the 
VBScript: HMIRuntime.Stop.

Operating the WinCC project

Requirement       
● On the server

– The WebNavigator Server is installed.

– The "WinCC WebNavigator" license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

– The user is created in WinCC.

● On the client

– WinCCViewerRT is configured.

Procedure
1. Start "WinCCViewerRT" in the Windows Start menu with "Programs > Siemens Automation 

> Options and Tools > HMI Tools".

2. Log on to the WebNavigator Server:

– A login dialog is not displayed if the user name and password is preset in the 
"WinCCViewerRT" configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
"WinCCViewerRT" configuration dialog. Enter the user name and password of the 
WinCC user. Passwords are case-sensitive. Click "OK".

3. To change the user, use the specified key combination for "WinCCViewerRT" login/logoff. 
The previous user is logged off. Enter the user name and password of the new WinCC user 
in the login dialog. Passwords are case-sensitive. Click "OK".
The key combination can only be used if no default user has been set.
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Result
WinCCViewerRT automatically connects to the activated WinCC project. The start picture that 
is configured for the user is displayed. 

The user may operate or monitor the project, depending on authorizations. Users assigned 
system authorization No. 1002 "Web access - monitoring only" in the User Administration are 
only allowed to monitor the WinCC project.

The "View Only Cursor" indicates that process-related operations are not possible. 

Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, 
are still possible. 

You can also use your own cursor icon as a "View Only Cursor", if required. For more 
information, refer to "Configuring Runtime settings (Page 85)".

The <F5> key triggers a reselection of WinCCViewerRT.

1.4.4.5 Using the "Hardcopy" function

Introduction    
On the WebNavigator Client, the current view can be output to the default printer.

You can generate a screenshot using a configurable key combination or a script. You can enter 
the definition of the key combination or the screen area to be printed via the command line, 
for example. 

Starting the hardcopy application
Start the "PrtScr.exe" application on the WebNavigator Client, for example, by means of the 
command line input or a user-defined function. The application is stored in the "...\Common 
Files\Siemens\BIN" folder. 

The parameters are transferred once only at the start. Separate the parameters with a space. 
Observe case sensitivity.

Close the application before you edit the parameters. Edit the parameters and restart the 
application.

The following parameters specify the procedure for printing a screenshot:

Parameters Function
Without parameters Not allowed on the WebNavigator Client. 

Use "-infinit" as a substitute. Example: PrtScr.exe –infinit –hotkey="<ALT>+p"
-end Terminates an active instance of PrtScr.exe.
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Parameters Function
-hardcopy Starts PrtScr.exe. Generates a screenshot of the current view. The hardcopy function then waits 

for the key combination for output to the printer.
Use this on the WebNavigator Client only in combination with the "infinit" and "hotkey" parameters.

-nomcp Starts PrtScr.exe. Generates a screenshot and prints the current view. PrtScr.exe is then closed.
-C= left;top;right;bottom Starts PrtScr.exe. Generates a screenshot of the screen section that is specified in pixels and 

prints the current view. PrtScr.exe is then closed. "-C=" is always followed by a space. Example: 
PrtScr.exe -C= 50;50;100;100 

-l Prints in landscape format. 
You can add the parameter to any parameter combination.

-infinit Serves as parameter for starting PrtScr.exe on a system without WinCC. Always use the parameter 
in combination with "hotkey". 

-hotkey="x" Specifies the key combination that starts output to the printer.
The following characters and combinations are allowed: 
<ALT>, <SHIFT>,<CTRL> +  {0-9, A-Z, 0xXX}
Write the parameters in uppercase letters. Combinations of the <ALT>, <SHIFT>, and <CTRL> 
keys are allowed but not mandatory. 
You can specify the "Virtual Key Code" with "XX" using the hexadecimal input "0xXX". For more 
information about "Virtual Key Codes", refer to the MSDN Library. 
Example: 
"CTRL" and P key combination: -hotkey="<CTRL>+P"      
Print button ("Print-Screen"): -hotkey="0x2C" 
Key combination "ALT" and "Print-Screen": -hotkey="<ALT>+0x2C"    

Examples of parameter combinations

Starting the hardcopy function by means of a key combination  
PrtScr.exe –infinit –hotkey="<ALT>+p"
Enter the following string in the command line:
"C:\Program Files\Common Files\Siemens\BIN\PrtScr.exe" –
infinit –hotkey="<ALT>+p"

Starts PrtScr.exe and waits for input of the "<ALT>+p" key 
combination. The current screen view is printed as screen‐
shot when you hit the key combination.

PrtScr.exe –infinit –hotkey="<ALT>+p" –C= 10;10;100;100 Starts PrtScr.exe and waits for input of the "<ALT>+p" key 
combination. Only the screen section that is defined in pixels 
will be printed as screenshot when you hit the key combina‐
tion.

Starting the hardcopy function by means of script  
PrtScr.exe –nomcp Starts PrtScr.exe. Generates a screenshot and prints the cur‐

rent view. PrtScr.exe is then closed.
PrtScr.exe –C= 10;10;100;100 Starts PrtScr.exe. Generates a screenshot of the section that 

is specified in pixels and prints the current view. PrtScr.exe 
is then closed.
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1.4.5 Installation of the WinCC Plug-In Builder

1.4.5.1 Overview of the WinCC Plug-In Builder

Introduction             
You use the WebNavigator Plug-In Builder to create MSI setup programs for downloading 
additional components to the WebNavigator-Clients, e.g., custom-created ActiveX-Controls. 
The Plug-Ins can be downloaded by the user, e.g., via the Web Navigator interface and can 
only be used in the WebNavigator environment.

No knowledge of the setup technology is required for using the Plug-In Builder. You only have 
to know which files are installed and registered by the setup program. 

The created Plug-In setup takes the form of a self-extracting "EXE" file. The file is made 
available in a folder on the WebNavigator-Server for download to the clients. 

A WebNavigator Plug-In is integrated in a previously installed WebNavigator-Client and is also 
uninstalled again with this Client.

User interface of WinCC Plug-in Builder
You install the WebNavigator Plug-In Builder from the WinCC-DVD. 

You open the Plug-In Builder in the Start menu via "SIMATIC > WinCC > Web Navigator > 
Web Navigator Plug-In Builder".

The Plug-In Builder shows an overview and the status of the existing Plug-In projects. Older 
Plug-Ins may have to be generated again.
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● The functions for creating a Plug-In are available via the navigation area, the menu 
commands and the toolbar.

● All open PlugIn projects are listed in the project explorer.

● In the "Information" area, you see the project status of the selected PlugIn project.

● In the "Installed Software" area, you see the WebNavigator components that are installed 
or still needed on the computer. The functions for testing and publishing a Plug-In are only 
available with certain WebNavigator components.  
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1.4.5.2 How to publish a plug-in

Introduction   
You can publish the Plug-In on the local WebNavigator-Server. As a result, the Plug-In is 
available to all Clients for installation.

If WebNavigator-Server and Plug-In Builder are located on the same computer, you can export 
the Plug-In directly to the WebNavigator-Server. If the Plug-In Builder is on another computer, 
you must transfer the Plug-In manually to the WebNavigator-Server.

Requirement
● The Plug-In has been generated successfully. 

● Publishing requires the WebNavigator-Server.

WinCC/WebNavigator
1.4 WinCC/WebNavigator Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 127



Procedure
1. In the navigation area, click "Publish", or get to this dialog from "Test" with "Next".

2. Click or on the"Publish" button. The created Plug-In is stored on the WebNavigator-
Server in the following installation folder: "WebNavigator/Server/Web/Install/Custom".
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3. You receive information on the status of the publishing in the "Publish Plugin" results 
window. You go directly to the storage location by clicking the link.

4. Click the menu command "File > Close" to close the project or close the Plug-In Builder 
with .

Installing a plug-in on the WebNavigator client
In order to install plug-ins created with the Plug-In Builder on the WebNavigator-Client, you 
must have Windows administrator rights. The versions of the Plug-In Builders and 
WebNavigator-Clients used must be identical.

You use the Web Navigator interface to install the Plug-In. In the "Download Area/Download 
plugins" menu, select the desired Plug-In.

1.4.6 Configuring terminal services for WebNavigator

1.4.6.1 Communication Using Terminal Services

Access from WebNavigator client and WinCC clients to the WebNavigator server   
When a WebNavigator Client via the terminal service and WinCC Clients access the 
WebNavigator Server, the WebNavigator Client operating as Terminal Client must not open a 
Windows Desktop in the session. 
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You have the following options of preventing the WebNavigator Client from opening the 
Windows Desktop at the beginning of a session:

● Enter all users directly in the Terminal Service configuration.

● In the Computer Management, enter Internet Explorer as start program for individual users.

1.4.6.2 Terminal Services Setup

Introduction   
The following chapters show you how to set up the terminal services with regard to the 
WebNavigator Client.

Requirement
● The WinCC basic system and WebNavigator Server do not run under the terminal services.

● The WinCC basic system and WebNavigator Server must be installed on the server before 
you activate the terminal services for the following configuration steps.  

Configuration steps
1. Activate the terminal services on the Terminal Server

2. Install the application on the Terminal Server, e.g. the WebNavigator Client. Information 
pertaining to the installation can be found in the corresponding documentation and the 
Online Help.

3. On the Terminal Server, create the users for access via the terminal services.

4. Run the application on the Terminal Client.

For more information, refer to "Terminal services" in the Microsoft Online Help.

1.4.6.3 Activating terminal services on the Windows Server

Introduction   
Activate the Terminal Services on the server before you install the actual applications, e.g. 
WebNavigator Client. 

Install the application on the server using the "Add or Remove Programs" dialog in the Control 
Panel. This makes it possible for all users to configure the applications. If the application is 
installed in any other way, only the user who actually installed the application can use it.

Requirement 
● Windows administrator rights

● Windows server
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Procedure 
1. Open the Control Panel and double-click "Software".

2. Click "Add/Remove Windows Components" in the "Software" dialog. The "Windows 
Components Wizard" opens.

3. Activate "Terminal Server" and "Terminal Server Licensing".

4. Click "Next". Follow the instructions.

1.4.6.4 Creating users for access to the Terminal Server

Requirement   
● Terminal Server is installed.

● A Windows user is created.

Procedure
1. Open Computer Management via the Control Panel. Select "Local Users and Groups".

2. Double-click the "Users" folder.

3. Double-click the user to be granted access to the Terminal Service.

4. Click on the "Membership" tab. Click "Add". The "Select Group" dialog opens.

5. Add the "Remote Desktop Users" group. Click "OK" to close all open dialogs.

6. Check the membership of the users in other groups. If required, add the user to other groups 
in order to assign the necessary user authorizations.

7. Close Computer Management.

1.4.6.5 Starting the Terminal Server on the Terminal Client

Requirement   
● The Terminal Service is started on the Windows Server

● On the Terminal Server, you created a user for access.

Procedure
1. On the Terminal Client, select "Programs > Accessories > Communication > Remote 

Desktop Connection" in the Windows start menu. The "Remote Desktop Connection" dialog 
opens.

2. Enter the name of the Terminal Server.

3. Click "Connect". Log on with the user that you created for access to the Terminal Server.
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Result
The connection is established. The desktop of the Terminal Server is displayed. Start an 
application on the Terminal Server, for example, WebNavigator Client via Internet Explorer.

1.4.7 Appendix

1.4.7.1 Troubleshooting

Communication between the WebNavigator Server and WebNavigator Client is down   
If a provider (participating proxy, Firewall) has set Content Filtering for an Internet connection, 
WebNavigator communication is no longer possible. With content filtering, only certain 
contents of HTML pages are permitted. Communication is routed via a defined port to an IP 
address, e.g. the address of the WinCC Server.

Disable Smart Filtering of the IP address on the WebNavigator Server. Because there is no 
HTML content on the WinCC server, filtering is not particularly useful in any case.

The data is transferred in encrypted form if you are using SSL technology. in this case, Smart 
Filtering of contents is not possible.

Connection abort
In the Internet environment, connection failures, delays, and fluctuation in communication can 
occur. 

If communication between the WebNavigator Client and WebNavigator Server goes down, a 
message is output to the user on the WebNavigator Client. The WebNavigator Client then 
attempts to perform an automatic connection setup in order to restore the connection. 

Set the waiting times between connection attempts with the "Web Configurator". If the value 
"0" is set, the WebNavigator Client does not attempt to reconnect automatically. In this case, 
a message is output on the WebNavigator Client querying whether you wish to re-establish 
the connection. 
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Confirm this prompt to re-establish the connection.

No pictures are displayed.
Check that the correct web page is activated on the WebNavigator Server.

Multiple tab browsing
You need the "ControlHost.exe" process to enable multiple tab browsing in Internet Explorer. 

When you append "?inplacecontrol=no" to the server name in the address bar, the 
WebNavigator Client is no longer hosted in the ControlHost, but instead in Internet Explorer. 
This means that multiple tab browsing is no longer possible and that the "Multiple viewer 
instance disabled" message is output.

Demo mode
If a required license is missing on the WebNavigator Server, a message is displayed informing 
you of this and the WebNavigator Client runs in demo mode. In this mode, the WebNavigator 
Client is fully operational for a period of 30 days. After 30 days, the error message "Still no 
License on Server, Demo mode expired" is shown. The WebNavigator Client can no longer 
connect to the WebNavigator Server.

Security levels as of Internet Explorer 8
Protected mode is activated by default for Internet Explorer 8 in Windows 7. 

While protective mode is activated, you cannot connect to the WebNavigator Server. The error 
message "Low integrity level is not supported:. Please deactivate protected mode" is displayed.

Disable the mode in "Tools > Internet Options > Security". 

No connection to WebNavigator Server possible.
The following section lists several error messages and reasons that prevent the WebNavigator 
Client from connecting to the WebNavigator Server:

● "The WinCC Server is currently not active":
A server is not started in Runtime.

● "Unknown user name or password":
This error can only occur in WinCCViewerRT. The user or password was stored or entered 
incorrectly. Internet Explorer allows you to enter the user name and password three times. 
The "HTTP Error 401.1" error page is then displayed.

Note

Passwords are case-sensitive.

● "Maximum count of users reached":
The WinCC/WebNavigator license was exceeded on the WebNavigator Server.
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● "Server workload exceeds limit":
The maximum number of simultaneous connections was exceeded. You make the setting 
in "WebNavigator > Web settings > Runtime" in WinCC Explorer. The number of clients 
connected to a server is shown on the page "http://<servername>/status.html". The number 
of simultaneous connections could exceed the number of connected clients if, for example, 
several tabs are opened in the browser window. 

● "Maximum count of tabs reached":
The maximum number of tabs per browser was exceeded. You make the setting in 
"WebNavigator > Web settings > Runtime" in WinCC Explorer.

● "No connection to server":
The server cannot be reached. The precise cause of error is unknown. For diagnostics 
information, refer to the page "http://<servername>/status.html".

● "Failed to load http://<servername>/Pictures/For_example.PD_":
Access to the configured start picture has failed. Check the authorizations on the 
WebNavigator Server. The published picture may no longer be available on the server.

Wrong start picture
You have edited a new picture in the Graphics Designer.

1. Start the Web View Publisher in order to publish the new picture.

2. Select "Tools > Internet Options" in Internet Explorer to delete the temporary Internet files.

3. You can assign an individual start picture to each user in the User Administration.

See also
Check the activated web page (Page 101)

1.4.7.2 Functions

Supported functions

Introduction
The following list shows the functions supported by WebNavigator. 

Functions not included in this list are not automatically enabled for the WebNavigator.

Functions             

WaitForDocumentReady  

Get_Focus GetTagChar
GetAssignments GetTagCharState
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GetBasePicture GetTagCharStateWait
GetFlashPicture GetTagCharWait
GetFontName GetTagMultiStateWait
GetInputValueChar GetTagMultiWait
GetLastChange GetText
GetOutputFormat SetTagMultiWait
GetOutputValueChar SetTagMultiStateWait
GetPictureName SetTagRaw
GetPropChar SetTagRawState
GetServerName SetTagRawStateWait

AXC_OnBtnArcLong AXC_OnBtnMsgNext
AXC_OnBtnArcShort AXC_OnBtnMsgPrev
AXC_OnBtnComment AXC_OnBtnMsgWin
AXC_OnBtnEmergAckn AXC_OnBtnScroll
AXC_OnBtnInfo AXC_OnBtnSelect
AXC_OnBtnLock AXC_OnBtnSinglAckn
AXC_OnBtnLoop AXC_OnBtnVisibleAckn
AXC_OnBtnMsgFirst AXC_SetFilter
AXC_OnBtnMsgLast  

OnBtnArcLong OnBtnMsgLast
OnBtnArcShort OnBtnMsgNext
OnBtnComment OnBtnMsgPrev
OnBtnEmergAckn OnBtnMsgWin
OnBtnHornAckn OnBtnPrint
OnBtnInfo OnBtnScroll
OnBtnLanguage OnBtnSelect
OnBtnLock OnBtnSinglAckn
OnBtnLoop OnBtnVisibleAckn
OnBtnMsgFirst  

TLGGetTemplateParameter TlgTableWindowPressPrevButton
TLGPressToolbarButton TlgTableWindowPressPrevItemButton
TlgGetColumnPosition TlgTableWindowPressStartStopButton
TlgGetNumberOfColumns TlgTrendWindowPressFirstButton
TlgGetNumberOfRows TlgTrendWindowPressLastButton
TlgGetNumberOfTrends TlgTrendWindowPressLinealButton
TlgGetRowPosition TlgTrendWindowPressNextButton
TlgGetRulerArchivNameTrend TlgTrendWindowPressNextItemButton
TlgGetRulerTimeTrend TlgTrendWindowPressOneToOneButton
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TlgGetRulerValueTrend TlgTrendWindowPressOpenArchiveVariableSelectionDlg‐
Button

TlgGetRulerVariableNameTrend TlgTrendWindowPressOpenDlgButton
TlgGetTextAtPos TlgTrendWindowPressOpenItemSelectDlgButton
TlgTableWindowPressFirstButton TlgTrendWindowPressOpenTimeSelectDlgButton
TlgTableWindowPressLastButton TlgTrendWindowPressPrevButton
TlgTableWindowPressNextButton TlgTrendWindowPressPrevItemButton
TlgTableWindowPressNextItemButton TlgTrendWindowPressStartStopButton
TlgTableWindowPressOpenArchiveVariableSelectionDlg‐
Button

 TlgTrendWindowPressZoomInButton

TlgTableWindowPressOpenItemSelectDlgButton TlgTrendWindowPressZoomOutButton
TlgTableWindowPressOpenTimeSelectDlgButton  

GetLanguage GetParentPicture
SetLanguage GetParentPictureWindow
GetLink GetServerTagPrefix
SetLink OpenPicture
GetLinkedVariable SetPictureDeactivated
GetLocalPicture SetPictureDown
SetMultiLink SetPictureUp

_makepath fscanf setvbuf
_splitpath fsetpos sprintf 
abs ftell srand
abort fwrite sscanf 
asctime getc strcat
atexit  getchar strcmp
atof getenv strcpy
atoi gets strchr
atol gmtime strcspn
bsearch labs strerror
calloc ldiv strftime
clearerr localtime strlen
clock malloc strncat 
ctime memchr strncmp
difftime memcmp strncpy
div memcpy strpbrk
exit memmove strrchr
fclose memset strspn
feof mktime strstr
ferror perror strtod
fflush printf strtok
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fgetc putc strtol
fgetpos putchar strtoul
 fgets puts SysMalloc
fopen qsort system
fprintf rand time
fputc realloc  ungetc
fputs  remove vfprintf
freopen rename vprintf 
fread rewind vsprintf
free scanf  
fseek setbuf  

Check ProgramExecute

GetActualPointLeft GetExponent GetPicDeactTransparent
GetActualPointTop GetExtendedOperation GetPicDeactUseTransColor
GetAdaptBorder GetFillColor GetPicDownReferenced
GetAdaptPicture GetFilling GetPicDownTransparent
GetAdaptSize GetFillingIndex GetPicDownUseTransColor
GetAlarmHigh GetFillStyle GetPicReferenced
GetAlarmLow GetFillStyle2 GetPicTransColor
GetAlignment GetFlashBackColor GetPicUpReferenced
GetAlignmentLeft GetFlashBorderColor GetPicUpTransparent
GetAlignmentTop GetFlashFlashPicture GetPicUpUseTransColor
GetAssumeOnExit GetFlashForeColor GetPicUseTransColor
GetAssumeOnFull GetFlashPicReferenced GetPictureDeactivated
GetAverage GetFlashPicTransColor GetPictureDown
GetAxisSection GetFlashPicUseTransColor GetPictureUp
GetBackBorderWidth GetFlashRateBackColor GetPointCount
GetBackColor GetFlashRateBorderColor GetPosition
GetBackColor2 GetFlashRateFlashPic GetPressed
GetBackColor3 GetFlashRateForeColor GetProcess
GetBackColorBottom GetFontBold GetPropBOOL
GetBackColorTop GetFontItalic GetPropDouble
GetBackFlashColorOff GetFontSize GetPropLong
GetBackFlashColorOn GetFontUnderline GetPropWord
GetBasePicReferenced GetForeColor GetRadius
GetBasePicTransColor GetForeFlashColorOff GetRadiusHeight
GetBasePicUseTransColor GetForeFlashColorOn GetRadiusWidth
GetBitNumber GetGrid GetRangeMax
GetBorderBackColor GetGridColor GetRangeMin
GetBorderColor GetGridHeight GetReferenceRotationLeft
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GetBorderColorBottom GetGridWidth GetReferenceRotationTop
GetBorderColorTop GetHeight GetRightComma
GetBorderEndStyle GetHiddenInput GetRotationAngle
GetBorderFlashColorOff GetHotkey GetRoundCornerHeight
GetBorderFlashColorOn GetHysteresis GetRoundCornerWidth
GetBorderStyle GetHysteresisRange GetScaleColor
GetBorderWidth GetIndex GetScaleTicks
GetBoxAlignment GetInputValueDouble GetScaling
GetBoxCount GetItemBorderBackColor GetScalingType
GetBoxType GetItemBorderColor GetScrollBars
GetButtonColor GetItemBorderStyle GetSelBGColor
GetCaption GetItemBorderWidth GetSelTextColor
GetCheckAlarmHigh GetLanguageSwitch GetSizeable
GetCheckAlarmLow GetLayer GetSmallChange
GetCheckLimitHigh4 GetLeft GetStartAngle
GetCheckLimitHigh5 GetLeftComma GetToggle
GetCheckLimitLow4 GetLimitHigh4 GetToleranceHigh
GetCheckLimitLow5 GetLimitHigh5 GetToleranceLow
GetCheckToleranceHigh GetLimitLow4 GetTop
GetCheckToleranceLow GetLimitLow5 GetTrend
GetCheckWarningHigh GetLimitMax GetTrendColor
GetCheckWarningLow GetLimitMin GetTypeAlarmHigh
GetClearOnError GetListType GetTypeAlarmLow
GetClearOnNew GetLongStrokesBold GetTypeLimitHigh4
GetCloseButton GetLongStrokesOnly GetTypeLimitHigh5
GetColorAlarmHigh GetLongStrokesSize GetTypeLimitLow4
GetColorAlarmLow GetLongStrokesTextEach GetTypeLimitLow5
GetColorBottom GetMarker GetTypeToleranceHigh
GetColorChangeType GetMax GetTypeToleranceLow
GetColorLimitHigh4 GetMaximizeButton GetTypeWarningHigh
GetColorLimitHigh5 GetMin GetTypeWarningLow
GetColorLimitLow4 GetMoveable GetUnselBGColor
GetColorLimitLow5 GetNumberLines GetUnselTextColor
GetColorToleranceHigh GetOffsetLeft GetUpdateCycle
GetColorToleranceLow GetOffsetTop GetVisible
GetColorTop GetOnTop GetWarningHigh
GetColorWarningHigh GetOperation GetWarningLow
GetColorWarningLow GetOperationMessage GetWindowBorder
GetCursorControl GetOperationReport GetWindowsStyle
GetDataFormat GetOrientation GetWidth
GetDirection GetOutputValueDouble GetZeroPoint
GetEditAtOnce GetPasswordLevel GetZeroPointValue
GetEndAngle GetPicDeactReferenced GetZoom
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Set_Focus SetEditAtOnce SetPicDownUseTransColor
SetActualPointLeft SetEndAngle SetPicTransColor
SetActualPointTop SetExponent SetPicUpTransparent
SetAlarmHigh SetExtendedOperation SetPicUpUseTransColor
SetAlarmLow SetFillColor SetPicUseTransColor
SetAlignment SetFilling SetPictureName
SetAlignmentLeft SetFillingIndex SetPointCount
SetAlignmentTop SetFillStyle SetPosition
SetAssumeOnExit SetFillStyle2 SetPressed
SetAssumeOnFull SetFlashBackColor SetProcess
SetAverage SetFlashBorderColor SetPropBOOL
SetAxisSection SetFlashFlashPicture SetPropDateTime
SetBackBorderWidth SetFlashForeColor SetPropChar
SetBackColor SetFlashPicTransColor SetPropDouble
SetBackColor2 SetFlashPicUseTransColor SetPropLong
SetBackColor3 SetFlashRateBackColor SetPropWord
SetBackColorBottom SetFlashRateBorderColor SetRadius
SetBackColorTop SetFlashRateFlashPic SetRadiusHeight
SetBackFlashColorOff SetFlashRateForeColor SetRadiusWidth
SetBackFlashColorOn SetFontBold SetRangeMax
SetBasePicTransColor SetFontItalic SetRangeMin
SetBasePicUseTransColor SetFontName SetRightComma
SetBitNumber SetFontSize SetReferenceRotationLeft
SetBorderBackColor SetFontUnderline SetReferenceRotationTop
SetBorderColor SetForeColor SetRotationAngle
SetBorderColorBottom SetForeFlashColorOff SetRoundCornerHeight
SetBorderColorTop SetForeFlashColorOn SetRoundCornerWidth
SetBorderEndStyle SetHeight SetScaleColor
SetBorderFlashColorOff SetHiddenInput SetScaleTicks
SetBorderFlashColorOn SetHysteresis SetScaling
SetBorderStyle SetHysteresisRange SetScalingType
SetBorderWidth SetIndex SetSelBGColor
SetBoxAlignment SetItemBorderBackColor SetSelTextColor
SetBoxCount SetItemBorderColor SetSmallChange
SetBoxType SetItemBorderStyle SetStartAngle
SetButtonColor SetItemBorderWidth SetText
SetCheckAlarmHigh SetLeft SetTop
SetCheckAlarmLow SetLeftComma SetTrend
SetCheckLimitHigh4 SetLimitHigh4 SetTrendColor
SetCheckLimitHigh5 SetLimitHigh5 SetToleranceHigh
SetCheckLimitLow4 SetLimitLow4 SetToleranceLow
SetCheckLimitLow5 SetLimitLow5 SetToggle
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SetCheckToleranceHigh SetLimitMax SetTypeAlarmHigh
SetCheckToleranceLow SetLimitMin SetTypeAlarmLow
SetCheckWarningHigh SetLongStrokesBold SetTypeLimitHigh4
SetCheckWarningLow SetLongStrokesOnly SetTypeLimitHigh5
SetClearOnError SetLongStrokesSize SetTypeLimitLow4
SetClearOnNew SetMarker SetTypeLimitLow5
SetColorAlarmHigh SetMax SetTypeToleranceHigh
SetColorAlarmLow SetMin SetTypeToleranceLow
SetColorBottom SetNumberLines SetTypeWarningHigh
SetColorChangeType SetOffsetLeft SetTypeWarningLow
SetColorLimitHigh4 SetOffsetTop SetUnselBGColor
SetColorLimitHigh5 SetOperation SetUnselTextColor
SetColorLimitLow4 SetOperationMessage SetVisible
SetColorLimitLow5 SetOperationReport SetWarningHigh
SetColorToleranceHigh SetOrientation SetWarningLow
SetColorToleranceLow SetOutputValueChar SetWindowsStyle
SetColorTop SetOutputValueDouble SetWidth
SetColorWarningHigh SetPasswordLevel SetZeroPoint
SetColorWarningLow SetPicDeactTransparent SetZeroPointValue
SetCursorControl SetPicDeactUseTransColor SetZoom
SetDirection SetPicDownTransparent  

GetTagBit GetTagDateTime GetTagByteStateQCWait
GetTagByte GetTagDoubleWait GetTagCharStateQC
GetTagDouble GetTagDWordWait GetTagCharStateQCWait
GetTagDWord GetTagFloatWait GetTagDoubleStateQC
GetTagFloat GetTagRawWait GetTagDoubleStateQCWait
GetTagRaw GetTagSByteWait GetTagDWordStateQC
GetTagSByte GetTagSDWordWait GetTagDWordStateQCWait
GetTagSDWord GetTagSWordWait GetTagFloatStateQC
GetTagSWord GetTagWordWait GetTagFloatStateQCWait
GetTagWord GetTagBitStateWait GetTagRawStateQC
GetTagBitState GetTagByteStateWait GetTagRawStateQCWait
GetTagByteState GetTagDoubleStateWait GetTagSByteStateQC
GetTagDoubleState GetTagDWordStateWait GetTagSByteStateQCWait
GetTagDWordState GetTagFloatStateWait GetTagSDWordStateQC
GetTagFloatState GetTagRawStateWait GetTagSDWordStateQCWait
GetTagRawState GetTagSByteStateWait GetTagSWordStateQC
GetTagSByteState GetTagSDWordStateWait GetTagSWordStateQCWait
GetTagSDWordState GetTagSWordStateWait GetTagValueStateQC
GetTagSWordState GetTagWordStateWait GetTagValueStateQCWait
GetTagWordState GetTagBitStateQC GetTagWordStateQC
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GetTagBitWait GetTagBitStateQCWait GetTagWordStateQCWait
GetTagByteWait GetTagByteStateQC GetTagMultiStateQCWait

SetTagBit SetTagFloatState SetTagSWordWait
SetTagByte SetTagRawState SetTagWordWait
SetTagDouble SetTagSByteState SetTagBitStateWait
SetTagDWord SetTagSDWordState SetTagByteStateWait
SetTagFloat SetTagSWordState SetTagDoubleStateWait
SetTagRaw SetTagWordState SetTagDWordStateWait
SetTagSByte SetTagBitWait SetTagFloatStateWait
SetTagSDWord SetTagByteWait SetTagRawStateWait
SetTagSWord SetTagDoubleWait SetTagSByteStateWait
SetTagWord SetTagDWordWait SetTagSDWordStateWait
SetTagBitState SetTagFloatWait SetTagSWordStateWait
SetTagByteState SetTagRawWait SetTagWordStateWait
SetTagDoubleState SetTagSByteWait  
SetTagDWordState SetTagSDWordWait  

Supported ODK Functions
PWRTCheckPermission  

PWRTCheckPermissionOnPicture // Only the "permlevel" parameter is evaluated! 

MSRTStartMsgService  

MSRTStopMsgService  

MSRTCreateMsg  

MSRTCreateMsgInstanceWithComment

MSRTSetComment

PDLRTGetLink

PDLRTSetLink

PDLRTSetMultiLink

PDLRTGetPropEx // Nur das Lesen wird unterstützt.

PDLRTSetPropEx // Nur das Setzen wird unterstützt.

TXTRTConnect

TXTRTDisconnect

TXTRTGetInfoTextMC
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Supported User Archive-Functions

Note

User archive functions must always start with "ua" in lower case. 

Functions beginning with the uppercase letters "UA" are ODK functions. These ODK functions 
are not supported on the WebNavigator Client.

uaArchiveClose uaArchiveGetName uaArchiveSetFieldValueLong
uaArchiveDelete uaArchiveGetSort uaArchiveSetFieldValueString
uaArchiveExport uaArchiveImport uaArchiveSetFilter
uaArchiveGetCount uaArchiveInsert uaArchiveSetSort
uaArchiveGetFieldLength uaArchiveMoveFirst uaArchiveUpdate
uaArchiveGetFieldName uaArchiveMoveLast uaArchiveWriteTagValues
uaArchiveGetFields uaArchiveMoveNext uaArchiveWriteTagValuesByName
uaArchiveGetFieldType uaArchiveMovePrevious uaConnect
uaArchiveGetFieldValueDate uaArchiveOpen uaDisconnect
uaArchiveGetFieldValueFloat uaArchiveReadTagValues uaGetLastError
uaArchiveGetFieldValueDouble uaArchiveReadTagValuesByName uaGetLastHResult
uaArchiveGetFieldValueLong uaArchiveRequery uaQueryArchive
uaArchiveGetFieldValueString uaArchiveSetFieldValueDate uaQueryArchiveByName
uaArchiveGetFilter uaArchiveSetFieldValueDouble uaReleaseArchive
uaArchiveGetID uaArchiveSetFieldValueFloat  

Supported MBCS Functions

_ismbcalnum _mbscat _mbsncmp
_ismbcalpha _mbschr _mbsncpy
_ismbcdigit _mbscmp _mbsnicmp
_ismbcgraph _mbscpy _mbspbrk
_ismbclower _mbsdec _mbsrchr
_ismbcprint _mbsicmp _mbsspn
_ismbcpunct _mbsinc _mbsstr
_ismbcspace _mbslen _mbstok
_ismbcupper _mbscspn _mbctolower
_mbclen _mbsncat _mbctoupper
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WaitForDocumentReady

Function     
The function checks whether a picture is loaded in the specified picture window.

A difference must be made in the scripts of process pictures or project functions between the 
runtime environment of WinCC and of the WebNavigator Client. The following Compiler 
commands exist to this purpose:

● #ifdef RUN_ON_WEBNAVIGATOR

● #ifndef RUN_ON_WEBNAVIGATOR

This allows you to distinguish between WinCC and the WebNavigator Client in your 
configuration as follows:

● Script delay with "WaitForDocumentReady"

● Differing picture addressing

● Different function names for control system functions

● Functions that are not supported on the WebNavigator Client

Syntax in ANSI-C
int WaitForDocumentReady(LPCSTR lpszPictureWindow)

Parameters

lpszPictureWindow
Pointer to the name of the picture window that is opened in the WebNavigator Client.

The following addressing syntax is possible:

● Picture window "xxx" in the current screen: ./xxx
● Picture window "yyy" in the view object "xxx": ./xxx/yyy
● Picture window "xxx" in the parent screen: ../xxx
● Picture window "xxx" in the parent picture of the parent screen: ../../xxx
● Absolute path compatible with WinCC

Return value

TRUE
The picture window has been found and the status checked.

FALSE
The picture window has not been found.
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Example of ANSI-C
#ifdef RUN_ON_WEBNAVIGATOR
SetPropChar("../", "View", "PictureName", szViewName);
WaitForDocumentReady("../View");
#else
SetPropChar(lpszParent, "View", "PictureName", szViewName);
#endif

Note

The syntax of the code section for WebNavigator is not checked during compilation of the 
WinCC script and is checked only when the pictures are published.

Unsupported Functions
The following list is only an extract of the unsupported functions. The list contains the functions 
that are explicitly stated as being unsupported. 

Functions   

GetHWDiag OnDeactivateExecute ReportJob
GetHWDiagLevel OnErrorExecute RPTJobPreview
GetKopFupAwl OnTime RPTJobPrint
GetKopFupAwlLevel OpenPrevPicture RptShowError 

VBScript functions
● HMIRuntime.Stop: Terminates Internet Explorer and WinCCViewerRT, but not WinCC 

Runtime.

● AlarmLogs Object

● DataLogs Object

● Logging Object

● Project Object

Functions That Are not Required:
● DeactivateRTProject: Terminates Internet Explorer and WinCCViewerRT, but not WinCC 

Runtime.

● ExitWinCC

● FillDiagnoseInTags

● InquireLanguage

● TraceText

● TraceTime

WinCC/WebNavigator
1.4 WinCC/WebNavigator Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
144 System Manual, 02/2016, A5E37537386-AA



Other Functions
These functions are included in the functional scope in order to ensure error-free compilation 
on the WebNavigator Client. The functions are not supported by the WebNavigator Client.

AXC_OnBtnHornAckn GetCursorMode GmsgFunction  
AXC_OnBtnPrint SetCursorMode MSRTMsgWinCommand
AXC_OnBtnProtocol  TlgTableWindowPressHelpButton
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WinCC/DataMonitor 2
2.1 WinCC/DataMonitor Installation Notes

2.1.1 Installation Requirements

Introduction 
Certain hardware and software configuration requirements must be fulfilled for installation.

Note

A DataMonitor server cannot be operated on a WinCC client without a project of its own.

Only use a DataMonitor server on a computer which is not operated in WinCC ServiceMode.

Hardware requirements
To work with WinCC/DataMonitor efficiently, select a system that meets the recommended 
specifications for an optimum configuration.

DataMonitor server

  Minimum Recommended
DataMonitor 
server on 
WinCC server 
for more than 
10 clients

CPU Dual core CPU; 2.5 GHz Multi core CPU; 3.5 GHz
Work memory 4 GB 8 GB

DataMonitor 
server on 
WinCC server 
with WinCC 
project in Run‐
time

CPU Dual core CPU; 2.5 GHz Multi core CPU; 3.5 GHz
Work memory 4 GB 8 GB

DataMonitor 
server on 
WinCC server

CPU Dual core CPU; 2.5 GHz Multi core CPU; 3.5 GHz
Work memory 4 GB > 4 GB

DataMonitor 
server on 
WinCC single-
user system or 
WinCC client 
with its own 
project

CPU Dual core CPU; 2.5 GHz Multi core CPU; 3.5 GHz
Work memory 4 GB > 4 GB
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DataMonitor client

 Minimum Recommended
CPU Dual core CPU; 2 GHz Multi core CPU; 3 GHz
Work memory 1 GB 2 GB

Software requirements
Certain requirements concerning operating system and software configuration must be met 
for the installation.

Windows 10: Restricted release
Windows 10 only has restricted release. You can find detailed information in the Product 
Support under the entry number="109482899":

● Internet: Windows 10 for WinCC V7.4 - FAQ (http://support.automation.siemens.com/WW/
view/en/109482899)

Microsoft Internet Information Service (IIS)
Before installing the DataMonitor server, you must first install the Internet Information Service 
(IIS).

DataMonitor server on WinCC server

Operating system Software
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 R2 Standard 64-bit

Internet Explorer as of V10.0 (32-bit)
WinCC Basis System V7.4 or WinCC Fileserver V7.4

If you want to publish Intranet information, the following is required:

● A network-capable computer with a LAN connection

● A system that converts computer names into IP addresses. This step allows users to use 
"alias names" instead of IP addresses when connecting to your server.

If you want to publish information in the Internet, the following is required:

● An Internet connection and an IP address from your Internet service provider (ISP). You 
can only publish information in the Internet, if you have a connection to the Internet provided 
by the ISP.

● A network adapter that is suitable for connecting to the Internet.

● A DNS registration for your IP address. This step allows users to use "alias names" instead 
of IP addresses when connecting to your server.

WinCC/DataMonitor
2.1 WinCC/DataMonitor Installation Notes

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
148 System Manual, 02/2016, A5E37537386-AA

http://support.automation.siemens.com/WW/view/en/109482899
http://support.automation.siemens.com/WW/view/en/109482899


DataMonitor server on WinCC single-user system or WinCC client with its own project

Operating system Software
Windows 10 64-bit (max. 3 clients, restricted release)
Windows 8.1 32-bit (max. 3 clients)
Windows 8.1 64-bit (max. 3 clients)
Windows 7 Ultimate SP1 32-bit (max. 3 clients)
Windows 7 Ultimate SP1 64-bit (max. 3 clients)
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 R2 Standard 64-bit

Internet Explorer as of V10.0 (32-bit)
WinCC Basis System V7.4 or WinCC Fileserver V7.4
For the components "Excel Workbook Wizard" and "Excel 
Workbook":
● Microsoft Office 2007 SP2
● Microsoft Office 2010 32-bit version
● Microsoft Office 2013 32-bit version

You also need access to the Intranet/Internet or a TCP/IP connection to the Web client.

DataMonitor client

Operating system Software
Windows 10 64-bit (restricted release)
Windows 8.1 32-bit
Windows 8.1 64-bit
Windows 7 SP1 32-bit
Windows 7 SP1 64-bit
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2012 R2 Standard 64-bit
Also other operating systems via MS Terminal Services

Internet Explorer as of V10.0 (32-bit)
WinCC Basis System V7.4 or WinCC Fileserver V7.4
 
For the components "Excel Workbook Wizard" and "Excel 
Workbook": 
● Microsoft Office 2007 SP2
● Microsoft Office 2010 32-bit version
● Microsoft Office 2013 32-bit version

You also need access to the Intranet / Internet or a TCP/IP connection to the Web server. 

See also
Internet: Windows 10 for WinCC V7.4 - FAQ (http://support.automation.siemens.com/WW/
view/en/109482899)

2.1.2 User rights for installing the DataMonitor client

Introduction       
You can install the DataMonitor client as follows: 

● Installation from the product DVD
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation via the Intranet/Internet
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation using the group policy-based software distribution in networks
This can be done without any user interaction and using the Windows user permissions of 
the current user.
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Windows user permissions required for installation and initial logon of the client
Depending on the operating system, specific minimum user rights are required to install the 
DataMonitor client via Intranet/Internet. 

After installation, the client must log in with the following user identification for initial registration 
on the DataMonitor server:

● Under a user identification with Windows user rights higher or equal to those defined by 
the user identification that was given for the installation.

The connections must be established successfully. The subsequent logins can then be 
performed under a different Windows user authorization with possibly limited rights.

Minimum required user rights:

● Administrator

Installing the DataMonitor client with limited Windows user rights 
Using Microsoft Windows Installer technology (MSI), DataMonitor clients can also be installed 
with limited Windows user permissions, i.e. permissions other than "Power user" or 
"Administrator". 

This procedure can be set during the installation using the group policy based software 
distribution in networks.

Even the add-ins and plug-ins for the DataMonitor client can be installed in this way. The 
minimum user permissions described above are also required to install plug-ins created with 
WinCC Plug-In Builder.

Using MSI technology, it is also possible to install the DataMonitor client for a configured group 
of users or computers.

Installation for a configured group of users or computers

The following is possible with the Microsoft Systems Management Server or a group policy on 
a Domain Controller:

● The installation for a group of users or computers configured by the administrator

– To do this, the "WinCCDataMonitorClient.msi" MSI file is published on the domain 
controller and then released for a user group. The installation is then performed 
according to the configuration of the group policy based software distribution either 
during login of the defined users or when the computer is started.  

– When using a Microsoft Systems Management Server, the installation is configured by 
the administrator, triggered and executed when the relevant computer boots. Additional 
information on Microsoft Systems Management Server is available in the Internet on the 
Microsoft Homepage.

Group policy based software distribution

The software installation is normally executed with the access rights of the current Windows 
user. When using MSI technology, the installation is performed by an operating system service 
with a higher level of rights. This enables installations to be performed for which the Windows 
user has no permission. Applications which require installations with a higher permission are 
referred to as "privileged installations" in MSI technology. Installation of these applications is 
possible when a Windows user is assigned the "Always install with elevated privileges" 
permission. 
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In order to use the group policy-based software distribution, a group policy is created on the 
domain controller and assigned to the distributing software or published using Active Directory. 

● Assignment: The software distribution can be assigned to a user or a computer. In this 
case, the software to be distributed is automatically installed when the user logs in or the 
computer is started.

● Publication: The software distribution can be published for single users. In this case, when 
the user logs onto the client computer, the software to be distributed appears in a dialog 
and can be selected for installation.

2.1.3 Installing the Internet Information Service (IIS)

Settings
Before installing the DataMonitor server, you must first install the Internet Information Service 
(IIS). You specify the settings for the DataMonitor server during installation.

Activate the following settings:

● Web management tools:

– IIS management service

– IIS management console

– IIS management scripts and tools

– Compatibility with IIS Metabasis and IIS 6 configuration

– Compatibility with WMI for IIS 6

● WWW Services > Common HTTP Features or Shared HTTP Features:

– Standard document

– Static content

– HTTP error

● WWW services > Application development features:

– .NET extendibility

– ASP

– ASP.NET

– ISAPI extensions

– ISAPI filters

● WWW Services > security:

– Request filtering

– Basic Authentication

– Windows authentication
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Note

If the logging functions are active with IIS, the log files must be monitored and deleted, if 
necessary. The event views should be configured so that the log files do not become too large.

Requirements
● To do this, you must have administrator rights.

Procedure
1. Select "Programs and Features" from the Control Panel.

2. Click "Turn Windows features on or off" or "Add/Remove Windows Components".

3. Activate the settings specified above.
You can also use the command line "Start > Run > cmd" to install the IIS components:
pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-
StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-ASP;IIS-
ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-WindowsAuthentication;IIS-
ManagementConsole;IIS-ManagementService;IIS-IIS6ManagementCompatibility;IIS-
Metabase;IIS-WMICompatibility

4. Close the dialog box with the "OK" button. The required data is transferred and the IIS is 
configured accordingly.

Procedure for Windows Server 2008 R2 / 2012 R2
Configure the settings in the Server Manager using the "Webserver (IIS)" role in the associated 
role services.

2.1.4 Installing the DataMonitor server and client

Introduction 
This chapter describes the installation of the DataMonitor server and DataMonitor client.

Installation on the DataMonitor client depends on the DataMonitor tool used.

DataMonitor server scope of installation
A DataMonitor server is installed and set up as the web server to enable WinCC/DataMonitor 
to be used. 

This installation allows you to access the WinCC runtime archive using "Trends & Alarms".

Only "Webcenter" and "Trends & Alarms" are installed on a computer with WinCC file server, 
for example, used as a archive server, because the other components require WinCC Runtime. 
"Webcenter" and "Trends & Alarms" install all necessary components in the process. 
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Microsoft Internet Information Service (IIS)
Before installing the DataMonitor server, you must first install the Internet Information Service 
(IIS).

DataMonitor client installation conditions
You need not install the DataMonitor client if you only want to use "Webcenter" and "Trends 
and Alarms".

You can install the Excel add-ins "ExcelWorkbook Wizard" and "Excel Workbook" individually 
under "Reports/Download area" on the DataMonitor start page for the "Reports". For "Excel 
Workbook" you need "Microsoft Excel 2007 SP2", "Microsoft Excel 2010" or "Office Excel 
2013". 

Depending on the operating system, specific user rights may be required for installing the 
DataMonitor client. For additional information on this, see "User rights for installing the 
DataMonitor client".

Note
Downloading the client setup

To save the client setup on the client computer, select the "Save" option when downloading 
the client software from the DataMonitor server. It is recommended to save the Setup file 
because, in the event of a restart of the client computer being necessary, the Setup need not 
be downloaded again. 

If the DataMonitor client has already been installed from DVD and you want to install an 
updated version of the client via the Intranet/Internet, you must save the client setup on the 
target computer.
Excel Workbook Wizard requires Microsoft .Net Framework

In order to us Excel Workbook Wizard make sure that the .Net Framework is installed on the 
DataMonitor client.
Client installation on a DataMonitor server

Proceed as follows if you also wish to install the DataMonitor client or WebNavigator client on 
a DataMonitor server: 
1. Use the Services Manager in Windows to set the start type of the "CCArchiveConnMon" 

service to manual.
2. Restart the computer.
3. Install the client.

Ensure that no WebNavigator clients or DataMonitor clients access the server during 
installation. 

4. Switch the start type of the "CCArchiveConnMon" service back to automatic.

Requirement
● The DataMonitor server requires the Internet Information Services (IIS).

● The DataMonitor server requires the WinCC configuration data.

● You need Windows "Administrator" rights to install the DataMonitor server.
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Procedure
1. Insert the WinCC DVD into the DVD drive.

2. If the automatic execution of an autorun file is activated, after a few seconds the setup 
program starts automatically.
The setup can also be started manually in case the installation is performed from a network 
drive or the autorun function has been disabled.
The setup program is started.

3. To install, click the text "Install Software".

4. In the following dialog, select the component "DataMonitor Server" or "DataMonitor Client".

5. Follow the instructions of the setup program.

 

2.1.5 Licensing

DataMonitor client
No license is required for the DataMonitor client on the computer.

The DataMonitor clients are licensed on the DataMonitor server. Install the license keys for 
the client access to the server on the DataMonitor server.

DataMonitor server 
As a prerequisite for the WinCC basic system, the WinCC RT basic license is required.

Licenses are available for 1 / 3 / 10 / 30 clients that can simultaneously access the DataMonitor 
server. The licenses are cumulative.

A message will appear if the number of licensed clients is exceeded during a login attempt by 
a DataMonitor client. No further logins will be possible.

Note

The connection to the DataMonitor server is maintained if the user closes the DataMonitor 
start page without logging off with the "Log off" button.

The license remains allocated and is only released after approximately 20 minutes.
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License count
DataMonitor distinguishes between the following function groups:

● Excel Workbooks
A "WinCC DataMonitor" license is required on the server computer for each DataMonitor 
client.

● Webcenter, Trends & Alarms, Reports
It is not the number of clients but the number of connections that is relevant for the license 
count for the Webcenter function group. 

The following table shows the maximum number of clients or connections per license based 
on the function group. The values are valid only within a function group.

License Excel Workbooks 1) Webcenter, Trends & Alarms, Reports 1)

1 Client 1 3
3 Clients 3 6
10 clients 10 20
30 Clients 30 60

1) The same values apply even if you cumulate licenses.

In the following example, two licenses are installed on the DataMonitor server: "1 Client" a"3 
Clients". 

The following cumulative values apply depending on the selected function group:

Example: Excel Workbooks

Installed licenses Function group Maximum logged on users
"1 Client" + "3 Clients" Excel Workbooks 4 users

Example: Webcenter, Trends & Alarms, Reports

Installed licenses Function group Maximum logged on users
"1 Client" + "3 Clients" Webcenter, Trends & Alarms, Re‐

ports
8 users

No operation without a valid license 
If no license is available, DataMonitor displays a page reporting the missing license. 

Check the existing licenses. If necessary, install the required licenses.

Using DataMonitor versions prior to V7.4
DataMonitor versions up to V7.3 do not recognize licenses from DataMonitor V7.4 and higher.

Once you install the DataMonitor V7.4 licenses on a computer, a DataMonitor installation of a 
version prior to V7.4 can no longer be licensed. 

This also applies if you upgrade to the new cumulative licenses through an upgrade license. 
The upgraded licenses are no longer recognized by DataMonitor V7.3 or earlier versions.
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The upgrade to DataMonitor V7.4 cannot be reversed.
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2.2 WinCC/DataMonitor Release Notes

2.2.1 Notes about DataMonitor

Notes about DataMonitor
These release notes contain important information.

The statements in these release notes take precedence over information provided in the 
manuals and in the online help.

Please read these release notes carefully as they contain useful information.

Using a secure connection over HTTPS
To improve the security of your communication, configure the DataMonitor server in such a 
way that only HTTPS connections are supported. 

You need a digital certificate for the DataMonitor server for this purpose. Also use SSL 
certificates on the DataMonitor clients.

Detailed information is available in the Microsoft Support under "How To Set Up an HTTPS 
Service in IIS" (http://support.microsoft.com/kb/324069/EN-US (http://support.microsoft.com/
kb/324069)).

System load through large amounts of data
Note that SQL queries returning large amounts of data can affect system functionality. 

Select filter criteria which limit the amount of data in a useful manner.

Opening Excel workbooks on a computer not connected to the Internet
If you want to use the DataMonitor client on a computer not connected to the Internet, you 
must deactivate certificate checking. To do this, follow these steps:

● Open Internet Explorer.

● Select the "Internet Options" command from the "Tools" menu.

● Click "Advanced".

● In the "Security" section, deactivate the setting "Check for publisher's certificate revocation".

Excel workbook functions and print jobs after deactivating and activating WinCC Runtime
If you deactivate WinCC Runtime and then reactivate it, you also need to restart the Web 
application.
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Excel workbook: volume of requested data for archived values
Although you can limit the requested data volume with the "Data resolution" property, all data 
of the defined time period is initially used internally. This may have the result that the internal 
system limit is reached. Use compression archives to limit the data volume.

Excel workbook: Tag selection for event-driven print jobs and Excel Workbooks
As of WinCC V7.2, you can limit display the available variables for the selection of tags using 
a filter. For example, the filter setting "N*" shows all tags that start with "N".

Web Client: Display of ActiveX controls in Internet Explorer       
ActiveX controls are disabled in Internet Explorer by default. For this reason, the WinCC 
controls are not displayed correctly in Internet Explorer on a Web client.

To display the WinCC controls correctly, add the Web server as a trusted website and enable 
the ActiveX controls only for the "Trusted sites" zone.

To continue protecting Internet Explorer from foreign ActiveX controls, check that the restricted 
security settings still apply to the other zones after making the changes.

For more information, refer to the following documentation: 

● WinCC/DataMonitor: "WinCC/DataMonitor Documentation > Configuring the DataMonitor 
System > Working with the DataMonitor Client > Configuring Security Settings in Internet 
Explorer"

DataMonitor server: Remote access to WinCC file server
Remove access from one DataMonitor server to a WinCC file server is possible only if the 
firewall is disabled on the WinCC file server.

Excel workbook: Local times on DataMonitor client and DataMonitor server
Please note when requesting archive data that the local times on the server and client may 
differ if they have not been sufficiently synchronized, for example because automatic 
synchronization is not possible. 

The DataMonitor client attempts to establish the current time of the DataMonitor server when 
archive data is requested. If it succeeds, the query will be based on the server time. For the 
display of data in the Excel table, the time stamp represents the server time but in the local 
time zone of the client. 

If the query of the server time is unsuccessful, the DataMonitor client will base the time period 
of the query on its local time. An entry will also be made in the Windows event display on the 
DataMonitor client. For the display of data in the Excel table, the time stamp represents the 
client time.
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Excel workbook: Client on terminal server
In the case of operation on a terminal server, an Excel Workbook client will run in a session 
of the terminal services. A maximum of only 10 Excel workbook clients can be operated; 
otherwise, MS Excel will overload the computer.

Trends & Alarms: Display of archive data after copying a project
To copy a WinCC project between computers and then display the archive data of the project 
on the target computer in "Trends & Alarms", you will first need to copy the project using the 
WinCC Project Duplicator. 

If you use Windows Explorer rather than the Project Duplicator to copy the project, the runtime 
data will not be adapted to the target computer. The computer name of the source computer 
and not that of the target computer is displayed in the archive selection in "Trends and Alarms". 
The computer name of the target computer is displayed in the selection field only after the 
archive has been reset in Alarm Logging and Tag Logging. 

See also
http://support.microsoft.com/kb/324069 (http://support.microsoft.com/kb/324069)

2.2.2 Service and Support

2.2.2.1 Warnings

Safety notes
This manual contains information that must be observed to ensure your personal safety and 
to prevent property damage. Notices referring to your personal safety are highlighted in the 
manual by a safety alert symbol; notices referring to property damage only have no safety alert 
symbol. Depending on the hazard level, warnings are displayed in a descending order as 
follows:

DANGER

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.

WARNING

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.

CAUTION

indicates that minor personal injury may result if proper precautions are not taken.
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NOTICE

indicates that damage to property may result if proper precautions are not taken.

Note

is an important information about the product, the way to handle the product or the respective 
part of the documentation and we wish to especially bring this to your notice.

If multiple levels of hazards can occur, the warning is always displayed with the highest possible 
level. If a warning with a warning triangle is to be indicate physical injury, the same warning 
may also contain information about damage to property.

Qualified Personnel
The corresponding machine/ system may only be set up and operated with the help of this 
documentation. A device/system must only be commissioned and operated by qualified 
personnel. Qualified persons in the sense of safety instructions in this documentation stand 
for persons who are authorized to operate, earth and mark machines, system and electrical 
circuits according to safety standards.

Proper use
Please observe the following:

WARNING

Proper use

The machine may only be used for the application instances that have been described in the 
catalog and the technical description and only in combination with third-party devices and 
components recommended and/or approved by Siemens. Smooth and safe operations 
demand proper transport, proper storage, installation and assembling as well as careful 
operations and maintenance.

Brands
All names identified by ® are registered trademarks of Siemens AG. Third parties using for 
their own purposes any other names in this document which refer to trademarks might infringe 
upon the rights of the trademark owners.

Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly that 
you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 

WinCC/DataMonitor
2.2 WinCC/DataMonitor Release Notes

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
160 System Manual, 02/2016, A5E37537386-AA



state-of-the-art industrial security concept. Third-party products that may be in use should also 
be considered. For more information about industrial security, visit

● http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity)

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit

● http://support.automation.siemens.com (http://support.automation.siemens.com)

Disclaimer of liability
We have checked the contents of the description to ensure that it matches with the hardware 
and the software it describes. Nevertheless, we cannot assume responsibility for any 
deviations that may arise. The details outlined in this description are checked regularly and 
the required corrections are done in the subsequent editions. Suggestions for improvement 
are welcomed.

The statements in the online documentation are more binding than the statements in the 
manuals and PDF files.

Please follow the Release Notes and Installation Notes. The information in these Release 
Notes and Installation Notes has priority over that in the manuals and online help with regard 
to legal validity.

Copyright © Siemens AG 2016
Änderungen vorbehalten / All rights reserved

It is prohibited to transfer, copy, evaluate or communicate this document in full or part unless 
the same has been explicitly approved. Violation of this rule can lead to claims for damage 
compensation. All rights reserved, especially for granting patents or for GM registration.

Siemens AG

Digital Factory

SIMATIC Human Machine Interfaces

P.O. Box 4848

D-90026 Nuremberg, Germany

See also
http://support.automation.siemens.com (http://support.automation.siemens.com)

http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity)
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2.2.2.2 Customer Support

Customer Support and Technical Support           
You can reach the SIMATIC hotlines at the times specified in the following table. The SIMATIC 
hotline employees speak German and English. The Authorization hotline offers French, Italian 
or Spanish customer support in addition to German and English.

Technical support

Nuremberg (GMT +1:00)
Service HoursMonday - Friday, 8:00 to 17:00 (CET/CEST)
Phone +49 (0)911 895 7222
Fax +49 (0)911 895 7223
E-mail http://www.siemens.com/automation/support-request  (http://

www.siemens.com/automation/support-request)

An overview of the Technical Support is available at the following URL:

● http://support.automation.siemens.com/WW/view/en/16605032 (http://
support.automation.siemens.com/WW/view/en/16605032)

Automation Value Card (AVC)
The Automation Value Card (AVC) provides extended Technical Support and is available 24 
hours every day of the week. Information on the AVC can be found at the following URL:

● http://support.automation.siemens.com/WW/view/en/28448132 (http://
support.automation.siemens.com/WW/view/en/28448132)

SIMATIC Customer Online Support 

Service and Support 
An overview of the support offering for our products is available at the following URL:

● http://www.siemens.com/automation/service&support (http://www.siemens.com/
automation/service&support)

In Product Support, for example, you will find downloads of firmware updates, service packs 
and useful utilities.

Online Help is available so that you can successfully use the Support offering. Open the Online 
Help by selecting the corresponding button on the Internet site or at the following URL:

● http://support.automation.siemens.com/WW/support/html_00/help/Online_Hilfe.htm 
(https://support.industry.siemens.com/cs/helpcenter/en/index.htm)
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WinCC FAQs
WinCC Online Support with information on FAQs (Frequently Asked Questions) may also be 
found at the following URL:

● http://support.automation.siemens.com/WW/view/de/10805548/133000 (http://
support.automation.siemens.com/WW/view/en/10805583/133000)

Technical Forum
The Technical Forum supports exchange with other SIMATIC users. It is available at the 
following URL:

● http://www.siemens.com/automation/csi/forum (http://www.siemens.de/automation/csi_en/
forum)

Technical documentation for SIMATIC products
You can find a guide to the technical documentation provided for individual SIMATIC products 
and systems at the following URL:

● http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-
doku-portal)

Contact person database
To contact your local agent, search our contact database at the following URL:

● http://www.automation.siemens.com/partner/index.asp (http://
www.automation.siemens.com/partner/index.asp?lang=en)

Product Information 

SIMATIC WinCC
Go to the following URL for additional information about WinCC products:

● http://www.siemens.com/wincc (http://www.siemens.com/wincc)

SIMATIC Products
Go to the following URL for additional information about SIMATIC products:

● http://www.siemens.com/simatic (http://www.siemens.com/simatic)

See also
Internet: Support Request (http://www.siemens.com/automation/support-request)

Internet: Technical support (http://support.automation.siemens.com/WW/view/en/16605032)

Internet: Automation Validation Card (AVC) (http://support.automation.siemens.com/WW/
view/en/28448132)

Internet: Service and Support (http://www.siemens.com/automation/service&support)

Internet: WinCC FAQs (http://support.automation.siemens.com/WW/view/en/
10805583/133000)

Internet: Support Technical Forum (http://www.siemens.de/automation/csi_en/forum)
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Internet: Support Search (http://www.siemens.de/automation/csi_en/km)

Internet: Support Online Help (https://support.industry.siemens.com/cs/helpcenter/en/
index.htm)

Internet: Technical documentation for SIMATIC products (http://www.siemens.com/simatic-
tech-doku-portal)

Internet: Contact person database (http://www.automation.siemens.com/partner/index.asp?
lang=en)

Internet: Information about WinCC (http://www.siemens.com/wincc)

Internet: SIMATIC Products (http://www.siemens.com/simatic)

2.2.2.3 Support Request
Dear customer

In order to provide you with fast and effective support, please complete the "Support Request" 
form online on the Internet. Describe the problem in as much detail as possible. We would 
appreciate if you would provide us with all project data, so that we can reproduce the error 
situation or shorten the turn-around time.

Before filling out the support request, check whether your configured quantity structure is within 
the range of tested quantity structures (see topic "Performance Data").

Support Request form
The Support Request form is available at the following URL:   

● http://www.siemens.com/automation/support-request (http://www.siemens.com/
automation/support-request)

When filling out the report, you will be guided through several steps, which will ask about all 
required information.

A detailed description of the Support Request can be found at the following URL:

● http://support.automation.siemens.com/WW/view/en/16605654 (http://
support.automation.siemens.com/WW/view/en/16605654)

Procedure
1. Open the "Support Request" form using the link on the Internet. Step 1 "Select product" is 

displayed:

2. Enter the project name in the "Product/Order number" box. Upper/lower case is not relevant.
Search for parts of the product name or enter the full product name in the correct order. 
You can e. g. search for the following terms:
- "WinCC Runtime"
- "WinCC DataMonitor"
- "wincc webnavigator"
- "Connectivity"
The found products are offered in the "Product selection" field. 

3. Select the desired product and click on "Next" to switch to step 2 "Select use case".
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4. Select a use case or describe your specific use case in the "Other use case" field.

5. Press "Next" to switch to step 3 "Our solutions".
Suggested solutions and FAQs for the selected key words are listed.
Once you have found a suggested solution for your problem, you can close the form in the 
browser.
If you did not find any applicable suggested solutions, press "Next" to switch to step 4 
"Describe problem".

6. Describe your problem as exactly as possible in the "Details" field.
Pay particular attention to the following questions and comments. Please also check the 
WinCC installation and configuration with regard to the following references.
If you have any idea what has caused the error, please let us know. No detail should be 
omitted, even if you consider it unimportant.
- Was the configuration data created with older WinCC versions?
- How can the error be reproduced?
- Are other programs running simultaneously with WinCC?
- Have you deactivated the screen saver, virus checker and power management function?
- Search the computer for log files (WinCC\Diagnose\*.log, drwatson.log, drwtsn32.log). 
The log files are needed for error analysis. Thus, be sure to send the log files as well.

7. Use the "Search" button to upload your affected project and the log files (e. g. as a Zip file) 
to the Support Request.
Press "Next" to switch to step 5 "Provide contact information".

8. Enter your contact information.
Read the privacy notice and choose whether your personal data should be permanently 
saved.
Press "Next" to switch to step 6 "Summary & Send".

9. Press the "Print" button if you would like to print the support request.
You close the support request by clicking the "Send" button.
Your data will be transmitted to Customer Support and processed there.

Thank you for your cooperation. We hope that we can be of assistance in solving your problems.

Your WinCC Team 

See also
Internet: Error Report (http://www.siemens.com/automation/support-request)

Internet: Overview of Support Request  (http://support.automation.siemens.com/WW/view/en/
16605654)
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2.3 WinCC/DataMonitor Getting Started

2.3.1 DataMonitor

Overview   
You can display and evaluate current process states and historical data with WinCC/
DataMonitor via the Intranet/Internet. 

WinCC/DataMonitor consists of a server component and a client component. The DataMonitor 
server makes functions available to the DataMonitor client for analysis and display of data. 
Access rights control access to the functions.

● "WinCCViewerRT":
Program for monitoring of WinCC projects. The DataMonitor client is a so-called "View Only 
Client".

● "Excel Workbook":
Display of process values and archive values in an Excel table for evaluation and display 
via the web or as a print template for reports

● "Reports":
Creating reports from WinCC print jobs or from published Excel workbooks. This also allows 
for statistics and analyses of certain process data or historical data. The reports are created 
in PDF format and forwarded as e-mail if necessary.

● "Webcenter":
Central information portal for access to WinCC data via user-specific views. Clearly 
structured Webcenter pages with individual user rights for reading, writing and creating 
Webcenter pages.

● "Trends & Alarms":
For display and analysis of archived process values and alarms. The data is displayed in 
tables and diagrams on predefined Webcenter pages.

Quantity Structure
WinCC/DataMonitor allows the simultaneous operation of up to 50 clients per server.

Using terminal services
A configuration with 50 DataMonitor clients per terminal services server has been tested as a 
typical scenario.
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2.3.2 Preparations

Introduction
For the Getting Started, you will implement a WinCC single user system, on which the 
DataMonitor server will be installed. To access the data and display them with the DataMonitor 
client, the client is started on the DataMonitor server.

Requirement
Please follow the Installation Notes of WinCC and WinCC/DataMonitor.

● Internet Information Service is installed.

● WinCC is installed and has been started.

● The DataMonitor server is installed.

● The DataMonitor client is installed.

● A WinCC/DataMonitor license is installed.

● Internet Explorer is installed.

Configuration steps
You have to complete the following configuration steps to set up the DataMonitor system.

1. Configure the DataMonitor system.

– Define Windows user and access rights in Windows.

– Define WinCC user and access rights in "WinCC User Administrator" for 
WinCCViewerRT and "Excel Workbook".

– Set up the web page and firewall.

– Publish WinCC pictures.

2. Start the WinCC Runtime.

3. Set up the DataMonitor client.

– Configure the security settings of the Internet Explorer.

4. Use the DataMonitor client.

– Start the Internet Explorer and enter the address of the DataMonitor server.

– Log on to the DataMonitor server and access the DataMonitor functions.

5. Monitor the WinCC project with the WinCCViewerRT.

– Set up WinCCViewerRT.

– Display pictures.

WinCC/DataMonitor
2.3 WinCC/DataMonitor Getting Started

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 167



2.3.3 Configuring the DataMonitor system

2.3.3.1 Defining users in Windows

User groups in Windows

Overview     
The following user groups are created automatically in Windows when the DataMonitor server 
is installed.

SIMATIC Report Administrators
Membership of the user group "SIMATIC Report Administrators" is required for extended rights, 
especially for configuration purposes. At least one user must be created and assigned to the 
"SIMATIC Report Administrators" user group.

● You can also do the following as "SIMATIC Report Administrators" in the "Webcenter":

– Configuring connections

– Creating templates for Webcenter pages

– Creating and configuring public and private Webcenter pages

● You can also do the following as "SIMATIC Report Administrators" in "Reports":

– Configuring reports based on WinCC print jobs or Excel workbooks.

SIMATIC Report Users
Membership of the user group "SIMATIC Report Users" or of your own user group is required 
for the "Webcenter", "Trends & Alarms" and "Reports".

● You can also do the following as "SIMATIC Report Users" in the "Webcenter":

– Setting up and configuring Webcenter pages. The Webcenter pages are stored in 
different directories.

– Opening public pages

● You can also do the following as "SIMATIC Report Users" in "Reports":

– Opening reports based on WinCC print jobs or Excel workbooks.
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Defining Users and Access Rights in Windows

Introduction       
When using DataMonitor, users need different authentications. All users must be members of 
the "SIMATIC HMI" user group. For access to the WinCC database via DataMonitor, you need 
a Windows user with password who is a member of the "SIMATIC HMI VIEWER" user group.

This means you must create users with the matching user rights.

Requirement
● WinCC is installed.

● The DataMonitor server is installed.

Procedure using Windows 7 as an example 
1. Open the "Control Panel" from the Windows Start menu.

2. Double-click "System and Security" and then "Administrative Tools".

3. Double-click "Computer Management" in the "Administrative Tools" dialog.

4. Navigate to the "System Tools > Local Users and Groups / Groups" directory. In the shortcut 
menu select the entry "New user".

5. Enter a name such as "DM_Demo" in the dialog "New user" in the "User name" box.
Enter a description such as "User for DataMonitor" in the "Complete name" box.
Type the desired password into the "Password" box and then repeat it in the "Repeat 
password" box.
Create the user with "Create".
Close the "New user" dialog.

6. In the right part of the table window, click on the newly created user. Select the "Properties" 
command in the shortcut menu.
Switch to the "Member Of" tab.
Click "Add".

7. In the "Select Groups" dialog, click the "Advanced > Find now" button.

8. Select the entries "SIMATIC Report Administrators", "SIMATIC HMI"  and "SIMATIC HMI 
VIEWER" from the list at the bottom of the dialog.
Click "OK" twice to close the dialog.

9. In the properties of the user, the groups "SIMATIC Report Administrators", "SIMATIC HMI"  
and "SIMATIC HMI VIEWER" have been added to the list of memberships.
Click "OK".

10.Close the "Computer Management" dialog with "File > Exit".

11.Close the "Administrative Tools" window.
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Result
The user "DM_Demo" with membership of the user groups "SIMATIC Report Administrators", 
"SIMATIC HMI"  and "SIMATIC HMI VIEWER" has been set up. The user can now create 
directories in the Webcenter and make connections to WinCC databases.

Note

If a user wants to access remote computers via the DataMonitor server, the Windows user 
must be set up on the DataMonitor server as well as the remote servers with the same 
password.

2.3.3.2 Administering users for DataMonitor

Introduction     
For the use of certain functions on the DataMonitor client, users need authentication as 
DataMonitor user as well as authentication as WinCC user. Use one WinCC user for 
"WinCCViewerRT" and "Excel Workbook".

If you are working as DataMonitor user and WinCC user at the DataMonitor client you have to 
log on twice. You have two alternatives to only log on once:

● The DataMonitor user and the WinCC user have identical names and passwords.
The user must be configured in Windows and in WinCC and added to the "SIMATIC HMI" 
and "SIMATIC HMI VIEWER" user groups.

● SIMATIC logon allows the central administration of users.
In order to use SIMATIC logon in connection with DataMonitor, DataMonitor users must 
also be added to the user group "SIMATIC HMI VIEWER".
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Procedure
1. Select the entry "User Administrator" in the navigation window of WinCC Explorer. Select 

the "Open" command from the shortcut menu. The editor "User Administrator" is opened.

2. In the navigation window, select a user or create a new user.

3. Select a user group and then open the shortcut menu. Select the entry "New User". The 
name of the user can be changed directly with the <F2> function key or the shortcut menu 
command "Rename". The user must be selected beforehand for this purpose.

4. Enter a name and a password with at least six characters for "Login".
Click "OK".

5. Select the newly created user in the table window. The properties of the user are displayed.

6. Activate the option "WebNavigator". Select a start picture from the dropdown list next to 
"Web start picture".

7. Check the selected language and change this setting if desired via the dropdown list next 
to "Web language". You can only select a new language from the dropdown list if one of 
the two options "WebNavigator" or "PureWebClient" is activated. The languages created 
in the Text Library are available for selection.
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8. The user needs at least the authorization "Web Access - monitoring only".
In the row in the table window, activate the corresponding authorization in the "Enable" 
column.

9. Close the User Administrator.

2.3.3.3 Configuring the DataMonitor web page

Introduction     
You create the DataMonitor web page with the WinCC Web Configurator.

Requirement
● The DataMonitor server is installed.

● The Windows "Internet Information Service" component is installed.
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Procedure
1. Select "Web Navigator" in the navigation window of WinCC Explorer. Click the "Web 

Configurator" command in the shortcut menu.
Alternatively, in the Windows Start menu select "Start > All Programs > Siemens 
Automation > SIMATIC> WinCC > Webnavigator Server > WebConfigurator".

2. The Web Configurator detects whether a configuration already exists.

– No configuration found: Activate "Create a new standard website (Standalone)". Click 
"Next".

– Configuration found: Click "Next" and check the configuration.
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3. Select "Name of the web page" and enter the name.

4. Enter the number of the port used for access in the "Port" box.

5. At "IP address", specify whether the computer is to be available on the intranet or Internet 
or on both networks.
Use only the addresses that are available in the selection list.
Select "All not assigned" to enable intranet and Internet access to the computer.

6. Select "DataMonitor.asp" as the default web page.

7. Specify the time interval after which the DataMonitor client starts to reestablish a connection 
automatically in case of a connection error. A time setting of "0 s" disables the "Automatic 
reconnection" function.

8. Specify whether the web page is started once the configuration is completed.

9. Click "Finish" if you have not activated a firewall.
Click "Next" if you have installed a firewall. See the following pages to find out how to set 
up a firewall.

Result
You have created the Web folder and activated the web page. When you have activated the 
firewall, use the Web Configurator to configure its settings. 

2.3.3.4 Configuring the firewall

Introduction  
The chapter describes how to activate "HTTP" and "HTTPS" services for port "80" in Windows 7 
or in Windows Server 2008 R2.
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Consult your network administrator if you want to set up the Windows Firewall with advanced 
security or for a different port.

Requirement
● You have created a default web page with Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".

Procedure for the default port
1. Click the "Windows Firewall" button in the " WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Windows 7: Click "Allow a program or feature through Windows Firewall".
Windows Server 2008 R2: Click "Allow a program to communicate through Windows 
Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.
The server configuration is completed.
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2.3.3.5 How to publish WinCC process pictures using Web View Publisher

Introduction                       
Use Web View Publisher to publish the process pictures that you created in Graphics Designer. 
The WinCC Web Publishing Wizard supports you during publishing. 
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Procedure
1. Select "Web Navigator" in the navigation window of WinCC Explorer.

Select the "Web View Publisher" command in the shortcut menu.
The WinCC Web Publishing Wizard is now launched.

2. Click "Next".
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3. Activate the "Server prefix" option if you want to publish the pictures on a dedicated web 
server.
Select the prefix of the WinCC Server that contains the WinCC project from the selection 
list. The list displays the prefixes of the servers whose packages are loaded on the WinCC 
Client.
Deleting a prefix from the selection changes the paths displayed in the fields below.

4. Under "Path to your WinCC project", select the WinCC project folder containing the pictures 
you want to publish.
The folder has the following format for publication on a dedicated web server:
"\\<servername>\<serverprefix>_ _<projectname>".
If you want to publish from a remote station, select the source project containing the pictures.
The source project is displayed by its enable name on the other WinCC Server.
The folder has the following format:
"\\<computer name>\<enable name>".

5. Select the target folder for the published pictures under "Publishing folder of the WinCC 
web".
Accept the proposed folder within the WinCC project folder.
Do not change the path specification unless you want to transfer pictures to a different 
project, for example. In this case, the prefix selection list will be expanded accordingly.
Verify the specified target project to which the published pictures are saved during remote 
publishing.   
The path definition will be updated when you select the source project.
Should the target project be located on another WinCC server, select the corresponding 
project.
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6. Select the "Display hidden objects" option to show hidden objects that are published 
automatically in the results list.

7. Click "Next". Move the pictures that you wish to publish to the "Selected files" list.
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8. Click "Next". Move the C project functions which you use in the published pictures to the 
"Selected files" list. You cannot publish individual VB scripts.

Click "Next". 
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9. Move the referenced graphics that you wish to publish to the "Selected files" list. The 
referenced files are in the "GraCS" folder or in subfolders of "GraCS".

Click "Next". 

10.Click "Exit" to start publishing the pictures.
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Result
You have successfully published the pictures and functions. The results list displays the status 
of all published objects. You can click an object to view additional object information. 

You can trace publishing using the "<projectfolder>\WebNavigator\WizardLog.txt" file.
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Checking the scripts using "PdlPad"
The "WizardLog.txt" log file contains information about errors in the scripts used. You can also 
find errors using the "PdlPad" debugger. 

1. Open "PdlPad" by double-clicking on the affected object in the results list of Web View 
Publisher. The script of the published picture is displayed.

2. Click  in order to check the script.

3. You can temporarily correct and save the scripts. These corrections are only saved to the 
published pictures, not in the process picture of the WinCC project.

"PdlPad" can also be opened in the Windows Start menu via "SIMATIC > WinCC > 
WebNavigator-Server".
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2.3.4 Working with the DataMonitor client

2.3.4.1 Configuring security settings in Internet Explorer

Introduction   
For full functionality on the DataMonitor client, adapt the security settings in the Internet 
Explorer. 

Requirement
● Internet Explorer is installed.

Procedure
1. Click "Tools > "Internet Options" in the Internet Explorer.

This will open the "Internet Options" dialog.

2. Select the "Security" tab.

3. Select the "Trusted Sites" icon and click the "Sites" button.
The "Trusted Sites" dialog opens.

4. Enter the address of the DataMonitor server in the "Add this website to the zone" field.
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".

5. Deactivate the "Require server verification (https:) for all sites in this zone" check box.
Click "Add".
Confirm the entry by clicking "OK".

6. Select the "Trusted Sites" icon.

7. Click "Default Level".
Click "Adapt Level" in the next dialog.
The "Security settings" dialog box is opened. 

– Activate the "Activate" option under "Initialize and script ActiveX controls not marked as 
safe".

– Confirm the entry by clicking "OK".

8. Close the "Internet Options" dialog by clicking "OK".

Result
The necessary settings in the Internet Explorer of the DataMonitor client are configured.
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User authentication: Activated setting "Automatic logon with current user name and password" in 
Internet Explorer

If the setting "Automatic logon with current user name and password" is activated in Internet 
Explorer in "Tools > Internet Options > "Security" tab > "Adapt Level" button > entry "User 
Authentication" > Logon", this can lead to unexpected behavior under the following 
requirements.

Requirement
● The "Automatic logon with current user name and password" The setting is activated in 

Internet Explorer.

● The user logs onto the DataMonitor client as a WinCC user who is not configured in the 
user groups on the DataMonitor server.

● The user is logged onto the computer with a Windows logon that is set up as a user name 
on the DataMonitor server.

Behavior
1. The DataMonitor server does not recognize the WinCC user name the user has used to 

log onto the DataMonitor client and therefore rejects it. The user cannot see this behavior.

2. Internet Explorer automatically starts a new logon using the current Windows logon as user 
name.

3. The DataMonitor server recognizes the Windows logon as DataMonitor user name and 
accepts the logon for this user.

4. The user is logged on but not with the DataMonitor user name the user has entered. The 
current DataMonitor user is not displayed.

Recommendation
Disable the "Automatic logon with current user name and password" setting. 

Use the setting only when there is a clear distinction between Windows logon and DataMonitor 
user name.

2.3.4.2 DataMonitor start page on the DataMonitor client

Overview         
You start the DataMonitor client on a standalone computer or on a DataMonitor server. The 
start page of the DataMonitor summarizes the functions of the DataMonitor: 

● "Reports":
Creation and output of analysis results and process data in print jobs and published Excel 
workbooks.

● "Webcenter":
Creation of Webcenter pages for the display of archived data.
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● "Trends & Alarms":
Display of alarms and process values from archives in tables and diagrams.

● "Administration"
Configuration of connections and management of users, archives and pictures.

Requirement
● The user is created in WinCC.

● The user must be a member of the Windows user group "SIMATIC Report Administrators" 
or "SIMATIC Report Users" .

● The WinCC project on the DataMonitor server is in runtime.

Procedure
1. Start the Internet Explorer on the DataMonitor client.

2. Enter the name of the DataMonitor server in the format "http://<servername>" in the URL.
Confirm the entry with "Enter".
The log-in dialog is opened.

3. Enter the name of a Windows user and the associated password. Confirm with "OK".

Result
The start page with the DataMonitor functions will be displayed. The use of the functions 
depends on the access right of the user. 
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General Operations of the DataMonitor Client
● Select the desired interface language from the selection field in the header.

● Hide the header on the pages of "Webcenter" and "Trend & Alarms", if necessary.
Click . 
To show the header line again, click on the symbol .

● In order to log off from the DataMonitor server, click on the "Log off" link.
Exit Internet Explorer to free-up the used license immediately.

See also
Working with reports (Page 338)

Working with trends and alarms (Page 305)

Working with the Webcenter (Page 276)

2.3.5 Working with WinCCViewerRT

2.3.5.1 Configuring WinCCViewerRT

Introduction      
WinCCViewerRT is a program for visualizing WinCC projects. You can configure 
WinCCViewerRT for operation with the DataMonitor server and Graphics Runtime.

Requirement
● On the server

– The DataMonitor server is installed.

– A WinCC/DataMonitor license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

– The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring 
only".

● On the client

– The DataMonitor client is installed.
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Procedure
1. Select the "Start > Programs > Siemens Automation > Option and Tools > HMI Tools > 

WinCCViewerRT" command in the Windows Start menu.
The configuration dialog opens if you reconfigure WinCCViewerRT. 
WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> 
key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:

– Server address: "http://<Servername>" or "http://<IP-Adresse>"

– User name and password, if you want to specify a default user for the login dialog.

– The user settings you configured in the User Administrator will be activated if you enable 
the "Apply project settings" option.

3. Specify the Runtime language in the "Parameters" tab.
If necessary, disable any key combinations with which the user switches to other programs. 
If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open 
the WinCCViewerRT configuration dialog.
Define a key combination with which a user can log off and a new user can log on. The key 
combination can only be used if no default user has been set in the "General" tab.
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4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
- Start picture
- Configuration file for user-defined menus and toolbars
- Window attributes
- Impermissible user actions
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5. Specify additional user actions in the "Runtime" tab:
‑ Activating the screen keyboard
‑ <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating 
system via the screen keyboard.
- Auto-logoff settings

6. Close the dialog with the "OK" button.

Result
WinCCViewerRT is configured. The connection to the DataMonitor server is set up after you 
close the dialog. The settings are saved to the "WinCCViewerRT.xml" configuration file. The 
configuration file settings are used at the next start of WinCCViewerRT. WinCCViewerRT 
applies the user interface language from WinCC.

The configuration file is available in the folder "Documents and Settings\User\Application Data
\Siemens\SIMATIC.WinCC\WebNavigator\Client". You can rename the file, for example, to 
"User1.xml". You can also start WinCCViewerRT by means of the command line with the user-
specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for 
different configurations, depending on the logged-on user. 

The WinCCViewerRT configuration dialog opens at the start if you rename or delete 
"WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

Note

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut 
or hide the "Close" button. Function in the C-Script: DeactivateRTProject; function in the 
VBScript: HMIRuntime.Stop.

WinCC/DataMonitor
2.3 WinCC/DataMonitor Getting Started

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
190 System Manual, 02/2016, A5E37537386-AA



2.3.5.2 Displaying pictures

Requirement    
● A WinCC/DataMonitor license is installed on the DataMonitor server.

● The WinCC project on the DataMonitor server is in runtime.

● The WinCC pictures are configured and published for web access.

● The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only".

● WinCCViewerRT is configured on the DataMonitor client.

Procedure
1. Start WinCCViewerRT in the Windows Start menu with "Start > Programs > Siemens 

Automation > Options and Tools > HMI Tools".

2. Log on to the DataMonitor server:

– A login dialog is not displayed if the user name and password are set in the 
WinCCViewerRT configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
WinCCViewerRT configuration dialog. Enter the user name and password of the WinCC 
user. Click "OK".

3. To change the user, use the specified key combination for login/logoff of "WinCCViewerRT". 
The previous user is logged off. Enter the user name and password of the new WinCC user 
in the login dialog. Click "OK". 
The key combination can only be used if no default user has been set.

Result
WinCCViewerRT automatically connects to the activated WinCC project. The pictures of 
WinCC project are displayed. 

The "View Only Cursor" indicates that process-related operations are not possible. 

Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, 
are still possible. 

You can also use your own cursor icon as a "View Only Cursor", if required. For more 
information, refer to "Configuring Runtime settings (Page 260)".

The <F5> key triggers a reselection of WinCCViewerRT.
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2.3.6 Use of DataMonitor

2.3.6.1 Create connection and set up language

Introduction     
For access of the DataMonitor client to runtime data and archived data, configure connections 
to the WinCC databases in the "Webcenter". For each data source, set up a connection, e.g., 
to the WinCC server. You need the configured connections for Webcenter pages and "Trends 
& Alarms". 

Requirement
● The user is a member of the Windows user group "SIMATIC Report Administrators".

● For access to the WinCC database via DataMonitor, a Windows user with password is 
created who is a member of the "SIMATIC HMI VIEWER" user group.

Procedure
1. Click "Webcenter >Administration" on the start page.

2. Click the "Connection Administration" tab.

3. Select the option "New Connection". After the new installation, no selection is possible in 
the "Connection" box, as no connections have been configured yet.
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4. Select the language that corresponds with the linguistic region of the server or archive to 
be linked in "Linguistic Region". The setting ensures that special national characters are 
displayed correctly. 

5. Enter a name in the "Connection Name" box, such as "WinCC1_Runtime". The name 
should include a reference to the selected connection type. Do not use any blank spaces 
or special characters.

6. Enter the computer name on which the archive backup data are stored.
As an alternative, select the name of the computer using the "Find" button.

7. Enter the Windows user with password for the connection with the WinCC database.

8. Select the connection type to the WinCC data:

– "Swapped-out WinCC archive". Additional steps are necessary to access data on 
swapped archives. More information is available under "Connecting or separating 
swapped archives (Page 284)".

– "WinCC Runtime". Only the open single segment of the Runtime database is used.

– "CAS". The WinCC data of the central archive server are used.

– "WinCC Runtime + all segments". The open single segment and all other connected 
segments of the Runtime database are used.

9. Select the database for the connection type:

– "Swapped-out WinCC archive": Click "Display database" or select the archive from the 
list.

– "WinCC Runtime" and "CAS": Select the Runtime database of the activated WinCC 
project. As an alternative, select the name of the database using the "Find" button.

– "WinCC Runtime + all segments": "CC_ExternalBrowsing" is automatically entered as 
database.

10.Activate "Automatic adaptation of RT database" so that the database name is adjusted in 
the connection administration during a segment change.

11.Click the "Create" button.

Result
The connection to the data source is created and can be selected in the "Connection" box of 
the connection administration. 

2.3.6.2 Displaying process values and messages via "Trends and Alarms"

Displaying process values in a table

Introduction         
Use "Trends & Alarms" to display archived process values in a table.
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Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click the "Process Value Table" tab.
The Web part "Process Value Table" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.
The archive tags available via this connection will be displayed. 
Limit the display of the tags, if necessary:

– Select individual archives with "Archive selection".

– Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tag.

7. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click . 
Click "Preview" to check the set time range in the column "Preview Time Range". 

8. Specify the number of decimal points in the area "Representation of decimal points".

9. In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

10.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the web part to one or several Webcenter pages.

11.Click "OK" to confirm your entries.

Result
The values of the archive tags and the quality code are output in the process value table. 

If the manual entry of archive values is allowed during runtime, the modified or newly created 
values are identified as such. There is an "m" in a separate column to show a manual entry of 
the archive value.

WinCC/DataMonitor
2.3 WinCC/DataMonitor Getting Started

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
194 System Manual, 02/2016, A5E37537386-AA



Operation:

In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.

Export alarms in CSV format.
Changing the settings of the Web part.

Displaying process values in a diagram

Introduction     
Use "Trends & Alarms" to display archived process values in trends. 

Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click the "Trend (Process Values)" tab. The Web part "Trend (process values)" is displayed.
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3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field. The archive tags 
available via this connection will be displayed.
Limit the display of the tags, if necessary:

– Select individual archives with "Archive selection".

– Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tags, e.g. "TREND_0", "TREND_1", "TREND_2.
The archive tags are listed in the area "Current selection".

7. In the section "Current selection", you specify for the individual archive tag:

– Color of time axis and value axis

– Trend presentation type

8. In the section "Value axis editor", you can activate the automatic scaling for the different 
value axes or you can assign a minimum and maximum value to each axis.

9. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click . 
Click "Preview" to check the set time range in the column "Preview Time Range".

10.In the section "Diagram settings", you define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

11.Activate the option "Show legend" to display the legend.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the Web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.
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Result
The selected process values are displayed as trends in a diagram.

The legend shows the assignment of the colors to the archive tags. 

Operation:

In absolute time required to scroll forward or backward in the selected time range.
Enlarge the presentation and diagram range left or right of the center line. 
Restore the original view.
Exporting values of the displayed diagrams in CSV format
Changing the settings of the Web part.

Displaying messages in the alarm table

Introduction     
Use "Trends & Alarms" to display alarms in an alarm table. 
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Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click on the "Alarm Table" tab.
The web part "Alarm Table" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.

6. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click .
Click "Preview" to check the set time range in the column "Preview Time Range".

7. In the section "Language of the alarm texts", select the language, in which the alarms are 
displayed.

8. Select the respective WinCC server with "Selection of WinCC server", if necessary. The 
setting is necessary if you select a connection to swapped archives that include archives 
of several WinCC servers.

9. In the section "Filter selection", you may limit the expected search results with SQL syntax.
Set the filter conditions for individual columns to do so. 
Enter the filter condition for all columns in the "Extended Filter" field. 
For more information on filter conditions, click .

10.For representation of the data set the following:

– Sort order: For more information on sorting, click .

– Visible columns: To display all columns, click "Select All".

– Number of decimal places.

11.In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages".
Click  to assign the Web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.
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Result
The messages are output in a table.

Operation:

In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.

Export alarms in CSV format.
Changing the settings of the Web part.
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2.3.6.3 Displaying process values in an Excel workbook

Excel workbook

Overview         
With the Excel add-In "Excel Workbook" you can display the following data of the WinCC 
project in an Excel workbook on the DataMonitor client:

● Alarms

● Values of process tags and archive tags

● Additional information, such as time stamp or quality code of tags

Data of swapped archives is not displayed.

The data is evaluated by Excel and presented as graphic, e. g. as average value calculation 
or diagram representation. The created Excel workbooks are made available as templates for 
"Reports" and as report tools.

Requirement
● Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" 

and "Excel Workbook" on the DataMonitor client.

Configuring with XML file or online
Simultaneous online access to process data of different WinCC servers is possible using the 
"Excel Workbook". This requires that you either take the data from an XML file or from a local 
WinCC project during the configuration with the Excel add-in "Excel Workbook Wizard" . A 
separation between process and evaluation is possible with the XML file. 

● A WinCC project is open on the DataMonitor server.
The XML file is generated with the "Export Configuration Data" function. 
Then transfer the XML file to a computer with Microsoft Excel. 
Configure the process data display in the workbook. 
Afterwards, transfer the workbook to a DataMonitor client that displays the process data 
online.

● To accept the data of the WinCC project online, configure directly on the WinCC server or 
on a WinCC client with an online connection to the respective WinCC server.

● Import the data into an Excel workbook using the "Excel Workbook Wizard".
Then configure the display of alarms and tag values.

Note

If you rename a table in an Excel workbook, the configuration data of the table is lost.

You can configure up to 32,767 process and archive tags in an Excel workbook. During 
online display with "Excel Workbook" you may experience considerable delays in updating 
when there is a large number of tags.
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Configuring the Excel workbook

Applying data from WinCC project

Introduction     
You need the WinCC configuration data for the configuration of Excel workbooks. This means 
you apply the data from a local WinCC project during configuration in the "Excel Workbook 
Wizard" . 

Requirement
● Server computer

– Office 2007, Office 2010, or Office 2013 is installed.

– The Excel add-in "Excel Workbook" is installed.

– The DataMonitor server is installed.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● Configuration PC

– Office 2007, Office 2010, or Office 2013 is installed.

– The Excel add-in "Excel Workbook Wizard" is installed.

● MS Office

– Only Excel files with extensions "XLS, "XLSX, "XLSB", and "XLSM" may be used.

Procedure
1. Open an empty Excel workbook.

Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Establish connection with WinCC server". The "WinCC Server" box is 
shown.

3. Enter the desired name of the server and click "Connect". The log in dialog is displayed.

4. Enter the name and password of a WinCC user.

5. Click "Next". The "Add / delete tags" dialog opens.
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Result
The Excel workbook is set up to configure the display of process data. Then publish the 
workbook. The workbook is made available on the DataMonitor client as report tool or as 
template for "Reports".

Note
Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office Language 
Settings", and the Windows Regional Options.

Example:
● If you are using Office 2007 with the language "English (U.K.)", for instance, select the 

regional setting "English (U.K.)".
● If you have set "Chinese (PRC)" as a region and language option in Windows, you must 

also select "Chinese (PRC)" as the primary processing language in the "Microsoft Office 
Language Settings 2007".

More information can be obtained through Microsoft Support: http://support.microsoft.com/kb/
320369/en (http://support.microsoft.com/kb/320369/en)

See also
Configuring the display of tag values (Page 204)

Configuring the display of archive tags (Page 208)

Configuring the display of alarms (Page 212)

Applying data from a configuration file

Introduction     
You can create reports without connection to the WinCC server.

Configuration steps:
● Create a configuration file on the server.

● Configure data access with the configuration file.

● You can also configure the data access of a dedicated Web server / WinCC client.
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Requirement
● Server computer

– The DataMonitor server is installed.

– The online tags of the WinCC project are part of one tag group or one structure type.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● Configuration PC

– Office 2007, Office 2010, or Office 2013 is installed.

– The Excel add-in "Excel Workbook Wizard" is installed.

● MS Office

– Only Excel files with extensions "XLS, "XLSX, "XLSB", and "XLSM" may be used.

Creating a configuration file on the server 
1. Select the entry "WebNavigator" in the navigation window of WinCC Explorer.

Open the menu command "Export Configuration Data" in the shortcut menu.

2. Specify the data to be exported in the "Export configuration data" dialog. 
If you do not want to create the online tags in one tag group or one structure type, use the 
"Without structure (fast export)" option for the export.

3. Specify the path and the name of the XML file.

4. Click "Export". An XML file is generated.

5. If no Excel installation exists on the server, transfer the XML file to another computer, on 
which Excel and the "Excel Workbook Wizard" are installed.

Configuring data access with configuration file
1. Open an empty Excel workbook on the computer with Excel.

Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Load configuration data from file". Click "Next".

3. Navigate to the desired XML file.

4. Click "Next". The "Add / delete tags" dialog opens.

Result
The Excel workbook is set up to configure the display of process data. Then publish the 
workbook. The workbook is made available on the DataMonitor client as report tool or as 
template for "Reports". 
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Configuring data access of a dedicated Web server / WinCC client via XML file
If you want to display the project data from a dedicated Web server / WinCC client in the Excel 
workbook, you need to observe the following when configuring the Excel workbook via an XML 
file:

● The XML file now includes the data of subordinate servers whose packages are located on 
the DataMonitor server. The export of the loaded packages to the dedicated DataMonitor 
server / WinCC client can take several minutes, depending on the size of the package.

● This XML file must be available on the Excel configuration computer. Enter the server prefix 
when importing the configuration data in the "Excel Workbook Wizard".

● If you configure the data display in the Excel workbook on the WinCC client in the WinCC 
project, you do not have to specify a server prefix. The server prefix is automatically used 
when data is inserted from the package.

Note
Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office 
Language Settings", and the Windows Regional Options.

Example:
● If you are using Office 2007 with the language "English (U.K.)", for instance, select the 

regional setting "English (U.K.)".
● If you have set "Chinese (PRC)" as a region and language option in Windows, you must 

also select "Chinese (PRC)" as the primary processing language in the "Microsoft Office 
Language Settings 2007".

More information can be obtained through Microsoft Support: http://support.microsoft.com/
kb/320369/en (http://support.microsoft.com/kb/320369/en)

See also
Configuring the display of tag values (Page 204)

Configuring the display of archive tags (Page 208)

Configuring the display of alarms (Page 212)

Publishing the Excel workbook (Page 217)

Configuring the display of tag values

Introduction       
This chapter describes how to configure the display of tag values.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The dialog "Add/delete tags" is open.
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Procedure
1. Check the add sequence of tag groups in the "Adding tags" area.

2. Click on . The tag selection dialog opens.

3. Select the required tag and move the tag into a field in the Excel table with drag-and-drop.

4. Close the selection dialog. The tag is displayed in the tag list.
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5. Select the tag in the tag list and select the "Server settings" entry in the shortcut menu.

6. Enter the name and password of a WinCC user in the "Server setting" dialog.
To avoid an additional login during online display of process data, enable "Activate 
automatic login". 
Confirm your entries with "OK".
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7. Select the tag in the tag list and select the "Properties" entry in the shortcut menu.
The dialog "Tag properties" will be opened.

8. Set the properties for display in the table, for example, the update cycle or the display of 
time stamp and quality code. 

9. Specify settings for the headings.

10.You can save the settings to the properties. You can then load the settings and use them 
again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" 
file.

11.Confirm your entries with "OK". If necessary, repeat the procedure for additional online 
tags. The settings for the properties will be used again.  Multiple selection of tags is also 
possible in the tag list.

12.Click "Next" to display archive tags and alarms.
Additional information is available under "Configuring display of archive tags (Page 208)" 
and "Configuring display of alarms (Page 212)".

Result
The display of tag values is configured in the Excel workbook. Once you have saved the 
properties, you can use the settings whenever you need to.
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Each table field receives a short text and a comment in the Excel workbook. 

The short text "OV" in tag values stands for online tags. In the comments, the source of the 
displayed values is shown in the format "WDWO_<number>_<tagname>". 

Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data.
● after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.
Tags with local computer updating are not supported

In multiple station projects, you can activate the "Computer-local update" option in the tag 
management for internal tags. Any change of the tags only has an effect on the local computer 
in this case. This function is not supported by Excel Workbooks.

See also
Publishing the Excel workbook (Page 217)

Configuring the display of archive tags

Introduction       
This chapter describes how to configure the display of archive tags.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The "Add/delete archive tags" dialog is open.
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Procedure
1. Click  in the dialog "Add/delete archive tags".

2. The tag selection dialog opens.
Select the desired archive tag. 
Drag the tag to a cell in the Excel table with drag-and-drop.

3. Close the selection dialog. The tag is displayed in the tag list.
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4. Select the archive tag in the tag list, and select the "Properties" entry in the shortcut menu.
The "Archive tag properties" dialog opens.

5. Specify the settings for the insertion sequence and headings.
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6. Specify how much data you want to display. For a user-defined resolution, specify an integer 
number and the time unit or specify the quantity of data.

Note

If you use a user-defined data resolution with a combination of "Resolution" and "Quantity 
of data", it is possible that the amount of extracted data is not correctly determined. This 
results under certain circumstances in a mismatch between the displayed values and the 
configured quantity of data.

If you use the option "Quantity of data" in "User-defined resolution", enter an even value in 
the input box. Even values ensure a trend-true display.

7. In the "Time window" box, specify the time window from which you want to display archive 
tags:

● The time settings on the "Standard time" tag are based on the standard times:

– The settings for the relative time period refer to a period starting from the current time. 
You can enter positive and negative values for the past time period in the lines "From" 
and "To". For example, it is 12:00 (noon). You want to display the values for the last ten 
minutes. Activate all time options in the "Relative" line. Enter the value "-10" in the 
"Minutes" column of the "From" line.

– For settings of the absolute time period, enter the corresponding time parameters in the 
"From" and "To" lines and in the corresponding columns.

Click on the "Preview" button to check the time range set. 

● You can define a time window yourself or set a fixed interval, for example, "last week", on 
the "Legacy time" tab. If you want to define a time window yourself, you have the following 
possible settings:

– Relative time window: Specify the starting point and the duration. You can specify a 
duration ranging from a minute to days.

– Absolute time window: Specify the start and end of the time window.

1. If you select  the option "Display manually entered values", an additional column is 
displayed. You then see the letter "m" if an archived value was manually entered during 
runtime.

2. You can save the settings to the properties. You can then load the settings and use them 
again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" 
file.

3. Confirm your entries with "OK".
If necessary, repeat the procedure for additional archive tags. The settings for the properties 
will be used again. Multiple selection of tags is also possible in the tag list.

4. Click "Next" to display alarms. For more information, refer to "Configuring display of 
alarms (Page 212)".

Result
The display of archive tag values is configured in the Excel workbook. Once you have saved 
the properties, you can use the settings whenever you need to.

Each table field receives a short text and a comment in the Excel workbook. 
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The short text "AV" in tag values stands for archive tags. In the comments, the source of the 
displayed values is shown in the format "WDWA_<number>_<tagname>". 

Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data
● after deleting or inserting new rows or columns in the Excel workbook

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.

See also
Publishing the Excel workbook (Page 217)

Configuring the display of alarms

Introduction       
This chapter describes how to configure the display of alarms.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The "Add/delete alarms" dialog is open.
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Procedure 
1. Configure the alarms in the dialog "Add/delete alarms".

2. Select the required cell in the Excel table.
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3. Click . The "Alarm - properties" dialog opens.

4. On the "Standard configuration" tab, define the display options for alarms in the Excel table.

5. Enter a filter condition in the "Filter string" box or use the selection dialog to define a filter, 
for example, to display only specific alarms. If the filter contains a date or time, the "Time 
window" box is disabled.
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6. In the "Time window" box, specify the time window from which you want to display alarms: 

– The settings for the relative time period refer to a period starting from the current time. 
You can enter positive and negative values for the past time period in the lines "From" 
and "To". For example, it is 12:00 (noon). You want to display the alarms for the last ten 
minutes. Activate all time options in the "Relative" line. Enter the value "-10" in the 
"Minutes" column of the "From" line.

– For settings of the absolute time period, enter the corresponding time parameters in the 
"From" and "To" lines and in the corresponding columns.

Click on the "Preview" button to check the time range set.

7. Use the "Maximum number of alarms" option to limit the number of most recent alarms 
displayed. You can display maximum 1,000 messages.
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8. On the "Attributes" tab, select the required attributes of the alarms that you want to display.
Further details can be found in "Alarm attributes (Page 336)".

9. Specify the settings for the attribute insertion sequence and headings.

10.You can save the settings to the properties. You can then load the settings and use them 
again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" 
file.

11.Confirm your entries with "OK".
If necessary, repeat the procedure for additional alarms. The settings for the properties will 
be used again. Multiple selection of alarms is also possible in the "Alarm list".
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12.Click "Next". The "Description" dialog box opens.

13.You can enter a comment if needed. This comment is displayed when selecting files 
provided for download by the DataMonitor server.

Result
The display of alarms is configured in the Excel workbook. Once you have saved the properties, 
you can use the settings whenever you need to.

Each table field receives a short text and a comment in the Excel workbook. 

The short text for alarms is "AL". In the comments, the source of the displayed alarm is shown 
in the format "WDWL_<number>_<box name>".

Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data
● after deleting or inserting new rows or columns in the Excel workbook

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.

See also
Publishing the Excel workbook (Page 217)

Publishing the Excel workbook

Introduction
You make the configured Excel workbooks available on the DataMonitor client. The workbooks 
are published as report tool for the Intranet/Internet or used as template for "Reports". 

Requirement
● The DataMonitor server is installed on the computer.

● The display of tag values, archive values and alarms is configured.

● The "Description" dialog is open in the "Excel Workbook Wizard".
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Procedure
1. You make the workbooks available in the "Description" dialog.

2. If you click "Publish", the Excel workbook is made available on the DataMonitor client under 
"Report tools" in "Reports".
If you click "Template", the Excel workbook is made available on the DataMonitor client as 
template in "Reports" under "Excel Workbooks".

3. Exit the Excel Workbook-Wizard.

4. Save the workbook and close Excel.

Alternative Procedure
You upload the Excel workbooks on the DataMonitor client. Additional information is available 
under "Making Excel workbooks available as template (Page 338)" and "Making Excel 
workbooks available as report tool (Page 339)".
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Result
The Excel workbooks are made available on the DataMonitor client:

● The workbook is available on the "Report tools" tab. You can use the workbook to display 
process data in runtime. For more information, refer to "Displaying process data in an Excel 
workbook (Page 334)".

● You can create time-controlled and event-controlled reports using the workbook as 
template. For more information, refer to "Creating reports with an Excel workbook 
(Page 342)".

See also
Configuring the display of tag values (Page 204)

Configuring the display of archive tags (Page 208)

Configuring the display of alarms (Page 212)

Displaying process data in an Excel workbook

Introduction       
You can display process values or archive values and alarms in an available Excel workbook. 
You can edit and save the workbook.

Requirement
● The Excel workbooks were made available as report tool.

● MS Excel for online display in the Excel workbook

● The DataMonitor server is installed.

● The WinCC project is in Runtime.

● The start page of the DataMonitor is open.

● A user is created in WinCC.
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Procedure
1. Click "Reports" on the start page.

2. Click "Report tools".
You see the Excel workbooks that you have published in the Excel Workbook Wizard or 
made available as report tool.

3. Select a workbook.

4. Double-click the icon of the Excel workbook.

5. In the dialog that follows, click "Open". The workbook is opened.

6. Select the entry "Excel Workbook" in the "DataMonitor" menu.

7. The name of the server whose process data are configured in the workbook is displayed 
in the "WinCC server" field.
The "WinCC Server" field can include the following information:

– Access via domain: The server name and the domain are listed for access outside the 
network domain.

– The DataMonitor start page is the default web page: The "WinCC Server" field contains 
only the server name.

– The DataMonitor start page is in the virtual folder: The server name and the name of 
the virtual folder are displayed, e.g. "/webnavigator".

8. If the tags in the Excel sheet are from several servers, activate "all servers". The tag values 
of all servers are updated in the online display.

Note

To establish connections to all servers, activate "all servers" with "Connect" before you 
establish the connections.

9. Activate the connection to the WinCC project via the button "Connect". After a successful 
connection, the log-in dialog will be opened.
Type in the user name and associated password. 
In case of several servers, the log-in dialogs of the respective servers open one after the 
other.
If a connection was not established, a corresponding alarm is displayed. Clicking on the 
dialog will display additional information about the error that has occurred.

Note

Do not close the "Excel Workbook" dialog as long as the log-in dialog for connection 
establishment to the server is still open.
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10.The connection status will be displayed in the dialog.
Click the "Read tags", "Read archive tags" and "Read alarms" buttons to update the 
respective values or displays.

11.Activate the check box "Read cyclically" to update the tag values in cycles.

12.Close the "Excel Workbook" dialog after finishing your calculations in Excel.

13.Save the results in the workbook with the "Save as" menu command.

14.Close Excel.

Result
The process data are displayed in the Excel workbook and can be processed further.

If errors occur during display of the Excel workbook or no connection to the WinCC server is 
established, the log entries are displayed in a workbook. The entries contain the date, the tags 
or alarms affected, the server, and the error message.

2.3.6.4 Outputting data using "Reports"

Reports

Introduction           
Use "Reports" to create time-controlled and event-controlled reports independent of the 
SCADA system. Use the WinCC print jobs and published Excel workbooks to output analysis 
results and process data. The reports are output as PDF or XLS file and can be attached to 
an e-mail.
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Requirement
● You need a PDF reader for output as PDF file. The PDF reader can be obtained from 

www.adobe.com for example.

● For Output as XLS-file (Excel workbook):

– MS Excel 2007 or a later version is installed.
To use the automatic creation of Excel reports on the DataMonitor server, MS Excel 
must be installed on the server.

– The Excel workbook is created and published as template on the DataMonitor server.

● Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" 
and "Excel Workbook".

Using reports
You determine on the DataMonitor server when you want to create reports:

● Manually, for example, by a plant operator.

● Event-controlled, for example, when a tag value changes.

● Time-controlled, such as daily, for example.

The created reports are centrally saved in the directories on the DataMonitor server. Users 
can access the different folders with appropriate authorization from the DataMonitor client. 

Note

The creation time is always displayed on a DataMonitor client in the local time zone of the 
server.

Making an Excel workbook available as template

Introduction   
You can make Excel workbooks available as templates to create ""Reports"". For this you have 
the following options:

● You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard"  
using the "Template" button.

● You upload an Excel workbook not yet published to the DataMonitor client.

This page includes a description of how you make a template available on a DataMonitor client.

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Reports" on the start page.

2. Click the "Uploading templates" tab.

3. Select a directory, in which the template will be stored in the "Target directory" field.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Click "Find" for the "Selected template". Navigate to the desired Excel workbook.

5. Click the "Upload" button.

Result
You can create time-controlled and event-controlled reports using the workbook as template. 

See also
Displaying a report with an Excel Workbook (Page 226)

Making an Excel workbook available as a report tool

Introduction   
You can make Excel workbooks centrally available as report tools in "Reports". For this you 
have the following options:

● You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard"  
using the "Publish" button.

● You upload an Excel workbook not yet published to the DataMonitor client.

Here you find a description of how you make an Excel workbook not yet published available 
on the DataMonitor client.
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Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click the "Uploading templates" tab.

3. Click "Find" for "Uploading templates for Excel workbooks". Navigate to the desired Excel 
workbook.

4. Click the "Upload" button.

Result
The workbook is available on the "Report tools" tab. You can use the workbook to display 
process data in runtime. 

See also
Displaying process data in an Excel workbook (Page 219)

Making Settings for Reports

Introduction           
Different settings are required for using the "Reports" function in DataMonitor. 
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Requirement
● PDF Reader is installed.

● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click on the "Settings" tab. The "Settings" page is displayed.

3. Check the entries in the section "General project settings".
You can now select the printer of the Web server. Printing is only possible in files.

4. To enable the output to a PDF file, activate the option "Activate API print".
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5. Enter the data for sending mail in the "Mail" area:

– Server: Outgoing mail server (SMTP)

– User name: Name for the sender

– Password

– Sender: E-mail account used to sending the e-mail

6. Click the disk icon in the section "General project settings" to save your settings.

7. In the "Settings of the circular buffer" area, you can define the number of created reports 
that are stored in the selected destination directory. The box has a pre-assigned value of 
20. If the maximum number of reports of the same type has been reached, the "First in First 
out" principle applies. For example, if 21 reports of "Alarm Table" type have been created, 
the report that was created first is removed.

8. Click the disk icon in this section to save your settings.

Result
The settings for "Reports" have been made.

Product support - example
FAQ "51334611" on the Internet under "Product support" gives a detailed example:

● http://support.automation.siemens.com/WW/view/en/51334611

Displaying a report with an Excel Workbook

Introduction   
Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following 
is a description for creating reports from Excel workbooks. 

Requirement
● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● You have already published or made available as templates the Excel workbooks you want 
to use.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Reports" on the start page.

2. Click on the "Excel Workbooks" tab. The "Excel Workbooks" page is displayed.

The icons in front of "List of time-controlled Excel workbooks" and "List of event-controlled 
Excel workbooks" are deactivated. The icons indicate that no reports are currently 
configured.

3. Select one of the available Excel workbooks under "Available Excel workbooks".

4. Select the target directory in which you want to store the reports. Only the directories, for 
which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail 
recipient" field. You can enter several recipients as you would with any standard e-mail 
program.

6. Use  to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-
controlled creation of the report in the following steps.

8. To configure a time-controlled report, enter the following in the "Time-controlled Excel 
workbooks" area:

– Date: Enter the date in the respective field or enter the date using the calendar. To open 
the calendar, click the "Calendar" icon.

– Time: Define the time when you want the report to be created.

– Repetition: Define the repetition rate, for example, "Once" or "Weekly".
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9. Click "Add" in the "Time-controlled Excel workbooks" area. The report is displayed in the 
"List of time-controlled Excel workbooks".

10.To configure an event-controlled report, enter the following in the "Event-controlled Excel 
workbooks" area:

– Selected WinCC tag: Click . Select the required tag in the selection dialog.

– Defining event control: Set the triggering event, for example, when the tag value 
changes.
If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the 
respective limits.

11.Click "Add" in the "Event-controlled Excel workbooks" area. The report is displayed in the 
"List of event-controlled Excel workbooks".

Result
A time-controlled or event-controlled report is configured as "Excel Workbook". 

The configured reports are displayed in the lists of the "Excel Workbooks" . You can edit or 
delete the reports in the lists. 

Once the report has been created, it is available in runtime on the "Published Reports" tab in 
the selected directory. 

Note
Information on event-controlled "Excel Workbooks"

An event-controlled report is only created if the time period in which the tag changes is greater 
than one minute.

Keep in mind that the frequent creation of one or more event-controlled reports over a long 
period of time takes up a lot of memory and uses up valuable resources. This case often occurs, 
for example, with frequent signal changes of a tag that trigger an event-controlled report.

Creating a report with a print job

Introduction   
Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following 
is a description for creating reports using print jobs in PDF format. 

Requirement
● PDF Reader is installed.

● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Reports" on the start page.

2. Click on the "Print jobs" tab. The "Print jobs configuration" page is displayed.

The icons in front of "List of time-controlled print jobs" and "List of event-controlled print 
jobs" are deactivated. The icons indicate that no print jobs are currently configured.

3. Select the desired print job under "Available print jobs".

4. Select the target directory in which you want to store the reports. Only the directories, for 
which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail 
recipient" field. You can enter several recipients as you would with any standard e-mail 
program.

6. Use  to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-
controlled creation of the report in the following steps.

8. To configure a time-controlled report, enter the following in the "Time-controlled print jobs" 
area:

– Date: Enter the date in the respective field or enter the date using the calendar. To open 
the calendar, click the "Calendar" icon.

– Time: Define the time when you want the report to be created.

– Repetition: Define the repetition rate, for example, "Once" or "Weekly".

9. Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of 
time-controlled print jobs".
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10.To configure an event-controlled report, enter the following in the "Event-controlled print 
jobs" area:

– Selected WinCC tag: Click . Select the required tag in the selection dialog.

– Defining event control: Set the triggering event, for example, when the tag value 
changes.
If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the 
respective limits.

11.Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of 
event-controlled print jobs".

Result
A time-controlled or event-controlled report is configured as print job in PDF format. 

The configured reports are displayed in the lists of the print jobs. You can edit or delete the 
reports in the lists.

The report is created in the language that was set during WinCC configuration. The WinCC 
Runtime language does not have an effect on the representation of dynamic elements, such 
as tables.

Once the report has been created, the PDF files are available in runtime on the "Published 
Reports" tab in the selected directory.

Note
Opening Asian PDF files with Acrobat Reader

To open the Asian PDF files created with "Reports", you need the country-specific version or 
the respective font package of the Adobe Acrobat Reader.

The four Asian languages are fixed to one font each. This means the font settings in the report 
layout will not have an effect on the Asian languages.
Information on event-controlled print jobs

An event-controlled print job is only created if the time period in which the tag changes is 
greater than one minute.

Keep in mind that the frequent creation of one or more event-controlled print jobs over a long 
period of time takes up a lot of memory and uses up valuable resources. This case often occurs, 
for example, with frequent signal changes of a tag that trigger an event-controlled print job.
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2.3.6.5 Creating Webcenter pages in "Webcenter"

Web center

Overview     
The Webcenter is the central information portal for access to WinCC data via Intranet/Internet. 
Users can use the Webcenter pages and web parts to compile and save their views of WinCC 
data. The Webcenter pages are stored in directories.

The Webcenter pages are stored in modular fashion. The modules are defined by layout 
templates. Users can either use the supplied layout templates or the ones they create 
themselves.

The web parts are the individual blocks that prepare and display data. You can combine up to 
15 web parts in one screen view. For more information, refer to "Overview of web parts 
(Page 231)".

Within the WebCenter pages, the configuration of the respective web part is stored and can 
be called up again at any time. The multiple use of the same web part with different 
configuration is also possible. The WebCenter pages that have been created in this way can 
be opened with the same configuration by different users depending on the assigned rights.

You can export the configuration of web parts as XML file.

To transfer the configuration data to another computer, copy the folder:

"\Siemens\WinCC\WebNavigator\DataMonitorServer\WebCenter\App_Data\WebCenter"

Basic procedure
1. Creating directories for Webcenter pages

2. Assigning Access Rights

3. Establishing connection to the WinCC data

4. Publishing pictures for the Webcenter

5. Creating layout template for Webcenter pages

6. Creating Webcenter page

7. Inserting web parts to the Webcenter page

8. Configuring web parts within Webcenter pages

Overview of Web Parts

Overview   
You compile Webcenter pages from the web parts in the "Webcenter". 
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The following web parts are available:

● Process value table
The available process values are displayed for the defined time period.

● Process Values in the Table (Timestep)
The complete archive name and the tag name are displayed as tooltip in the column header.
The process values are combined beginning with the starting time in the defined time 
interval. 
Depending on the set aggregate type, the interval for the interval event is displayed.
For example, a process value was archived every 30 seconds. You have selected an 
interval of 60 seconds and the aggregate type "Average value". It determines the average 
value of two archive values each, which is then displayed in the table with the first time 
stamp of the averaging interval. 
If you select an aggregate type without interpolation, and if no value is present in the interval, 
no interval result will be displayed. If you select an aggregate type with linear interpolation, 
an interval result is displayed for each interval. 

● Statistics functions for process values
All available process values are used for the defined time period, for example, to calculate 
and display the average value.

● Trend Process Values
The process values are displayed with trends.

● Trend (Timestep)
Clear presentation of precompressed values in trends with aggregate functions, such as 
sum or average.

● Bar Chart (Aggregates)

● Pie Chart (Aggregates)

● Alarm table
Presentation of accrued alarms.

● Alarm hit list
Presentation of statistical information on alarms.

● Link to WebCenter pages

● Links (external)
Links to internal Webcenter pages and external Internet pages, such as stock market news.

● Displaying information
 Such as news, for example.

● Static process pictures
WinCC pictures are integrated into the Webcenter without installation download. A JPG 
screenshot of the process picture is created on the DataMonitor server at regular intervals.

● Display Graphic
JPG screenshots, such as company logo.

● The Last Reports
Display the reports created last, for example, the last ten print jobs in PDF format created 
with "Reports".
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See also
Displaying process values in a table (Page 305)

Displaying process values in a diagram (Page 306)

Displaying the hit list of messages (Page 312)

Displaying messages in the alarm table (Page 308)

Displaying statistics function for process values (Page 314)

Creating layout template for Webcenter pages

Introduction     
You need a layout template to create a Webcenter page. Predefined layouts were installed 
during the installation. Additionally, you can create your own Layout Templates.

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Creating layout" tab.

3. Define the number of columns and the number of lines.

4. Enter the name in the "Name of the layout file" box, for example, "mylayout_23". Click "Next".
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5. Combine the table fields, if necessary. To do so, click the desired arrow symbol, such as 
"Arrow up", in the desired field, for example line 3 / column 1. The modified view will be 
displayed.
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6. To restore the original table layout, click "Reset configuration". Click "Next".

7. Arrange the web parts in the table fields. If necessary, activate the corresponding symbol 
in a table field to place the web parts vertically or horizontally.

8. Click "Save".

Result
The layout template "mylayout_23" is created. You can use the layout template as a template 
for creating a Webcenter page. 

Creating Webcenter page

Introduction  
You create Webcenter pages in which you add web parts. The Webcenter pages are stored 
in directories. In this example, the WebCenter page is saved in the "myPart" directory.

You can only change or create Webcenter pages in directories for which the Windows user 
group has the "Edit" or "Create" access rights. 
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Requirement
● The directory "myPart" is set up.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Creating page" tab.

3. Click on the desired layout template. The file name is displayed in the "Layout file" box.

4. Enter a name in the "Webcenter page" box, for example, "My_Webcenter".
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5. Select the directory in which the Webcenter page is stored. The selected directory is 
displayed in the box "Save WebCenter page as".

6. Click "Save".

Result
The Webcenter page "My_Webcenter" is created and saved.
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Inserting web parts to the Webcenter page

Introduction    
You compile the contents of the Webcenter pages from the web parts. 

Requirement
● The directory "myPart" is set up.

● The Webcenter page "My_Webcenter" is stored in the directory.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Pages" on the start page.

2. Click on the "myPart" tab.

3. Click on the entry "My_Webcenter".
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4. To add web parts, click  at the top right edge of the page. The available web parts are 
listed.
If you have exported web parts that have already been configured, they are listed under 
"Imported web parts". If necessary, insert these web parts into your Webcenter page.

5. Activate the entry "Trend (Timestep)".

6. Select the entry "WPZ_01_01" and click "Add".

7. Activate the entry "Hit list of alarms".
If you insert several web parts into a table field, the web parts are arranged horizontally or 
vertically. You specify the arrangement when you create the layout template.

8. Select the entry "WPZ_02_01" and click "Add".

9. Click "Exit".
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Result
Web parts to display data are inserted into the Webcenter page "My_Webcenter". The current 
compilation of the Webcenter page is displayed.
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2.4 WinCC/DataMonitor Documentation

2.4.1 Basic principles

2.4.1.1 DataMonitor

Overview   
You can display and evaluate current process states and historical data with WinCC/
DataMonitor via the Intranet/Internet. 

WinCC/DataMonitor consists of a server component and a client component. The DataMonitor 
server makes functions available to the DataMonitor client for analysis and display of data. 
Access rights control access to the functions.

● "WinCCViewerRT":
Program for monitoring of WinCC projects. The DataMonitor client is a so-called "View Only 
Client".

● "Excel Workbook":
Display of process values and archive values in an Excel table for evaluation and display 
via the web or as a print template for reports

● "Reports":
Creating reports from WinCC print jobs or from published Excel workbooks. This also allows 
for statistics and analyses of certain process data or historical data. The reports are created 
in PDF format and forwarded as e-mail if necessary.

● "Webcenter":
Central information portal for access to WinCC data via user-specific views. Clearly 
structured Webcenter pages with individual user rights for reading, writing and creating 
Webcenter pages.

● "Trends & Alarms":
For display and analysis of archived process values and alarms. The data is displayed in 
tables and diagrams on predefined Webcenter pages.

Quantity Structure
WinCC/DataMonitor allows the simultaneous operation of up to 50 clients per server.

Using terminal services
A configuration with 50 DataMonitor clients per terminal services server has been tested as a 
typical scenario.
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2.4.1.2 WinCCViewerRT

Overview   
The Web Viewer "WinCCViewerRT" is solely a display program for WinCC projects that is 
installed with the DataMonitor client. The DataMonitor Client is therefore a "View Only Client". 

You run the "WinCCViewerRT.exe" application instead of Internet Explorer on the DataMonitor 
Client. 

The Web Viewer accesses the DataMonitor server using its own communication. This way you 
prevent access by users to the Internet and protect the system from viruses and trojans. 

The viewer only displays the pictures that you configured for web access and published on the 
DataMonitor server.

The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only". 
The "View Only Cursor" indicates that process-related operations are not possible. Certain 
operations, such as opening the properties dialog of an OnlineTrendControl, are still possible. 

If the WinCC user does not have authorization no. 1002, the DataMonitor client runs in demo 
mode after logon.

2.4.1.3 Web center

Overview     
The Webcenter is the central information portal for access to WinCC data via Intranet/Internet. 
Users can use the Webcenter pages and web parts to compile and save their views of WinCC 
data. The Webcenter pages are stored in directories.

The Webcenter pages are stored in modular fashion. The modules are defined by layout 
templates. Users can either use the supplied layout templates or the ones they create 
themselves.

The web parts are the individual blocks that prepare and display data. You can combine up to 
15 web parts in one screen view. For more information, refer to "Overview of web parts 
(Page 243)".

Within the WebCenter pages, the configuration of the respective web part is stored and can 
be called up again at any time. The multiple use of the same web part with different 
configuration is also possible. The WebCenter pages that have been created in this way can 
be opened with the same configuration by different users depending on the assigned rights.

You can export the configuration of web parts as XML file.

To transfer the configuration data to another computer, copy the folder:

"\Siemens\WinCC\WebNavigator\DataMonitorServer\WebCenter\App_Data\WebCenter"

Basic procedure
1. Creating directories for Webcenter pages

2. Assigning Access Rights
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3. Establishing connection to the WinCC data

4. Publishing pictures for the Webcenter

5. Creating layout template for Webcenter pages

6. Creating Webcenter page

7. Inserting web parts to the Webcenter page

8. Configuring web parts within Webcenter pages

2.4.1.4 Overview of Web Parts

Overview   
You compile Webcenter pages from the web parts in the "Webcenter". 

The following web parts are available:

● Process value table
The available process values are displayed for the defined time period.

● Process Values in the Table (Timestep)
The complete archive name and the tag name are displayed as tooltip in the column header.
The process values are combined beginning with the starting time in the defined time 
interval. 
Depending on the set aggregate type, the interval for the interval event is displayed.
For example, a process value was archived every 30 seconds. You have selected an 
interval of 60 seconds and the aggregate type "Average value". It determines the average 
value of two archive values each, which is then displayed in the table with the first time 
stamp of the averaging interval. 
If you select an aggregate type without interpolation, and if no value is present in the interval, 
no interval result will be displayed. If you select an aggregate type with linear interpolation, 
an interval result is displayed for each interval. 

● Statistics functions for process values
All available process values are used for the defined time period, for example, to calculate 
and display the average value.

● Trend Process Values
The process values are displayed with trends.

● Trend (Timestep)
Clear presentation of precompressed values in trends with aggregate functions, such as 
sum or average.

● Bar Chart (Aggregates)

● Pie Chart (Aggregates)

● Alarm table
Presentation of accrued alarms.

● Alarm hit list
Presentation of statistical information on alarms.

● Link to WebCenter pages
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● Links (external)
Links to internal Webcenter pages and external Internet pages, such as stock market news.

● Displaying information
 Such as news, for example.

● Static process pictures
WinCC pictures are integrated into the Webcenter without installation download. A JPG 
screenshot of the process picture is created on the DataMonitor server at regular intervals.

● Display Graphic
JPG screenshots, such as company logo.

● The Last Reports
Display the reports created last, for example, the last ten print jobs in PDF format created 
with "Reports".

See also
Displaying process values in a table (Page 305)

Displaying process values in a diagram (Page 306)

Displaying the hit list of messages (Page 312)

Displaying messages in the alarm table (Page 308)

Displaying statistics function for process values (Page 314)

2.4.1.5 Trends and Alarms

Overview   
"Trends & Alarms" is used for display and analysis of archived process values and alarms.

Predefined web pages have the following content:

● Displaying process values in a table (Page 305)

● Displaying a maximum of three process values in a diagram. Displaying process values in 
a diagram (Page 306)

● Displaying statistics function for process values (Page 314)

● Displaying alarm hit list (Page 312)

● Displaying alarms in the alarm table (Page 308)

The functions of "Trends & Alarms" are configured with web parts. Use the same web parts 
for this purpose that you used for the Webcenter pages.

Within Trends & Alarms each user can only make one configuration for each web part. The 
configuration is saved for the user. Other users cannot access the configuration of this web 
part directly.
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2.4.1.6 Excel workbook

Overview         
With the Excel add-In "Excel Workbook" you can display the following data of the WinCC 
project in an Excel workbook on the DataMonitor client:

● Alarms

● Values of process tags and archive tags

● Additional information, such as time stamp or quality code of tags

Data of swapped archives is not displayed.

The data is evaluated by Excel and presented as graphic, e. g. as average value calculation 
or diagram representation. The created Excel workbooks are made available as templates for 
"Reports" and as report tools.

Requirement
● Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" 

and "Excel Workbook" on the DataMonitor client.

Configuring with XML file or online
Simultaneous online access to process data of different WinCC servers is possible using the 
"Excel Workbook". This requires that you either take the data from an XML file or from a local 
WinCC project during the configuration with the Excel add-in "Excel Workbook Wizard" . A 
separation between process and evaluation is possible with the XML file. 

● A WinCC project is open on the DataMonitor server.
The XML file is generated with the "Export Configuration Data" function. 
Then transfer the XML file to a computer with Microsoft Excel. 
Configure the process data display in the workbook. 
Afterwards, transfer the workbook to a DataMonitor client that displays the process data 
online.

● To accept the data of the WinCC project online, configure directly on the WinCC server or 
on a WinCC client with an online connection to the respective WinCC server.

● Import the data into an Excel workbook using the "Excel Workbook Wizard".
Then configure the display of alarms and tag values.

Note

If you rename a table in an Excel workbook, the configuration data of the table is lost.

You can configure up to 32,767 process and archive tags in an Excel workbook. During 
online display with "Excel Workbook" you may experience considerable delays in updating 
when there is a large number of tags.
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2.4.1.7 Reports

Introduction           
Use "Reports" to create time-controlled and event-controlled reports independent of the 
SCADA system. Use the WinCC print jobs and published Excel workbooks to output analysis 
results and process data. The reports are output as PDF or XLS file and can be attached to 
an e-mail.

Requirement
● You need a PDF reader for output as PDF file. The PDF reader can be obtained from 

www.adobe.com for example.

● For Output as XLS-file (Excel workbook):

– MS Excel 2007 or a later version is installed.
To use the automatic creation of Excel reports on the DataMonitor server, MS Excel 
must be installed on the server.

– The Excel workbook is created and published as template on the DataMonitor server.

● Use the Download area in "Reports" to install the Excel add-ins "ExcelWorkbook Wizard" 
and "Excel Workbook".

Using reports
You determine on the DataMonitor server when you want to create reports:

● Manually, for example, by a plant operator.

● Event-controlled, for example, when a tag value changes.

● Time-controlled, such as daily, for example.

The created reports are centrally saved in the directories on the DataMonitor server. Users 
can access the different folders with appropriate authorization from the DataMonitor client. 

Note

The creation time is always displayed on a DataMonitor client in the local time zone of the 
server.

See also
Configuring the display of tag values (Page 204)

Making an Excel workbook available as template (Page 338)

Configuring the Excel workbook (Page 201)
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2.4.2 Configuring the DataMonitor system

2.4.2.1 Overview of the configuration steps

Introduction  
For use of WinCC/DataMonitor the data and process pictures are made available on the 
DataMonitor server. The DataMonitor client accesses the available data to display data and 
process pictures.

Requirement
● Server and client are interconnected.

● On the server

– Internet Information Service is installed.

– The DataMonitor server is installed.

– A WinCC/DataMonitor license is installed.

– WinCC is installed.

● On the client

– Internet Explorer is installed.

Configuration steps
You have to complete the following configuration steps to set up the DataMonitor system.

1. Configuration of the WinCC project.

– Publish WinCC pictures.

– Define users and access rights in "WinCC User Administrator", if you use 
WinCCViewerRT and/or "Excel Workbook" .

– Configure the settings for Runtime.

2. Configure the DataMonitor server.

– Set up the web page and firewall.

– Define users and access rights in Windows, if you use "Trend & Alarms", "Reports" and 
"Webcenter".

3. Start WinCC Runtime on the server.
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4. Use the DataMonitor functions on the DataMonitor client.

– Check the security settings of the Internet Explorer.

– Start the Internet Explorer and enter the address of the DataMonitor server.

– Log on to the DataMonitor server and access the DataMonitor functions.

5. Monitor the WinCC project on the DataMonitor client.

– Configuring WinCCViewerRT

– Displaying pictures

See also
Configuring the DataMonitor web page (Page 264)

Configuring security settings in Internet Explorer (Page 268)

Configuring runtime settings (Page 260)

Creating static process pictures for the Webcenter (Page 291)

Defining users in Windows (Page 262)

2.4.2.2 Configure the WinCC project

Publishing WinCC process pictures

Publishing WinCC Process Pictures

Introduction         
If you wish to display WinCC process pictures on the WebNavigator Client or DataMonitor 
Client, you have to publish the pictures. For publishing, you use the Web View Publisher, which 
automatically makes the necessary adaptations to the project data. 

WinCC/DataMonitor
2.4 WinCC/DataMonitor Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
248 System Manual, 02/2016, A5E37537386-AA



Overview
The Web View Publisher enables the following types of publishing: 

● Publishing on the local computer.
The current WinCC project folder is the source folder.
The target folder is a subfolder, for example, "Projectname/WebNavigator/Pictures".

● Publishing on a dedicated web server with a server prefix.
The source folder is the WinCC project folder on another WinCC computer that is defined 
by the server prefix.
The target folder is located in subfolder ".../WebNavigator/Pictures" of the WinCC project 
on the WinCC Client. The pictures of your own project are saved with the name 
"<picturename>.PD_", while the pictures of other projects are saved with the name 
"<serverprefix>_ _<picturename>.PD_".

● Remote publishing.
The source and target folders can be located on the same or different web servers.
You can start the Web View Publisher on the web server with the source and target folder 
or on a third web server.

● Remote publishing on a dedicated web server or WinCC Client from a different remote 
station.
The project folder of the WinCC project must be released in Windows on the dedicated web 
server/WinCC Client. You can start the Web View Publisher remotely by opening the WinCC 
project of the web server/WinCC Client on the remote computer. On the remote station, 
you publish the WinCC pictures from other WinCC Servers to the dedicated web server.

The Web View Publisher performs the following adjustments:

● Compression of the data for optimizing performance on the Internet.

● Removal of project-specific data that is not required for the operation.

● Conversion of picture windows into an ActiveX component.

● Conversion of scripts so that they can be run on the Client.

Publication of pictures with faulty scripts
If warnings or errors are generated during publishing, the process pictures affected are marked 
in the output field of the Web Publishing Wizard. The pictures with errors in the scripts are 
nonetheless published. However, errors can still occur in Runtime and are reported by the 
WebNavigator Client. 

The "PdlPad" tool can be started directly in the Web View Publisher in order to check and, if 
necessary, correct the scripts used in the published pictures.

Publishing Without Project Functions
Publishing without project functions can be an additional source of error. When publishing with 
the Web View Publisher, the selected project functions are always published. When published 
without project functions, the pictures no longer contain any project functions. The project 
functions of the last publishing process are always available in the published pictures and, 
therefore, on the client. 
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The selection of project functions in the Publisher is independent of the pictures published in 
the same process. If , for example, you modify selected project functions but not their 
interfaces, you need to publish all necessary project functions. In this case, you do not have 
to publish the picture.

Changing the process picture in Graphics Designer
Process pictures that you edit in runtime in Graphics Designer on the WebNavigator Server 
must be published once again. This is required for the process picture to be displayed on the 
WebNavigator Client.

When using a dedicated web server, open the WinCC project on that server from a remote 
station in order to transfer the changes to the WebNavigator Client. On completion, open and 
save the modified picture in Graphics Designer. Publish the picture in the next step using Web 
View Publisher on the dedicated web server. 

If you have modified a large number of pictures, you can simplify this process. For this purpose, 
call the "Convert pictures" function in the shortcut menu of Graphics Designer. On completion, 
you once again have to publish the pictures.

Requirements for publishing pictures

General requirements             
● The picture names may not contain double underscores, e.g. "__furnace_overview.pdl". 

The string before the double underscore will be interpreted as server prefix.

● The package names and/or symbolic computer names may not contain any double 
underscores.

● The package names and/or symbolic computer names may not end in an underscore.

● Moreover, the name cannot begin with a single underscore if you are using Basic Process 
Control. When using Picture Tree Manager, the name string of higher-level pictures will 
have a "@PTN_" prefix. With the leading underscore, the picture name will then have a 
double underscore.

● If two header files of the same name exist in the project path and in the installation path of 
WinCC, Web View Publisher will use the header file from the installation path.

Requirements for publishing on a dedicated web server
● The Web Navigator Server is installed on the WinCC Client.

● The C and VB scripts of all WinCC servers to which the WinCC Client has access have 
been copied to the WinCC Client.

● The WinCC server packages that the WinCC Client can access are loaded on the WinCC 
Client.

● If you wish to publish projects on other computers, these computers must be linked by 
means of network drive before you start Web View Publisher. This procedure enables the 
display of your projects in the selection dialog of the Publisher. You cannot enter the path 
directly.
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Requirements for remote publishing
● Access to the target and source folders is enabled for Web View Publisher.

WinCC configures these Windows enables by default. Verify that these enables are not 
restricted, for example, valid for specific users only.

● If you wish to publish projects on other computers, these computers must be linked by 
means of network drive before you start Web View Publisher. This procedure enables the 
display of your projects in the selection dialog of the Publisher. You cannot enter the path 
directly.

How to publish WinCC process pictures using Web View Publisher

Introduction                       
Use Web View Publisher to publish the process pictures that you created in Graphics Designer. 
The WinCC Web Publishing Wizard supports you during publishing. 
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Procedure
1. Select "Web Navigator" in the navigation window of WinCC Explorer.

Select the "Web View Publisher" command in the shortcut menu.
The WinCC Web Publishing Wizard is now launched.

2. Click "Next".
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3. Activate the "Server prefix" option if you want to publish the pictures on a dedicated web 
server.
Select the prefix of the WinCC Server that contains the WinCC project from the selection 
list. The list displays the prefixes of the servers whose packages are loaded on the WinCC 
Client.
Deleting a prefix from the selection changes the paths displayed in the fields below.

4. Under "Path to your WinCC project", select the WinCC project folder containing the pictures 
you want to publish.
The folder has the following format for publication on a dedicated web server:
"\\<servername>\<serverprefix>_ _<projectname>".
If you want to publish from a remote station, select the source project containing the pictures.
The source project is displayed by its enable name on the other WinCC Server.
The folder has the following format:
"\\<computer name>\<enable name>".

5. Select the target folder for the published pictures under "Publishing folder of the WinCC 
web".
Accept the proposed folder within the WinCC project folder.
Do not change the path specification unless you want to transfer pictures to a different 
project, for example. In this case, the prefix selection list will be expanded accordingly.
Verify the specified target project to which the published pictures are saved during remote 
publishing.   
The path definition will be updated when you select the source project.
Should the target project be located on another WinCC server, select the corresponding 
project.
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6. Select the "Display hidden objects" option to show hidden objects that are published 
automatically in the results list.

7. Click "Next". Move the pictures that you wish to publish to the "Selected files" list.
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8. Click "Next". Move the C project functions which you use in the published pictures to the 
"Selected files" list. You cannot publish individual VB scripts.

Click "Next". 
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9. Move the referenced graphics that you wish to publish to the "Selected files" list. The 
referenced files are in the "GraCS" folder or in subfolders of "GraCS".

Click "Next". 

10.Click "Exit" to start publishing the pictures.
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Result
You have successfully published the pictures and functions. The results list displays the status 
of all published objects. You can click an object to view additional object information. 

You can trace publishing using the "<projectfolder>\WebNavigator\WizardLog.txt" file.
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Checking the scripts using "PdlPad"
The "WizardLog.txt" log file contains information about errors in the scripts used. You can also 
find errors using the "PdlPad" debugger. 

1. Open "PdlPad" by double-clicking on the affected object in the results list of Web View 
Publisher. The script of the published picture is displayed.

2. Click  in order to check the script.

3. You can temporarily correct and save the scripts. These corrections are only saved to the 
published pictures, not in the process picture of the WinCC project.

"PdlPad" can also be opened in the Windows Start menu via "SIMATIC > WinCC > 
WebNavigator-Server".

Administering users for DataMonitor

Introduction     
For the use of certain functions on the DataMonitor client, users need authentication as 
DataMonitor user as well as authentication as WinCC user. Use one WinCC user for 
"WinCCViewerRT" and "Excel Workbook".
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If you are working as DataMonitor user and WinCC user at the DataMonitor client you have to 
log on twice. You have two alternatives to only log on once:

● The DataMonitor user and the WinCC user have identical names and passwords.
The user must be configured in Windows and in WinCC and added to the "SIMATIC HMI" 
and "SIMATIC HMI VIEWER" user groups.

● SIMATIC logon allows the central administration of users.
In order to use SIMATIC logon in connection with DataMonitor, DataMonitor users must 
also be added to the user group "SIMATIC HMI VIEWER".

Procedure
1. Select the entry "User Administrator" in the navigation window of WinCC Explorer. Select 

the "Open" command from the shortcut menu. The editor "User Administrator" is opened.

2. In the navigation window, select a user or create a new user.

3. Select a user group and then open the shortcut menu. Select the entry "New User". The 
name of the user can be changed directly with the <F2> function key or the shortcut menu 
command "Rename". The user must be selected beforehand for this purpose.
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4. Enter a name and a password with at least six characters for "Login".
Click "OK".

5. Select the newly created user in the table window. The properties of the user are displayed.

6. Activate the option "WebNavigator". Select a start picture from the dropdown list next to 
"Web start picture".

7. Check the selected language and change this setting if desired via the dropdown list next 
to "Web language". You can only select a new language from the dropdown list if one of 
the two options "WebNavigator" or "PureWebClient" is activated. The languages created 
in the Text Library are available for selection.

8. The user needs at least the authorization "Web Access - monitoring only".
In the row in the table window, activate the corresponding authorization in the "Enable" 
column.

9. Close the User Administrator.

Configuring runtime settings

Introduction       
Define the settings for behavior in runtime when you use the DataMonitor.
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Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web 

settings" command from the shortcut menu.

2. Change to the "Runtime" tab in the "WinCC web settings" dialog.
Select the required settings. Close the dialog with "OK".

Use "WinCC Classic" design
Activate the option to improve the performance of the DataMonitor client. The original style of 
WinCC V6 is now used.

"Monitoring only" cursor
A default cursor shows that the user of the DataMonitor client is not permitted to operate 
Runtime. The user has been assigned system authorization no. 1002 - "Web access - 
monitoring only" in the WinCC User Administrator.

If you want to use your own cursor, enter its path and file name. You can also use the "..." 
button to navigate to the file of the selected cursor.
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Server load
You do not need the settings in the area "Server load" for DataMonitor.

Activate WinCC system messages
The system messages "No. 1012400" or "No. 1012401" are output and archived at the login/
logoff of a DataMonitor client.

Enable event log messages
A successful session login or logoff is recorded in the Windows event viewer.

Disable local groups of SIMATIC Logon
The DataMonitor server can only be accessed by groups in the same domain.

Hardware accelerated graphics representation
The Direct2D representation is activated for the entire project on the WebNavigator clients.

2.4.2.3 Configuring the DataMonitor system

Defining users in Windows

User groups in Windows

Overview     
The following user groups are created automatically in Windows when the DataMonitor server 
is installed.

SIMATIC Report Administrators
Membership of the user group "SIMATIC Report Administrators" is required for extended rights, 
especially for configuration purposes. At least one user must be created and assigned to the 
"SIMATIC Report Administrators" user group.

● You can also do the following as "SIMATIC Report Administrators" in the "Webcenter":

– Configuring connections

– Creating templates for Webcenter pages

– Creating and configuring public and private Webcenter pages

● You can also do the following as "SIMATIC Report Administrators" in "Reports":

– Configuring reports based on WinCC print jobs or Excel workbooks.
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SIMATIC Report Users
Membership of the user group "SIMATIC Report Users" or of your own user group is required 
for the "Webcenter", "Trends & Alarms" and "Reports".

● You can also do the following as "SIMATIC Report Users" in the "Webcenter":

– Setting up and configuring Webcenter pages. The Webcenter pages are stored in 
different directories.

– Opening public pages

● You can also do the following as "SIMATIC Report Users" in "Reports":

– Opening reports based on WinCC print jobs or Excel workbooks.

Defining Users and Access Rights in Windows

Introduction       
When using DataMonitor, users need different authentications. All users must be members of 
the "SIMATIC HMI" user group. For access to the WinCC database via DataMonitor, you need 
a Windows user with password who is a member of the "SIMATIC HMI VIEWER" user group.

This means you must create users with the matching user rights.

Requirement
● WinCC is installed.

● The DataMonitor server is installed.

Procedure using Windows 7 as an example 
1. Open the "Control Panel" from the Windows Start menu.

2. Double-click "System and Security" and then "Administrative Tools".

3. Double-click "Computer Management" in the "Administrative Tools" dialog.

4. Navigate to the "System Tools > Local Users and Groups / Groups" directory. In the shortcut 
menu select the entry "New user".

5. Enter a name such as "DM_Demo" in the dialog "New user" in the "User name" box.
Enter a description such as "User for DataMonitor" in the "Complete name" box.
Type the desired password into the "Password" box and then repeat it in the "Repeat 
password" box.
Create the user with "Create".
Close the "New user" dialog.

6. In the right part of the table window, click on the newly created user. Select the "Properties" 
command in the shortcut menu.
Switch to the "Member Of" tab.
Click "Add".
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7. In the "Select Groups" dialog, click the "Advanced > Find now" button.

8. Select the entries "SIMATIC Report Administrators", "SIMATIC HMI"  and "SIMATIC HMI 
VIEWER" from the list at the bottom of the dialog.
Click "OK" twice to close the dialog.

9. In the properties of the user, the groups "SIMATIC Report Administrators", "SIMATIC HMI"  
and "SIMATIC HMI VIEWER" have been added to the list of memberships.
Click "OK".

10.Close the "Computer Management" dialog with "File > Exit".

11.Close the "Administrative Tools" window.

Result
The user "DM_Demo" with membership of the user groups "SIMATIC Report Administrators", 
"SIMATIC HMI"  and "SIMATIC HMI VIEWER" has been set up. The user can now create 
directories in the Webcenter and make connections to WinCC databases.

Note

If a user wants to access remote computers via the DataMonitor server, the Windows user 
must be set up on the DataMonitor server as well as the remote servers with the same 
password.

Configuring the DataMonitor web page

Introduction     
You create the DataMonitor web page with the WinCC Web Configurator.

Requirement
● The DataMonitor server is installed.

● The Windows "Internet Information Service" component is installed.
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Procedure
1. Select "Web Navigator" in the navigation window of WinCC Explorer. Click the "Web 

Configurator" command in the shortcut menu.
Alternatively, in the Windows Start menu select "Start > All Programs > Siemens 
Automation > SIMATIC> WinCC > Webnavigator Server > WebConfigurator".

2. The Web Configurator detects whether a configuration already exists.

– No configuration found: Activate "Create a new standard website (Standalone)". Click 
"Next".

– Configuration found: Click "Next" and check the configuration.
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3. Select "Name of the web page" and enter the name.

4. Enter the number of the port used for access in the "Port" box.

5. At "IP address", specify whether the computer is to be available on the intranet or Internet 
or on both networks.
Use only the addresses that are available in the selection list.
Select "All not assigned" to enable intranet and Internet access to the computer.

6. Select "DataMonitor.asp" as the default web page.

7. Specify the time interval after which the DataMonitor client starts to reestablish a connection 
automatically in case of a connection error. A time setting of "0 s" disables the "Automatic 
reconnection" function.

8. Specify whether the web page is started once the configuration is completed.

9. Click "Finish" if you have not activated a firewall.
Click "Next" if you have installed a firewall. See the following pages to find out how to set 
up a firewall.

Result
You have created the Web folder and activated the web page. When you have activated the 
firewall, use the Web Configurator to configure its settings. 

Configuring the firewall

Introduction  
The chapter describes how to activate "HTTP" and "HTTPS" services for port "80" in Windows 7 
or in Windows Server 2008 R2.
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Consult your network administrator if you want to set up the Windows Firewall with advanced 
security or for a different port.

Requirement
● You have created a default web page with Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".

Procedure for the default port
1. Click the "Windows Firewall" button in the " WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Windows 7: Click "Allow a program or feature through Windows Firewall".
Windows Server 2008 R2: Click "Allow a program to communicate through Windows 
Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.
The server configuration is completed.
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2.4.2.4 Working with the DataMonitor client

Configuring security settings in Internet Explorer

Introduction   
For full functionality on the DataMonitor client, adapt the security settings in the Internet 
Explorer. 

Requirement
● Internet Explorer is installed.

Procedure
1. Click "Tools > "Internet Options" in the Internet Explorer.

This will open the "Internet Options" dialog.

2. Select the "Security" tab.

3. Select the "Trusted Sites" icon and click the "Sites" button.
The "Trusted Sites" dialog opens.

4. Enter the address of the DataMonitor server in the "Add this website to the zone" field.
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".

5. Deactivate the "Require server verification (https:) for all sites in this zone" check box.
Click "Add".
Confirm the entry by clicking "OK".

6. Select the "Trusted Sites" icon.

7. Click "Default Level".
Click "Adapt Level" in the next dialog.
The "Security settings" dialog box is opened. 

– Activate the "Activate" option under "Initialize and script ActiveX controls not marked as 
safe".

– Confirm the entry by clicking "OK".

8. Close the "Internet Options" dialog by clicking "OK".

Result
The necessary settings in the Internet Explorer of the DataMonitor client are configured.
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User authentication: Activated setting "Automatic logon with current user name and password" in 
Internet Explorer

If the setting "Automatic logon with current user name and password" is activated in Internet 
Explorer in "Tools > Internet Options > "Security" tab > "Adapt Level" button > entry "User 
Authentication" > Logon", this can lead to unexpected behavior under the following 
requirements.

Requirement
● The "Automatic logon with current user name and password" The setting is activated in 

Internet Explorer.

● The user logs onto the DataMonitor client as a WinCC user who is not configured in the 
user groups on the DataMonitor server.

● The user is logged onto the computer with a Windows logon that is set up as a user name 
on the DataMonitor server.

Behavior
1. The DataMonitor server does not recognize the WinCC user name the user has used to 

log onto the DataMonitor client and therefore rejects it. The user cannot see this behavior.

2. Internet Explorer automatically starts a new logon using the current Windows logon as user 
name.

3. The DataMonitor server recognizes the Windows logon as DataMonitor user name and 
accepts the logon for this user.

4. The user is logged on but not with the DataMonitor user name the user has entered. The 
current DataMonitor user is not displayed.

Recommendation
Disable the "Automatic logon with current user name and password" setting. 

Use the setting only when there is a clear distinction between Windows logon and DataMonitor 
user name.

DataMonitor start page on the DataMonitor client

Overview         
You start the DataMonitor client on a standalone computer or on a DataMonitor server. The 
start page of the DataMonitor summarizes the functions of the DataMonitor: 

● "Reports":
Creation and output of analysis results and process data in print jobs and published Excel 
workbooks.

● "Webcenter":
Creation of Webcenter pages for the display of archived data.
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● "Trends & Alarms":
Display of alarms and process values from archives in tables and diagrams.

● "Administration"
Configuration of connections and management of users, archives and pictures.

Requirement
● The user is created in WinCC.

● The user must be a member of the Windows user group "SIMATIC Report Administrators" 
or "SIMATIC Report Users" .

● The WinCC project on the DataMonitor server is in runtime.

Procedure
1. Start the Internet Explorer on the DataMonitor client.

2. Enter the name of the DataMonitor server in the format "http://<servername>" in the URL.
Confirm the entry with "Enter".
The log-in dialog is opened.

3. Enter the name of a Windows user and the associated password. Confirm with "OK".

Result
The start page with the DataMonitor functions will be displayed. The use of the functions 
depends on the access right of the user. 
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General Operations of the DataMonitor Client
● Select the desired interface language from the selection field in the header.

● Hide the header on the pages of "Webcenter" and "Trend & Alarms", if necessary.
Click . 
To show the header line again, click on the symbol .

● In order to log off from the DataMonitor server, click on the "Log off" link.
Exit Internet Explorer to free-up the used license immediately.

See also
Working with trends and alarms (Page 305)

Working with reports (Page 338)

Working with the Webcenter (Page 276)

2.4.3 Working with WinCCViewerRT

2.4.3.1 Configuring WinCCViewerRT

Introduction      
WinCCViewerRT is a program for visualizing WinCC projects. You can configure 
WinCCViewerRT for operation with the DataMonitor server and Graphics Runtime.

Requirement
● On the server

– The DataMonitor server is installed.

– A WinCC/DataMonitor license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

– The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring 
only".

● On the client

– The DataMonitor client is installed.
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Procedure
1. Select the "Start > Programs > Siemens Automation > Option and Tools > HMI Tools > 

WinCCViewerRT" command in the Windows Start menu.
The configuration dialog opens if you reconfigure WinCCViewerRT. 
WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> 
key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:

– Server address: "http://<Servername>" or "http://<IP-Adresse>"

– User name and password, if you want to specify a default user for the login dialog.

– The user settings you configured in the User Administrator will be activated if you enable 
the "Apply project settings" option.

3. Specify the Runtime language in the "Parameters" tab.
If necessary, disable any key combinations with which the user switches to other programs. 
If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open 
the WinCCViewerRT configuration dialog.
Define a key combination with which a user can log off and a new user can log on. The key 
combination can only be used if no default user has been set in the "General" tab.
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4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
- Start picture
- Configuration file for user-defined menus and toolbars
- Window attributes
- Impermissible user actions
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5. Specify additional user actions in the "Runtime" tab:
‑ Activating the screen keyboard
‑ <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating 
system via the screen keyboard.
- Auto-logoff settings

6. Close the dialog with the "OK" button.

Result
WinCCViewerRT is configured. The connection to the DataMonitor server is set up after you 
close the dialog. The settings are saved to the "WinCCViewerRT.xml" configuration file. The 
configuration file settings are used at the next start of WinCCViewerRT. WinCCViewerRT 
applies the user interface language from WinCC.

The configuration file is available in the folder "Documents and Settings\User\Application Data
\Siemens\SIMATIC.WinCC\WebNavigator\Client". You can rename the file, for example, to 
"User1.xml". You can also start WinCCViewerRT by means of the command line with the user-
specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for 
different configurations, depending on the logged-on user. 

The WinCCViewerRT configuration dialog opens at the start if you rename or delete 
"WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

Note

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut 
or hide the "Close" button. Function in the C-Script: DeactivateRTProject; function in the 
VBScript: HMIRuntime.Stop.
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2.4.3.2 Displaying pictures

Requirement    
● A WinCC/DataMonitor license is installed on the DataMonitor server.

● The WinCC project on the DataMonitor server is in runtime.

● The WinCC pictures are configured and published for web access.

● The WinCC user must be assigned authorization no. 1002 - "Web Access - monitoring only".

● WinCCViewerRT is configured on the DataMonitor client.

Procedure
1. Start WinCCViewerRT in the Windows Start menu with "Start > Programs > Siemens 

Automation > Options and Tools > HMI Tools".

2. Log on to the DataMonitor server:

– A login dialog is not displayed if the user name and password are set in the 
WinCCViewerRT configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
WinCCViewerRT configuration dialog. Enter the user name and password of the WinCC 
user. Click "OK".

3. To change the user, use the specified key combination for login/logoff of "WinCCViewerRT". 
The previous user is logged off. Enter the user name and password of the new WinCC user 
in the login dialog. Click "OK". 
The key combination can only be used if no default user has been set.

Result
WinCCViewerRT automatically connects to the activated WinCC project. The pictures of 
WinCC project are displayed. 

The "View Only Cursor" indicates that process-related operations are not possible. 

Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, 
are still possible. 

You can also use your own cursor icon as a "View Only Cursor", if required. For more 
information, refer to "Configuring Runtime settings (Page 260)".

The <F5> key triggers a reselection of WinCCViewerRT.
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2.4.4 Working with the Webcenter

2.4.4.1 Administration

User Groups and Directories

User Groups and Directories

Overview      
WebCenter pages and reports are stored in directories on the DataMonitor server. 

Its standard complement of directories is as follows:

● "Public"

● "Private" Every user has a "Private" directory. Only the respective user has access rights 
to this directory.

A user of the user group "SIMATIC Report Administrators" can create other directories and 
assign the other user groups different access rights to these directories. 

More information on setting up directories can be found in chapter "Setting up directories 
(Page 278)".

Windows User Groups
The user groups "SIMATIC Report Administrators" and "SIMATIC Report Users" are created 
when the DataMonitor server is installed. You can create more user groups. More information 
on setting up user groups and users can be found in chapter "Defining users and access rights 
in Windows (Page 263)".

To access the DataMonitor, assign all members of a user group the same access rights to the 
directories of the DataMonitor server.

The following access authorization is possible:

● Read

● Change

● Create

A user, as a member of a user group, only has access to a directory if the respective user 
group has access rights to that directory. This permits user group-specific access. More 
information on assigning access authorization can be found in chapter "Assigning access 
rights (Page 278)".

The following picture shows the basic user administration for the WebCenter.
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Creating Directories

Introduction  
You store Webcenter pages in directories. The default directories are "Public" and "Private". 

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Administration" on the start page.

2. Click the "Directory administration" tab.

3. Enter a name, such as "mypart", in the "New directory" field.

4. Click the "Create" button.

Result
The directory "mypart" is created. The directories are created in a layer.

Assigning Access Rights

Introduction   
Directories are created within the Webcenter in which you store, for example, Webcenter 
pages. You can assign different access rights for the individual directories to Windows user 
groups.
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The following access authorization is possible:

● Read

● Change

● Create

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".
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Procedure
1. Click "Webcenter > Administration" on the start page.

2. Click on the "User administration" tab.

3. Select the desired directory from the "Current directory".
All existing Windows user groups are listed.

4. Activate the access rights in the line of the required Windows user group.

5. Click "Save".

Result
The access rights for the required directory are configured.
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See also
User Groups and Directories (Page 276)

Example: User Groups and Directories

Overview   
The user groups "Service" and "Planning" have been created in the following example. The 
directories "ServiceGroup", "Water" and "ProcessPlans" are created in the Webcenter.

The following table shows which access rights the members of the user groups "Service" and 
"Planning" have for the following directories:

Directory User group "Service" User group"Planning"
Public ● Read ● Read
Private ● Read

● Change
● Create

● Read
● Change
● Create

ServiceGroup ● Read
● Change
● Create

● Read

Water ● Read
● Change

No access authorization

ProcessPlans No access authorization ● Read
● Change

When a member of the user group "Service" logs in and clicks "Pages" in the Webcenter, the 
member will see the directories as tabs to which the user group has at least read access. The 
"Webcenter > Pages" looks as follows for the member "Service_014" of the user group 
"Service":

The "Webcenter > Pages" looks as follows for the member "Plan_012" of the user group 
"Planning":
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Create connection and set up language

Introduction     
For access of the DataMonitor client to runtime data and archived data, configure connections 
to the WinCC databases in the "Webcenter". For each data source, set up a connection, e.g., 
to the WinCC server. You need the configured connections for Webcenter pages and "Trends 
& Alarms". 

Requirement
● The user is a member of the Windows user group "SIMATIC Report Administrators".

● For access to the WinCC database via DataMonitor, a Windows user with password is 
created who is a member of the "SIMATIC HMI VIEWER" user group.
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Procedure
1. Click "Webcenter >Administration" on the start page.

2. Click the "Connection Administration" tab.

3. Select the option "New Connection". After the new installation, no selection is possible in 
the "Connection" box, as no connections have been configured yet.

4. Select the language that corresponds with the linguistic region of the server or archive to 
be linked in "Linguistic Region". The setting ensures that special national characters are 
displayed correctly. 

5. Enter a name in the "Connection Name" box, such as "WinCC1_Runtime". The name 
should include a reference to the selected connection type. Do not use any blank spaces 
or special characters.

6. Enter the computer name on which the archive backup data are stored.
As an alternative, select the name of the computer using the "Find" button.

7. Enter the Windows user with password for the connection with the WinCC database.
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8. Select the connection type to the WinCC data:

– "Swapped-out WinCC archive". Additional steps are necessary to access data on 
swapped archives. More information is available under "Connecting or separating 
swapped archives (Page 284)".

– "WinCC Runtime". Only the open single segment of the Runtime database is used.

– "CAS". The WinCC data of the central archive server are used.

– "WinCC Runtime + all segments". The open single segment and all other connected 
segments of the Runtime database are used.

9. Select the database for the connection type:

– "Swapped-out WinCC archive": Click "Display database" or select the archive from the 
list.

– "WinCC Runtime" and "CAS": Select the Runtime database of the activated WinCC 
project. As an alternative, select the name of the database using the "Find" button.

– "WinCC Runtime + all segments": "CC_ExternalBrowsing" is automatically entered as 
database.

10.Activate "Automatic adaptation of RT database" so that the database name is adjusted in 
the connection administration during a segment change.

11.Click the "Create" button.

Result
The connection to the data source is created and can be selected in the "Connection" box of 
the connection administration. 

See also
Configuring a symbolic directory (Page 284)

Connect archives using the WinCC Archive Connector (Page 288)

Connecting or disconnecting swapped archives

Configuring a symbolic directory

Introduction                 
To access data on swapped-out WinCC archives, these archives must be connected to an 
SQL server once again. 

You can connect all or individual archive backup files of a directory with the SQL server.
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If you want to remove a directory containing archives from the list of symbolic names, 
disconnect all archives contained therein. You see the status of the archives in the tab 
"Connecting/disconnecting archives".

Note
Connected archives on changeable media

Before changing the media in the drive you need to disconnect the archives on this medium. 
After changing the medium, check whether the archives are connected on the new medium.

Requirement
● Archive backup files are write-protected. Create a backup copy of the file before connecting 

and remove the write-protection of the copied archive backup file.

● The archive backup files are stored on a local drive.

● The directories in which the archive backup files are stored have been released.

– The directory must be set for sharing in the Windows Explorer before you start the 
DataMonitor server.

– Restart the DataMonitor server if you are releasing the directories at a later time.

● The user group "SIMATIC HMI VIEWER" has "Full access" to the directories.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators".

● Windows Server 2008 R2: "Network service" is added in the "Print operators" group.

● Windows 7: "Network service" is added in the "Main user" group.

Procedure 
1. Click "Webcenter > Administration" on the start page.

2. Click on the "Archive administration" tab.

3. In the "Symbolic Name" box, enter a unique symbolic name for each directory. The name 
should only contain characters permitted in the SQL syntax. You use the symbolic name 
for access via the DataMonitor client.
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4. Select the folder which contains the archive backup files. You can only select released 
directories.

5. To automatically connect all existing archive backup files of the directory, activate 
"Automatically connect all archives in this directory".

6. To connect individual archive backup files of the directory, deactivate "Automatically 
connect all archives in this directory".

7. Click "Add".

Result
The symbolic directory "Test" is created. 

If you have deactivated "Automatically connect all archives in this directory", specify the archive 
backup files in the "Connecting/disconnecting archives" tab. To disconnect archives, 
deactivate the respective archives in the "Connecting/disconnecting archives" tab. 

Connecting or disconnecting archives

Introduction
All archives of a selected archiving directory are displayed on the "Connecting/disconnecting 
archives" tab. You can connect or disconnect the existing archives.

Requirement
● Archive backup files are write-protected. Create a backup copy of the file before connecting 

and remove the write-protection of the copied archive backup file.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators".

● A symbolic directory is created, such as "Test".
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Procedure
1. Click "Webcenter > Administration" on the start page.

2. Click on the "Connecting/disconnecting archives" tab.

3. Select a directory from "Symbolic directories", such as "Test". The available archives are 
displayed in a list. The "Info" column indicates the status:

– Green: Connected

– Red: Disconnected

4. To limit the display, click "Filter".

5. Enter a filter criterion in a column and click . Click  with "From" and "To" to enter a 
required period of time. Then click .

6. To connect an individual archive, activate the desired archive in the "List of available 
archives". Click "Save".

7. To disconnect an individual archive, deactivate the desired archive in the "List of available 
archives". Click "Save".

8. You sort the list entries by clicking on one of the column headers.

Alternative Procedure
To connect archive backup files, you can also use the WinCC Archive Connector. For additional 
information, refer to "Connecting archives using the WinCC Archive Connector (Page 288)".
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Result
The required swapped-out WinCC archives are connected. If you connect signed archives, 
which have been changed after the swap, a message is output.

Connect archives using the WinCC Archive Connector

Introduction           
You use the Archive Connector to reconnect swapped-out WinCC archives with an SQL Server.

The Archive Connector has the following functions:

● Manual Connection: Local databases are selected and connected to the local SQL Server.

● Manual disconnection: Connected databases are disconnected from the SQL Server.

● Automatic Connection: Local directories can be selected in which WinCC archives have 
been exported. After activation of monitoring, all archives added to the directory are 
automatically connected with the SQL Server.

Note
Connected archives on changeable media

Before changing the media in the drive you need to disconnect the archives on this medium 
using the Archive Connector. After changing the medium, check in Archive Connector 
whether the archives are connected on the new medium.

Requirement
● The Archive Connector may only be operated using a local SQL Server and a WinCC/

DataMonitor license.

● Archive backup files are write-protected. Create a backup copy of the file before connecting 
and remove the write-protection of the copied archive backup file.

● The archive backup files are stored on a local drive.

● The directories in which the archive backup files are stored have been released.

● The user group "SIMATIC HMI VIEWER" has "Full access" to the directories.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators".
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Procedure
1. From the Windows Start menu choose "Start > SIMATIC > WinCC > WebNavigator Server 

> ArchiveConnector".

2. Click "Add" in the "Configuration" tab. The "New directory" dialog opens.

3. Navigate to the directory in which the archive backup files are stored.

4. Enter a unique symbolic name for the directory. The name should only contain characters 
permitted in the SQL syntax. You use the symbolic name for access via the DataMonitor 
client.

5. Click "OK". The directory is displayed on the "Configuration" tab.

6. If you activate the checkbox for a directory in the "Monitored" column, then all archives that 
are added to the directory from the time of activation are automatically connected to the 
SQL server.

7. Remove a selected directory again, if necessary. The archives in the directory must already 
be disconnected. The status of the archives of a directory can be verified on the "Connect/
disconnect archives" tab in the "Connected" column.
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8. Click on the "Connecting/disconnecting archives" tab. All archives of a selected directory 
are displayed on the "Connecting/disconnecting archives" tab.

9. Select a directory with archives either from the list of directories or by its symbolic name.

10.Select the required archive and click "Connect".

11.Disconnect the connection of a selected archive, if necessary.

Result
A connection is created and the required archive backup files are connected with the SQL 
Server.

The "Connecting/disconnecting archives" tab displays the connection status of each archive. 
"From" and "To" columns contain the archiving period in the local time zone.

The "Type" column contains the details for archive type:

● A - Alarm archive

● TF - Tag Logging Fast

● TS - Tag Logging Slow

If you connect signed archives, which have been changed after the swap, a message is output.
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2.4.4.2 Creating static process pictures for the Webcenter

Introduction         
In the picture administration you specify which pictures you need for the web part "Static 
process pictures". The process pictures cannot be operated.

The DataMonitor server creates copies of pictures in a cycle that can be set. The server makes 
the pictures available as static process pictures on the DataMonitor client. 

The following objects are not displayed in the web part "Static process pictures":

● Global Script Diagnostics Window

● WinCC Media Control

● WinCC Controls from migrated projects that have been created with versions prior to WinCC 
V7.0.

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The WinCC pictures are published for web access. Additional information is available under 
"Publishing WinCC process pictures (Page 248)".

● The start page of the DataMonitor is open.

● The "Picture administration" tab is open. All published process pictures are listed.
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Procedure
1. Select the desired pictures.

– To select all pictures, activate the checkbox in the column header.

– To select individual pictures, activate the checkbox in front of the required picture.

2. To show only a part of the picture, specify the following:

– X position: Start positions in x direction in pixels

– Y position: Start positions in y direction in pixels

– Height: Height of the picture in pixels

– Width: Width of the picture in pixels

3. If you have configured and published pictures in different languages, select a language 
from the list to display the language-specific picture.  

4. To output the time when the process picture was created by the DataMonitor server, 
activate "Stamp". The date and time are displayed in the picture.

5. In order to change the update cycle, enter the desired value in "Update time interval". Select 
this cycle as large as possible. A cycle that is too small results in limited performance.

6. Click "Save".

Result
The DataMonitor server creates static process pictures from the selected pictures. You can 
configure the static process pictures in the web part "Static process pictures".
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Deleting static process pictures
To delete static process pictures, select the checkbox "Delete graphic" for the selected picture 
name. Click "Save" to delete the static process picture or the copy. You can no longer configure 
the deleted process picture in the web part "Static process pictures".

Finding picture names or limiting display
Use a filter to find a picture name or limit the display to certain picture names.

When you click  with "Filter", the filter is shown above the table. Enter a picture name in the 
text field or click <Enter>. 

To hide the filter, click .

2.4.4.3 Creating layout template for Webcenter pages

Introduction     
You need a layout template to create a Webcenter page. Predefined layouts were installed 
during the installation. Additionally, you can create your own Layout Templates.

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Creating layout" tab.

3. Define the number of columns and the number of lines.

4. Enter the name in the "Name of the layout file" box, for example, "mylayout_23". Click "Next".
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5. Combine the table fields, if necessary. To do so, click the desired arrow symbol, such as 
"Arrow up", in the desired field, for example line 3 / column 1. The modified view will be 
displayed.
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6. To restore the original table layout, click "Reset configuration". Click "Next".

7. Arrange the web parts in the table fields. If necessary, activate the corresponding symbol 
in a table field to place the web parts vertically or horizontally.

8. Click "Save".

Result
The layout template "mylayout_23" is created. You can use the layout template as a template 
for creating a Webcenter page. 

2.4.4.4 Creating Webcenter page

Introduction  
You create Webcenter pages in which you add web parts. The Webcenter pages are stored 
in directories. In this example, the WebCenter page is saved in the "myPart" directory.

You can only change or create Webcenter pages in directories for which the Windows user 
group has the "Edit" or "Create" access rights. 
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Requirement
● The directory "myPart" is set up.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Creating page" tab.

3. Click on the desired layout template. The file name is displayed in the "Layout file" box.

4. Enter a name in the "Webcenter page" box, for example, "My_Webcenter".
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5. Select the directory in which the Webcenter page is stored. The selected directory is 
displayed in the box "Save WebCenter page as".

6. Click "Save".

Result
The Webcenter page "My_Webcenter" is created and saved.

See also
Inserting web parts to the Webcenter page (Page 298)

Configuring web parts within Webcenter pages  (Page 301)
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2.4.4.5 Inserting web parts to the Webcenter page

Introduction    
You compile the contents of the Webcenter pages from the web parts. 

Requirement
● The directory "myPart" is set up.

● The Webcenter page "My_Webcenter" is stored in the directory.

● The logged in user is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The start page of the DataMonitor is open.

Procedure
1. Click "Webcenter > Pages" on the start page.

2. Click on the "myPart" tab.

3. Click on the entry "My_Webcenter".
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4. To add web parts, click  at the top right edge of the page. The available web parts are 
listed.
If you have exported web parts that have already been configured, they are listed under 
"Imported web parts". If necessary, insert these web parts into your Webcenter page.

5. Activate the entry "Trend (Timestep)".

6. Select the entry "WPZ_01_01" and click "Add".

7. Activate the entry "Hit list of alarms".
If you insert several web parts into a table field, the web parts are arranged horizontally or 
vertically. You specify the arrangement when you create the layout template.

8. Select the entry "WPZ_02_01" and click "Add".

9. Click "Exit".
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Result
Web parts to display data are inserted into the Webcenter page "My_Webcenter". The current 
compilation of the Webcenter page is displayed.

See also
Overview of Web Parts (Page 243)

Creating Webcenter page (Page 295)

Configuring web parts within Webcenter pages  (Page 301)
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2.4.4.6 Configuring web parts within Webcenter pages 

Introduction    
To display data from WinCC Runtime or an archive, you must configure the web parts.

Web part configuration     

Open the configuration dialog of the web part
Deleting the web part
Minimizing the web part
Maximizing the web part
Exporting the web part
Exporting the configuration of the web part as XML file

Requirement
● The logged in user is a member of the Windows user group "SIMATIC Report 

Administrators" or "SIMATIC Report Users".

● The Windows user groups have the access rights "Edit" or "Create" for the directory.

● The Webcenter page "My_Webcenter" is open.

● The WinCC project is in Runtime.
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Procedure
1. Click  in the required web part. The configuration dialog is opened.

2. Configure the web part:

– Displaying process values in a table (Page 305)

– Displaying process values in a diagram (Page 306)

– Displaying alarm hit list (Page 312)

– Displaying alarms in the alarm table (Page 308)

– Displaying statistics function for process values (Page 314)

3. To change the position of the web part, move the web part to the desired position with the 
mouse.
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See also
Creating Webcenter page (Page 295)

Inserting web parts to the Webcenter page (Page 298)

2.4.4.7 Deleting Webcenter pages and layout templates

Introduction    
You can delete layout templates and Webcenter pages that are no longer required.

Requirements - Deleting Layout Templates
● The user is a member of the Windows user group "SIMATIC Report Administrators".

● The start page of the DataMonitor is open.

Requirements - Deleting Webcenter pages 
● The logged in user must have "Create" access rights for the directory, in which the page to 

be deleted is stored.

● The start page of the DataMonitor is open.
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Deleting layout templates
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Deleting layout" tab.

3. Delete the required layout files:

– To delete several layout files, activate the checkbox "Selection" for the files you want to 
delete. Click "Delete".

– To delete all layout files, click "Select All". Click "Delete".

– To delete individual layout files, click the respective "Delete" button in the "Action" 
column.

Result
The selected layout file is deleted. You can also delete the supplied layout files. Existing 
Webcenter pages that are using this layout template are not deleted. You cannot create new 
Webcenter pages with this layout.

Deleting Webcenter pages
1. Click "Webcenter > Configuration" on the start page.

2. Click on the "Deleting page" tab.

3. Activate the respective check box to mark the pages to be deleted.

4. Click on the "Delete" button.
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Result
The selected Webcenter pages are deleted. 

2.4.5 Working with trends and alarms

2.4.5.1 Displaying process values in a table

Introduction         
Use "Trends & Alarms" to display archived process values in a table.

Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click the "Process Value Table" tab.
The Web part "Process Value Table" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.
The archive tags available via this connection will be displayed. 
Limit the display of the tags, if necessary:

– Select individual archives with "Archive selection".

– Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tag.

7. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click . 
Click "Preview" to check the set time range in the column "Preview Time Range". 

8. Specify the number of decimal points in the area "Representation of decimal points".

9. In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

10.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the web part to one or several Webcenter pages.

11.Click "OK" to confirm your entries.
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Result
The values of the archive tags and the quality code are output in the process value table. 

If the manual entry of archive values is allowed during runtime, the modified or newly created 
values are identified as such. There is an "m" in a separate column to show a manual entry of 
the archive value.

Operation:

In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.

Export alarms in CSV format.
Changing the settings of the Web part.

2.4.5.2 Displaying process values in a diagram

Introduction     
Use "Trends & Alarms" to display archived process values in trends. 
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Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click the "Trend (Process Values)" tab. The Web part "Trend (process values)" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field. The archive tags 
available via this connection will be displayed.
Limit the display of the tags, if necessary:

– Select individual archives with "Archive selection".

– Set the filter criteria with "Tag filter".

6. Click "Add" for the required archive tags, e.g. "TREND_0", "TREND_1", "TREND_2.
The archive tags are listed in the area "Current selection".

7. In the section "Current selection", you specify for the individual archive tag:

– Color of time axis and value axis

– Trend presentation type

8. In the section "Value axis editor", you can activate the automatic scaling for the different 
value axes or you can assign a minimum and maximum value to each axis.

9. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click . 
Click "Preview" to check the set time range in the column "Preview Time Range".

10.In the section "Diagram settings", you define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

11.Activate the option "Show legend" to display the legend.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the Web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.
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Result
The selected process values are displayed as trends in a diagram.

The legend shows the assignment of the colors to the archive tags. 

Operation:

In absolute time required to scroll forward or backward in the selected time range.
Enlarge the presentation and diagram range left or right of the center line. 
Restore the original view.
Exporting values of the displayed diagrams in CSV format
Changing the settings of the Web part.

2.4.5.3 Displaying messages in the alarm table

Introduction     
Use "Trends & Alarms" to display alarms in an alarm table. 
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Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click on the "Alarm Table" tab.
The web part "Alarm Table" is displayed.

3. Click . The configuration dialog of the Web part opens.

4. Change the title in the "Title" field. Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.

6. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. 
For more information on entering time, click .
Click "Preview" to check the set time range in the column "Preview Time Range".

7. In the section "Language of the alarm texts", select the language, in which the alarms are 
displayed.

8. Select the respective WinCC server with "Selection of WinCC server", if necessary. The 
setting is necessary if you select a connection to swapped archives that include archives 
of several WinCC servers.

9. In the section "Filter selection", you may limit the expected search results with SQL syntax.
Set the filter conditions for individual columns to do so. 
Enter the filter condition for all columns in the "Extended Filter" field. 
For more information on filter conditions, click .

10.For representation of the data set the following:

– Sort order: For more information on sorting, click .

– Visible columns: To display all columns, click "Select All".

– Number of decimal places.

11.In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the Web part.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages".
Click  to assign the Web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.
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Result
The messages are output in a table.

Operation:

In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.

Export alarms in CSV format.
Changing the settings of the Web part.

See also
Alarm Log Column Names (Page 311)

WinCC/DataMonitor
2.4 WinCC/DataMonitor Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
310 System Manual, 02/2016, A5E37537386-AA



2.4.5.4 Alarm Log Column Names

Introduction   
You can select the alarm log columns while displaying alarms in "Trends & Alarms".

Overview of column names

Position Name Type Comments
1 MsgNo Integer 4 Bytes Message number
2 State Small Integer 2 Bytes Alarm Log Status
3 DateTime DateTime 8 Bytes Time stamp of message (Date/time without millisec‐

onds) 
4 Ms Small Integer 2 Bytes Time stamp of message (milliseconds)
5 Instance VarChar (255) Instance Name of the Alarm Log 
6 Flags1 Integer 4 Bytes (only for internal use)
7 PValueUsed Integer 4 Bytes Process Values used 
8 to 17 PValue1 to PValue10 Real 8 Bytes Numerical Process Value 1 to 10
18 to 27 PText1 to PText10 VarChar (255) Process Value Text 1 to 10
28 ComputerName VarChar (255) Computer Name
29 Application VarChar (255) Application Name
30 Comment VarChar (255) Comments
31 UserName VarChar (255) User Name
32 Counter Integer 4 Bytes Running Alarm Message Counter
33 TimeDiff Integer 4 Bytes Time difference to "Came in" status 
34 ClassName VarChar (255) Name of the alarm class
35 Type name VarChar (255) Name of the alarm type
36 Class Small Integer 2 Bytes Message class ID
37 Type Small Integer 2 Bytes Message type ID
38 to 47 Text1 to Text10 VarChar (255) Message Text 1 to 10
48 AG_NR Small Integer 2 Bytes Number of the PLC
49 CPU_NR Small Integer 2 Bytes Number of the CPU
50 CrComeFore Integer 4 Bytes Foreground Color for the "Came in" Status
51 CrComeBack Integer 4 Bytes Background Color for the "Came in" Status
52 CrGoFore Integer 4 Bytes Foreground Color for the "Went out" Status
53 CrGoBack Integer 4 Bytes Background Color for the "Went out" Status
54 CrAckFore Integer 4 Bytes Foreground Color for the "Acknowledged" Status
55 CrAckBack Integer 4 Bytes Background Color for the "Acknowledged" Status
56 LocaIID Integer 4 Bytes Location of the Alarm
57 Priority Integer 4 Bytes Priority
58 AP_type Integer 4 Bytes Loop-in alarm
59 AP_name VarChar (255) Loop-in-Alarm Function Name
60 AP_PAR VarChar (255) Loop-in-Alarm Screen
61 InfoText VarChar (255) Info text
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Position Name Type Comments
62 TxtCame VarChar (255) Text came in
63 TxtWent VarChar (255) Text went out
64 TxtCameNWent VarChar (255) Text came in and went out
65 TxtAck VarChar (255) Text acknowledged
66 AlarmTag Integer 4 Bytes Message tag
67 AckType Small Integer 2 Bytes Acknowledgment Type
68 Params Integer 4 Bytes Parameter

2.4.5.5 Displaying the hit list of messages

Introduction     
Use "Trends & Alarms" to display the hit list of alarms in a table.

Note

The display of alarms in the hit list may take some time and may place a strong load on the 
CPU. A message is displayed in "Trends & Alarms" if the data volume is too high. 

Confirm this message to continue without changes. If you want to reduce the data volume, 
stop the process and change the filter criteria. 

Requirement
● Connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Select the "Hit list of the alarms" tab. The web part "Hit list of the alarms" is displayed.

3. Click . The configuration dialog of the web part opens.

4. Change the title in the "Title" field. Enter a short message in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field.

6. Set the time range in the area "Time period". With relative times, enter a negative value 
into the respective field. For more information on entering time, click .
Click "Preview" to check the set time range in the column "Preview Time Range".

7. In the section "Language of the alarm texts", select the language, in which the alarms are 
displayed.
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8. Select the respective WinCC server with "Selection of WinCC server". The setting is 
necessary if you select a connection to swapped archives that include archives of several 
WinCC servers.

9. In the section "Filter selection", you may limit the expected search results with SQL syntax.
Set the filter conditions for individual columns to do so. Enter the filter condition for all 
columns in the "Extended Filter" field. For more information on filter conditions, click .

10.For representation of the data set the following:

– Sort order: For more information on sorting, click .

– Visible columns: To display all columns, click "Select All".

– Number of decimal places.

11.In the "Table size" area, define the size of the display window.
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the web part.

12.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the web part to one or several Webcenter pages.

13.Click "OK" to confirm your entries.

Result
The analysis values for the alarms are displayed in a hit list.

The table includes configured data and statistical values, such as the frequency of the alarm.

If you move the mouse above the column header, an explanation is displayed in a tooltip. 

Operation:

In absolute time required to scroll forward or backward in the selected time range.
Arrow buttons To scroll forward or backward in multi-page tables.
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Export alarms in CSV format.
Changing the settings of the web part.

2.4.5.6 Displaying statistics function for process values

Introduction    
Use "Trends & Alarms" to display the statistics functions for process values in a table. 

Requirement
● The connection to the WinCC data is established.

● The start page of the DataMonitor is open.

Procedure
1. Click "Trends & Alarms" on the start page.

2. Click on the "Statistics functions for process values" tab. The web part "Statistics functions 
for process values" is displayed.

3. Click . The configuration dialog of the web part opens.

4. Change the title in the "Title" field. 
Enter a note in the "Tooltip" field.

5. Select one of the configured connections in the "Connection" field. The archive tags 
available via this connection will be displayed. 
You can limit the number of tags displayed using the "Archive selection" and "Tag filter" 
fields.

6. Click "Add" for the required archive tag.

7. Set the time range in the area "Time period".
With relative times, enter a negative value into the respective field. For more information 
on entering time, click .
Click "Preview" to check the set time range in the column "Preview Time Range".

8. For representation of the data set the following:

– Number of decimal places

– Aggregate selection: Define the analysis function for the process values.

9. In the "Table size" area, define the size of the display window. 
If the value "0" is entered in both fields, the size is determined automatically. The size 
depends on the space requirement of the web part.

10.The available Webcenter pages are displayed in the area "Link to Webcenter pages". Click 
 to assign the web part to one or several Webcenter pages.

11.Click "OK" to confirm your entries.
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Result
Statistics functions for the selected process values were executed and output in the table.

If you move the mouse above the column header, the archive name and the tag name are 
displayed in a tooltip.

You can export the displayed table in CSV format using the  icon. 

To change the settings, click .

2.4.6 Working with Excel Workbook

2.4.6.1 Configuring the Excel workbook

Applying data from WinCC project

Introduction     
You need the WinCC configuration data for the configuration of Excel workbooks. This means 
you apply the data from a local WinCC project during configuration in the "Excel Workbook 
Wizard" . 
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Requirement
● Server computer

– Office 2007, Office 2010, or Office 2013 is installed.

– The Excel add-in "Excel Workbook" is installed.

– The DataMonitor server is installed.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● Configuration PC

– Office 2007, Office 2010, or Office 2013 is installed.

– The Excel add-in "Excel Workbook Wizard" is installed.

● MS Office

– Only Excel files with extensions "XLS, "XLSX, "XLSB", and "XLSM" may be used.

Procedure
1. Open an empty Excel workbook.

Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Establish connection with WinCC server". The "WinCC Server" box is 
shown.

3. Enter the desired name of the server and click "Connect". The log in dialog is displayed.

4. Enter the name and password of a WinCC user.

5. Click "Next". The "Add / delete tags" dialog opens.
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Result
The Excel workbook is set up to configure the display of process data. Then publish the 
workbook. The workbook is made available on the DataMonitor client as report tool or as 
template for "Reports".

Note
Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office Language 
Settings", and the Windows Regional Options.

Example:
● If you are using Office 2007 with the language "English (U.K.)", for instance, select the 

regional setting "English (U.K.)".
● If you have set "Chinese (PRC)" as a region and language option in Windows, you must 

also select "Chinese (PRC)" as the primary processing language in the "Microsoft Office 
Language Settings 2007".

More information can be obtained through Microsoft Support: http://support.microsoft.com/kb/
320369/en (http://support.microsoft.com/kb/320369/en)

See also
Configuring the display of tag values (Page 204)

Configuring the display of archive tags (Page 208)

Configuring the display of alarms (Page 212)

Applying data from a configuration file

Introduction     
You can create reports without connection to the WinCC server.

Configuration steps:
● Create a configuration file on the server.

● Configure data access with the configuration file.

● You can also configure the data access of a dedicated Web server / WinCC client.
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Requirement
● Server computer

– The DataMonitor server is installed.

– The online tags of the WinCC project are part of one tag group or one structure type.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● Configuration PC

– Office 2007, Office 2010, or Office 2013 is installed.

– The Excel add-in "Excel Workbook Wizard" is installed.

● MS Office

– Only Excel files with extensions "XLS, "XLSX, "XLSB", and "XLSM" may be used.

Creating a configuration file on the server 
1. Select the entry "WebNavigator" in the navigation window of WinCC Explorer.

Open the menu command "Export Configuration Data" in the shortcut menu.

2. Specify the data to be exported in the "Export configuration data" dialog. 
If you do not want to create the online tags in one tag group or one structure type, use the 
"Without structure (fast export)" option for the export.

3. Specify the path and the name of the XML file.

4. Click "Export". An XML file is generated.

5. If no Excel installation exists on the server, transfer the XML file to another computer, on 
which Excel and the "Excel Workbook Wizard" are installed.

Configuring data access with configuration file
1. Open an empty Excel workbook on the computer with Excel.

Select the command "Excel Workbook Wizard" in the "DataMonitor" menu.

2. Activate the option "Load configuration data from file". Click "Next".

3. Navigate to the desired XML file.

4. Click "Next". The "Add / delete tags" dialog opens.

Result
The Excel workbook is set up to configure the display of process data. Then publish the 
workbook. The workbook is made available on the DataMonitor client as report tool or as 
template for "Reports". 
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Configuring data access of a dedicated Web server / WinCC client via XML file
If you want to display the project data from a dedicated Web server / WinCC client in the Excel 
workbook, you need to observe the following when configuring the Excel workbook via an XML 
file:

● The XML file now includes the data of subordinate servers whose packages are located on 
the DataMonitor server. The export of the loaded packages to the dedicated DataMonitor 
server / WinCC client can take several minutes, depending on the size of the package.

● This XML file must be available on the Excel configuration computer. Enter the server prefix 
when importing the configuration data in the "Excel Workbook Wizard".

● If you configure the data display in the Excel workbook on the WinCC client in the WinCC 
project, you do not have to specify a server prefix. The server prefix is automatically used 
when data is inserted from the package.

Note
Language for the Office package and the Windows Regional Settings

Make sure that the language is the same for the Office package, the "Microsoft Office 
Language Settings", and the Windows Regional Options.

Example:
● If you are using Office 2007 with the language "English (U.K.)", for instance, select the 

regional setting "English (U.K.)".
● If you have set "Chinese (PRC)" as a region and language option in Windows, you must 

also select "Chinese (PRC)" as the primary processing language in the "Microsoft Office 
Language Settings 2007".

More information can be obtained through Microsoft Support: http://support.microsoft.com/
kb/320369/en (http://support.microsoft.com/kb/320369/en)

See also
Configuring the display of tag values (Page 204)

Configuring the display of archive tags (Page 208)

Configuring the display of alarms (Page 212)

Publishing the Excel workbook (Page 217)

Configuring the display of tag values

Introduction       
This chapter describes how to configure the display of tag values.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The dialog "Add/delete tags" is open.
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Procedure
1. Check the add sequence of tag groups in the "Adding tags" area.

2. Click on . The tag selection dialog opens.

3. Select the required tag and move the tag into a field in the Excel table with drag-and-drop.

4. Close the selection dialog. The tag is displayed in the tag list.
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5. Select the tag in the tag list and select the "Server settings" entry in the shortcut menu.

6. Enter the name and password of a WinCC user in the "Server setting" dialog.
To avoid an additional login during online display of process data, enable "Activate 
automatic login". 
Confirm your entries with "OK".
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7. Select the tag in the tag list and select the "Properties" entry in the shortcut menu.
The dialog "Tag properties" will be opened.

8. Set the properties for display in the table, for example, the update cycle or the display of 
time stamp and quality code. 

9. Specify settings for the headings.

10.You can save the settings to the properties. You can then load the settings and use them 
again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" 
file.

11.Confirm your entries with "OK". If necessary, repeat the procedure for additional online 
tags. The settings for the properties will be used again.  Multiple selection of tags is also 
possible in the tag list.

12.Click "Next" to display archive tags and alarms.
Additional information is available under "Configuring display of archive tags (Page 208)" 
and "Configuring display of alarms (Page 212)".

Result
The display of tag values is configured in the Excel workbook. Once you have saved the 
properties, you can use the settings whenever you need to.
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Each table field receives a short text and a comment in the Excel workbook. 

The short text "OV" in tag values stands for online tags. In the comments, the source of the 
displayed values is shown in the format "WDWO_<number>_<tagname>". 

Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data.
● after deleting or inserting new rows or columns in the Excel workbook.

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.
Tags with local computer updating are not supported

In multiple station projects, you can activate the "Computer-local update" option in the tag 
management for internal tags. Any change of the tags only has an effect on the local computer 
in this case. This function is not supported by Excel Workbooks.

See also
Publishing the Excel workbook (Page 217)

Configuring the display of archive tags

Introduction       
This chapter describes how to configure the display of archive tags.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The "Add/delete archive tags" dialog is open.
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Procedure
1. Click  in the dialog "Add/delete archive tags".

2. The tag selection dialog opens.
Select the desired archive tag. 
Drag the tag to a cell in the Excel table with drag-and-drop.

3. Close the selection dialog. The tag is displayed in the tag list.
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4. Select the archive tag in the tag list, and select the "Properties" entry in the shortcut menu.
The "Archive tag properties" dialog opens.

5. Specify the settings for the insertion sequence and headings.
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6. Specify how much data you want to display. For a user-defined resolution, specify an integer 
number and the time unit or specify the quantity of data.

Note

If you use a user-defined data resolution with a combination of "Resolution" and "Quantity 
of data", it is possible that the amount of extracted data is not correctly determined. This 
results under certain circumstances in a mismatch between the displayed values and the 
configured quantity of data.

If you use the option "Quantity of data" in "User-defined resolution", enter an even value in 
the input box. Even values ensure a trend-true display.

7. In the "Time window" box, specify the time window from which you want to display archive 
tags:

● The time settings on the "Standard time" tag are based on the standard times:

– The settings for the relative time period refer to a period starting from the current time. 
You can enter positive and negative values for the past time period in the lines "From" 
and "To". For example, it is 12:00 (noon). You want to display the values for the last ten 
minutes. Activate all time options in the "Relative" line. Enter the value "-10" in the 
"Minutes" column of the "From" line.

– For settings of the absolute time period, enter the corresponding time parameters in the 
"From" and "To" lines and in the corresponding columns.

Click on the "Preview" button to check the time range set. 

● You can define a time window yourself or set a fixed interval, for example, "last week", on 
the "Legacy time" tab. If you want to define a time window yourself, you have the following 
possible settings:

– Relative time window: Specify the starting point and the duration. You can specify a 
duration ranging from a minute to days.

– Absolute time window: Specify the start and end of the time window.

1. If you select  the option "Display manually entered values", an additional column is 
displayed. You then see the letter "m" if an archived value was manually entered during 
runtime.

2. You can save the settings to the properties. You can then load the settings and use them 
again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" 
file.

3. Confirm your entries with "OK".
If necessary, repeat the procedure for additional archive tags. The settings for the properties 
will be used again. Multiple selection of tags is also possible in the tag list.

4. Click "Next" to display alarms. For more information, refer to "Configuring display of 
alarms (Page 212)".

Result
The display of archive tag values is configured in the Excel workbook. Once you have saved 
the properties, you can use the settings whenever you need to.

Each table field receives a short text and a comment in the Excel workbook. 
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The short text "AV" in tag values stands for archive tags. In the comments, the source of the 
displayed values is shown in the format "WDWA_<number>_<tagname>". 

Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data
● after deleting or inserting new rows or columns in the Excel workbook

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.

See also
Publishing the Excel workbook (Page 217)

Configuring the display of alarms

Introduction       
This chapter describes how to configure the display of alarms.

Requirement
● The "Excel Workbook Wizard" is started and an Excel workbook is configured.

● The "Add/delete alarms" dialog is open.
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Procedure 
1. Configure the alarms in the dialog "Add/delete alarms".

2. Select the required cell in the Excel table.
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3. Click . The "Alarm - properties" dialog opens.

4. On the "Standard configuration" tab, define the display options for alarms in the Excel table.

5. Enter a filter condition in the "Filter string" box or use the selection dialog to define a filter, 
for example, to display only specific alarms. If the filter contains a date or time, the "Time 
window" box is disabled.
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6. In the "Time window" box, specify the time window from which you want to display alarms: 

– The settings for the relative time period refer to a period starting from the current time. 
You can enter positive and negative values for the past time period in the lines "From" 
and "To". For example, it is 12:00 (noon). You want to display the alarms for the last ten 
minutes. Activate all time options in the "Relative" line. Enter the value "-10" in the 
"Minutes" column of the "From" line.

– For settings of the absolute time period, enter the corresponding time parameters in the 
"From" and "To" lines and in the corresponding columns.

Click on the "Preview" button to check the time range set.

7. Use the "Maximum number of alarms" option to limit the number of most recent alarms 
displayed. You can display maximum 1,000 messages.
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8. On the "Attributes" tab, select the required attributes of the alarms that you want to display.
Further details can be found in "Alarm attributes (Page 336)".

9. Specify the settings for the attribute insertion sequence and headings.

10.You can save the settings to the properties. You can then load the settings and use them 
again after exiting Excel and opening it again. Click "Save" to save the settings in an "xml" 
file.

11.Confirm your entries with "OK".
If necessary, repeat the procedure for additional alarms. The settings for the properties will 
be used again. Multiple selection of alarms is also possible in the "Alarm list".
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12.Click "Next". The "Description" dialog box opens.

13.You can enter a comment if needed. This comment is displayed when selecting files 
provided for download by the DataMonitor server.

Result
The display of alarms is configured in the Excel workbook. Once you have saved the properties, 
you can use the settings whenever you need to.

Each table field receives a short text and a comment in the Excel workbook. 

The short text for alarms is "AL". In the comments, the source of the displayed alarm is shown 
in the format "WDWL_<number>_<box name>".

Note
Running the Excel Workbook Wizard again

You need to run the Excel Workbook Wizard  again:
● after deleting or moving cells with configuration data
● after deleting or inserting new rows or columns in the Excel workbook

The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed with "Next". Save the workbook and close Excel.

See also
Publishing the Excel workbook (Page 217)

Publishing the Excel workbook

Introduction
You make the configured Excel workbooks available on the DataMonitor client. The workbooks 
are published as report tool for the Intranet/Internet or used as template for "Reports". 

Requirement
● The DataMonitor server is installed on the computer.

● The display of tag values, archive values and alarms is configured.

● The "Description" dialog is open in the "Excel Workbook Wizard".
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Procedure
1. You make the workbooks available in the "Description" dialog.

2. If you click "Publish", the Excel workbook is made available on the DataMonitor client under 
"Report tools" in "Reports".
If you click "Template", the Excel workbook is made available on the DataMonitor client as 
template in "Reports" under "Excel Workbooks".

3. Exit the Excel Workbook-Wizard.

4. Save the workbook and close Excel.

Alternative Procedure
You upload the Excel workbooks on the DataMonitor client. Additional information is available 
under "Making Excel workbooks available as template (Page 338)" and "Making Excel 
workbooks available as report tool (Page 339)".
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Result
The Excel workbooks are made available on the DataMonitor client:

● The workbook is available on the "Report tools" tab. You can use the workbook to display 
process data in runtime. For more information, refer to "Displaying process data in an Excel 
workbook (Page 334)".

● You can create time-controlled and event-controlled reports using the workbook as 
template. For more information, refer to "Creating reports with an Excel workbook 
(Page 342)".

See also
Configuring the display of tag values (Page 204)

Configuring the display of archive tags (Page 208)

Configuring the display of alarms (Page 212)

2.4.6.2 Displaying process data in an Excel workbook

Introduction       
You can display process values or archive values and alarms in an available Excel workbook. 
You can edit and save the workbook.

Requirement
● The Excel workbooks were made available as report tool.

● MS Excel for online display in the Excel workbook

● The DataMonitor server is installed.

● The WinCC project is in Runtime.

● The start page of the DataMonitor is open.

● A user is created in WinCC.
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Procedure
1. Click "Reports" on the start page.

2. Click "Report tools".
You see the Excel workbooks that you have published in the Excel Workbook Wizard or 
made available as report tool.

3. Select a workbook.

4. Double-click the icon of the Excel workbook.

5. In the dialog that follows, click "Open". The workbook is opened.

6. Select the entry "Excel Workbook" in the "DataMonitor" menu.

7. The name of the server whose process data are configured in the workbook is displayed 
in the "WinCC server" field.
The "WinCC Server" field can include the following information:

– Access via domain: The server name and the domain are listed for access outside the 
network domain.

– The DataMonitor start page is the default web page: The "WinCC Server" field contains 
only the server name.

– The DataMonitor start page is in the virtual folder: The server name and the name of 
the virtual folder are displayed, e.g. "/webnavigator".

8. If the tags in the Excel sheet are from several servers, activate "all servers". The tag values 
of all servers are updated in the online display.

Note

To establish connections to all servers, activate "all servers" with "Connect" before you 
establish the connections.

9. Activate the connection to the WinCC project via the button "Connect". After a successful 
connection, the log-in dialog will be opened.
Type in the user name and associated password. 
In case of several servers, the log-in dialogs of the respective servers open one after the 
other.
If a connection was not established, a corresponding alarm is displayed. Clicking on the 
dialog will display additional information about the error that has occurred.

Note

Do not close the "Excel Workbook" dialog as long as the log-in dialog for connection 
establishment to the server is still open.

WinCC/DataMonitor
2.4 WinCC/DataMonitor Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 335



10.The connection status will be displayed in the dialog.
Click the "Read tags", "Read archive tags" and "Read alarms" buttons to update the 
respective values or displays.

11.Activate the check box "Read cyclically" to update the tag values in cycles.

12.Close the "Excel Workbook" dialog after finishing your calculations in Excel.

13.Save the results in the workbook with the "Save as" menu command.

14.Close Excel.

Result
The process data are displayed in the Excel workbook and can be processed further.

If errors occur during display of the Excel workbook or no connection to the WinCC server is 
established, the log entries are displayed in a workbook. The entries contain the date, the tags 
or alarms affected, the server, and the error message.

See also
Administering users for DataMonitor (Page 258)

2.4.6.3 Alarm Attributes

Introduction   
When displaying alarms in "Excel Workbook"  you can select the attributes to be displayed in 
the table in the "Excel Workbook Wizard" .
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Overview 

Position Attribute Type Comments
1 Name of the alarm class VarChar (255)  
2 Name of the alarm type VarChar (255)  
3 Foreground color Integer 4 Bytes  
4 Background color Integer 4 Bytes  
5 Flash color Integer 4 Bytes  
6 to 15 Message Text 1 to 10 VarChar (255)  
16 to 25 Process value 1 to 10 Real 8 Bytes Numerical Process Value 1 to 10
26 State VarChar (255) Status text
27 Info text VarChar (255)  
28 Message class ID Integer 4 Bytes  
29 Message type ID Integer 4 Bytes  
30 AS Number Small Integer 2 Bytes  
31 CPU Number Small Integer 2 Bytes  
32 Duration Integer 4 Bytes Time difference to "Came in" status
33 Alarm counter Integer 4 Bytes Consecutive alarm counter
34 Acknowledgment Status VarChar (255) Text of the acknowledgement status
35 Priority Integer 4 Bytes  
36 Application  Application with which the comment was created.
37 Computer VarChar (255) Computer on which the comment was created.
38 Users VarChar (255) User who created the comment.
39 Comments VarChar (255)  

2.4.6.4 VBA Functions of the Excel Workbook

VBA Functions of the Excel Workbook  
The following functions are available to you in an Excel workbook if you have generated an 
instance of the Excel workbook object using the 
"Application.COMAddIns.Item("ExcelWorkbook.Connect").Object":

● ShowDialog(0): 
Opens the "Excel Workbook" dialog with a normal size.

● ShowDialog(1): 
Opens the "Excel Workbook" dialog with a minimized size.

● ShowDialog(2): 
Opens the "Excel Workbook" dialog hidden.

● CloseDialog: 
Closes the "Excel Workbook" dialog.

● GetServerID(server name): 
Gets the ID of the WinCC server with a specified name, for example: "http://Local_PC".
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● Connect(ServerID): 
Connects the specified WinCC server to the Excel workbooks. You can get the "ServerID" 
using the "GetServerID(server name)" function.
The "Excel Workbook" dialog must be opened before establishing a connection.

● ConnectAll: 
Connects all WinCC servers to Excel workbooks. The "Excel Workbook" dialog must be 
opened before establishing a connection.

● Disconnect(ServerID): 
Disconnects the Excel workbook from the specified WinCC server.

● DisconnectAll: 
Disconnects the Excel workbook from all WinCC servers.

● ReadTags(ServerID): 
Reads the tags from WinCC server with "ServerID". The connection must be established 
before tags can be read.

● ReadArchives(ServerID): 
Reads the archives from WinCC server with "ServerID". The connection must be 
established before archives can be read.

● ReadAlarms(ServerID): 
Reads the alarms from the WinCC server with "ServerID". The connection must be 
established before alarms can be read.

As soon as a connection is established or closed, the event "ServerConnected(ServerID)" or 
"ServerDisconnected(ServerID)" is output by the "ExcelWorkbook.Connect" object. These 
events can be integrated, for example, using "WithEvents" (VB standard).

2.4.7 Working with reports

2.4.7.1 Making an Excel workbook available as template

Introduction   
You can make Excel workbooks available as templates to create ""Reports"". For this you have 
the following options:

● You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard"  
using the "Template" button.

● You upload an Excel workbook not yet published to the DataMonitor client.

This page includes a description of how you make a template available on a DataMonitor client.

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Reports" on the start page.

2. Click the "Uploading templates" tab.

3. Select a directory, in which the template will be stored in the "Target directory" field.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Click "Find" for the "Selected template". Navigate to the desired Excel workbook.

5. Click the "Upload" button.

Result
You can create time-controlled and event-controlled reports using the workbook as template. 

See also
Assigning Access Rights (Page 278)

Displaying a report with an Excel Workbook (Page 342)

Configuring the Excel workbook (Page 201)

2.4.7.2 Making an Excel workbook available as a report tool

Introduction   
You can make Excel workbooks centrally available as report tools in "Reports". For this you 
have the following options:

● You publish the Excel workbooks on the WinCC server with "Excel Workbook Wizard"  
using the "Publish" button.

● You upload an Excel workbook not yet published to the DataMonitor client.
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Here you find a description of how you make an Excel workbook not yet published available 
on the DataMonitor client.

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click the "Uploading templates" tab.

3. Click "Find" for "Uploading templates for Excel workbooks". Navigate to the desired Excel 
workbook.

4. Click the "Upload" button.

Result
The workbook is available on the "Report tools" tab. You can use the workbook to display 
process data in runtime. 

See also
Displaying process data in an Excel workbook (Page 334)

2.4.7.3 Making Settings for Reports

Introduction           
Different settings are required for using the "Reports" function in DataMonitor. 
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Requirement
● PDF Reader is installed.

● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click on the "Settings" tab. The "Settings" page is displayed.

3. Check the entries in the section "General project settings".
You can now select the printer of the Web server. Printing is only possible in files.

4. To enable the output to a PDF file, activate the option "Activate API print".
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5. Enter the data for sending mail in the "Mail" area:

– Server: Outgoing mail server (SMTP)

– User name: Name for the sender

– Password

– Sender: E-mail account used to sending the e-mail

6. Click the disk icon in the section "General project settings" to save your settings.

7. In the "Settings of the circular buffer" area, you can define the number of created reports 
that are stored in the selected destination directory. The box has a pre-assigned value of 
20. If the maximum number of reports of the same type has been reached, the "First in First 
out" principle applies. For example, if 21 reports of "Alarm Table" type have been created, 
the report that was created first is removed.

8. Click the disk icon in this section to save your settings.

Result
The settings for "Reports" have been made.

Product support - example
FAQ "51334611" on the Internet under "Product support" gives a detailed example:

● http://support.automation.siemens.com/WW/view/en/51334611 (http://
support.automation.siemens.com/WW/view/de/51334611)

See also
Sending WinCC/DataMonitor reports by e-mail (http://support.automation.siemens.com/WW/
view/de/51334611)

2.4.7.4 Displaying a report with an Excel Workbook

Introduction   
Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following 
is a description for creating reports from Excel workbooks. 

Requirement
● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● You have already published or made available as templates the Excel workbooks you want 
to use.

● The start page of the DataMonitor is open.
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Procedure
1. Click "Reports" on the start page.

2. Click on the "Excel Workbooks" tab. The "Excel Workbooks" page is displayed.

The icons in front of "List of time-controlled Excel workbooks" and "List of event-controlled 
Excel workbooks" are deactivated. The icons indicate that no reports are currently 
configured.

3. Select one of the available Excel workbooks under "Available Excel workbooks".

4. Select the target directory in which you want to store the reports. Only the directories, for 
which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail 
recipient" field. You can enter several recipients as you would with any standard e-mail 
program.

6. Use  to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-
controlled creation of the report in the following steps.

8. To configure a time-controlled report, enter the following in the "Time-controlled Excel 
workbooks" area:

– Date: Enter the date in the respective field or enter the date using the calendar. To open 
the calendar, click the "Calendar" icon.

– Time: Define the time when you want the report to be created.

– Repetition: Define the repetition rate, for example, "Once" or "Weekly".
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9. Click "Add" in the "Time-controlled Excel workbooks" area. The report is displayed in the 
"List of time-controlled Excel workbooks".

10.To configure an event-controlled report, enter the following in the "Event-controlled Excel 
workbooks" area:

– Selected WinCC tag: Click . Select the required tag in the selection dialog.

– Defining event control: Set the triggering event, for example, when the tag value 
changes.
If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the 
respective limits.

11.Click "Add" in the "Event-controlled Excel workbooks" area. The report is displayed in the 
"List of event-controlled Excel workbooks".

Result
A time-controlled or event-controlled report is configured as "Excel Workbook". 

The configured reports are displayed in the lists of the "Excel Workbooks" . You can edit or 
delete the reports in the lists. 

Once the report has been created, it is available in runtime on the "Published Reports" tab in 
the selected directory. 

Note
Information on event-controlled "Excel Workbooks"

An event-controlled report is only created if the time period in which the tag changes is greater 
than one minute.

Keep in mind that the frequent creation of one or more event-controlled reports over a long 
period of time takes up a lot of memory and uses up valuable resources. This case often occurs, 
for example, with frequent signal changes of a tag that trigger an event-controlled report.

See also
Making an Excel workbook available as template (Page 338)

Publishing the Excel workbook (Page 217)

2.4.7.5 Creating a report with a print job

Introduction   
Use "Reports" to create reports from Excel workbooks or print jobs in PDF format. The following 
is a description for creating reports using print jobs in PDF format. 
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Requirement
● PDF Reader is installed.

● The WinCC project is activated on the DataMonitor server.

● The option "Report Runtime" is activated in the WinCC project in the properties of the 
computer.

● The start page of the DataMonitor is open.

Procedure
1. Click "Reports" on the start page.

2. Click on the "Print jobs" tab. The "Print jobs configuration" page is displayed.

The icons in front of "List of time-controlled print jobs" and "List of event-controlled print 
jobs" are deactivated. The icons indicate that no print jobs are currently configured.

3. Select the desired print job under "Available print jobs".

4. Select the target directory in which you want to store the reports. Only the directories, for 
which the user that is logged in has "Create" access rights, can be selected.

5. If you want to send the report as an e-mail, enter the e-mail addresses in the "E-mail 
recipient" field. You can enter several recipients as you would with any standard e-mail 
program.

6. Use  to create the report immediately.

7. If you do not want to create the report immediately, configure a time-controlled or event-
controlled creation of the report in the following steps.
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8. To configure a time-controlled report, enter the following in the "Time-controlled print jobs" 
area:

– Date: Enter the date in the respective field or enter the date using the calendar. To open 
the calendar, click the "Calendar" icon.

– Time: Define the time when you want the report to be created.

– Repetition: Define the repetition rate, for example, "Once" or "Weekly".

9. Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of 
time-controlled print jobs".

10.To configure an event-controlled report, enter the following in the "Event-controlled print 
jobs" area:

– Selected WinCC tag: Click . Select the required tag in the selection dialog.

– Defining event control: Set the triggering event, for example, when the tag value 
changes.
If you have selected "lower limit", "upper limit" or "both limits" for event control, enter the 
respective limits.

11.Click "Add" in the "Time-controlled print jobs" area. The report is displayed in the "List of 
event-controlled print jobs".

Result
A time-controlled or event-controlled report is configured as print job in PDF format. 

The configured reports are displayed in the lists of the print jobs. You can edit or delete the 
reports in the lists.

The report is created in the language that was set during WinCC configuration. The WinCC 
Runtime language does not have an effect on the representation of dynamic elements, such 
as tables.

Once the report has been created, the PDF files are available in runtime on the "Published 
Reports" tab in the selected directory.

Note
Opening Asian PDF files with Acrobat Reader

To open the Asian PDF files created with "Reports", you need the country-specific version or 
the respective font package of the Adobe Acrobat Reader.

The four Asian languages are fixed to one font each. This means the font settings in the report 
layout will not have an effect on the Asian languages.
Information on event-controlled print jobs

An event-controlled print job is only created if the time period in which the tag changes is 
greater than one minute.

Keep in mind that the frequent creation of one or more event-controlled print jobs over a long 
period of time takes up a lot of memory and uses up valuable resources. This case often occurs, 
for example, with frequent signal changes of a tag that trigger an event-controlled print job.
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WinCC/WebUX 3
3.1 WinCC/WebUX - Documentation

3.1.1 WebUX - Overview

Overview
WinCC/WebUX provides a solution for operator control and monitoring of the automation 
system independent of device and browser. 

In the interests of process security, only HTTPS connections are supported with SSL 
certificates.

The employed Web technology results in restrictions to the WinCC basic system. Some 
Graphics Designer objects and their properties are not supported. You can find additional 
information under:

● AUTOHOTSPOT

Distinction WebUX - WebNavigator

WinCC/WebUX WinCC/WebNavigator
Based on generally established Web standards Based on ActiveX technology from Microsoft
Can be used regardless of browser. Only supports Microsoft Internet Explorer
Runs on a wide variety of devices, regardless of 
operating system, for example on tablets, PCs and 
smart phones.

Runs only on Windows computers.

Does not require a client installation. Requires a client installation.
Default user rights are sufficient Requires administrative rights to install.

Visualization in WebUX
WinCC pictures and the supported WinCC controls are displayed in the Web browser with the 
"HTML5" and "SVG" standards:

● The graphic elements are created with SVG elements.

● The dynamic updating of the process picture is performed via a permanent connection 
between the browser and server. 
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Note
Browser-dependent representation

Minor differences in display and behavior are possible for the different browser versions.

Working with WebUX
In order to use WinCC/WebUX, following these steps:

1. Install WinCC and WinCC/WebUX on the WebUX server.

2. Set up a WebUX website.

3. Configure a WinCC project for WebUX.

4. Access the WebUX server with the terminal device.

Performance data
The performance of the WebUX system depends on the employed hardware of the WebUX 
server and the volume of graphic objects and scripts.

Configuration
As a typical scenario, we tested the simultaneous access of 100 WebUX clients to one WebUX 
server.

Picture change in Runtime:
The performance on a WebUX client basically corresponds to the behavior on a WinCC client.

However, the load times during picture changes on a WebUX client are influenced by the 
following factors:

● Number of WebUX clients that access the WebUX server simultaneously

● Performance of the WebUX clients

● Utilized browser
Depending on the browser, the picture setup time can vary by several seconds.
Additional information on tested browsers is available on the Internet on the Customer 
Support pages under entry ID =109480708:

– http://support.automation.siemens.com/WW/view/de/109480708 (http://
support.automation.siemens.com/WW/view/en/109480708)

● Number of scripts in the process pictures 
Unlike with WinCC clients, all scripts are executed on the WebUX server.

● Number of graphic objects in the process pictures

● Type of graphic objects in the process pictures
Web controls can extend the load times.
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Note
Connection loss due to performance load

High performance load can result in a timeout. The connection of the WebUX client to the 
WebUX server is disconnected as a result.

WinCC/WebUX V7.3: Migration
To use a project migrated from V7.3 in WebUX V7.4 and higher, convert the process pictures 
and project functions.

You can find additional information in the WinCC Information System under: "First Steps > 
Migration > Additional Steps".

See also
http://support.automation.siemens.com/WW/view/de/109480708 (http://
support.automation.siemens.com/WW/view/en/109480708)

3.1.2 Licensing
The WinCC/WebUX basic package with an integrated WinCC WebUX Monitor license is 
included in WinCC.

WebUX client
The WebUX clients are licensed on the WebUX server.

No license is required for the WebUX client on the computer.

WebUX server
The WebUX server is installed on a WinCC system. The WinCC basic system requires at least 
the WinCC basic RT license.
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The license keys are differentiated as described below and run in parallel on the WinCC/
WebUX server:

License Function Comments
WinCC WebUX 
Monitor

The user has only read 
access.

The authorization level 1002 "Web access - monitoring 
only" is configured for the user in the User Administrator.
If the available "Monitor" licenses have been allocated, 
an "Operate" license or a WebNavigator license can al‐
so be allocated to a WebUX client for read access.

WinCC WebUX 
Operate

User has read and write 
access

If the available "Operate" licenses have been allocated, 
a WebNavigator license can also be allocated to a We‐
bUX client for read or write access.

WinCC/WebNavi‐
gator

The user's authoriza‐
tions determine wheth‐
er write access is possi‐
ble in addition to read 
access.

If a WinCC/WebNavigator license is also installed in the 
WinCC system, the WebNavigator license can also be 
allocated to a WebUX client.
First, however, all available WebUX licenses are used.

License packages
The license packages are available with 1, 3, 10, 30 and 100 clients. 

If you have upgraded from WebUX V7.3, there may also be licenses for 5 / 25 / 50 / 150 clients.

If the number of licensed clients is exceeded during the logon attempt by a WebUX client, no 
further logon is permitted.

The packages are version-independent and can be combined.

Reserved license
A reserved WebUX license always gives the user guaranteed access to the WebUX server. 

A connection remains reserved for the user. The number of freely available WebUX licenses 
is reduced by each configured reserved license.

Applications 
Possible applications include: 

● Remote operator access:
If the connections to the WebUX server are occupied by read-only access, a connection 
remains reserved for operation.

● Central display: 
Central client stations are always connected, for example, to display the status of the 
WinCC system.

Reserve WebUX license
In the User Administrator, you assign one of the available licenses to a WebUX user as a 
reserve license.

To do this, enable the "Reserve WebUX license" option for the user. The field "WebUX Number 
of reserved licenses" shows how many WebUX licenses are assigned through reservation.

Reserved licenses cannot be configured for user groups, only for individual users.
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If more reserved licenses are configured than those available on the WebUX server, the 
licenses of the first users logged on are used.

3.1.3 Communication: SSL certificate for HTTPS connections
To improve the security of your communication, WebUX only supports HTTPS connections.

You need a digital SSL certificate for the WebUX server. 

You can find more information in the Microsoft Support under "How to Set Up an HTTPS 
Service in IIS":

● http://support.microsoft.com/kb/324069 (http://support.microsoft.com/kb/324069)

NOTICE

Protecting the infrastructure

Setting up a Web server may enable access to your plant infrastructure.

Therefore, protect the computer on which the Web server is installed. Make sure that the 
following rules are followed:
● The computer is only accessible via secure connections.
● The check mechanisms provided by software vendors are activated and cannot be 

bypassed under any circumstances.

Install a SSL certificate
You have the following options when setting up the WebUX website:

● Select an existing certificate

● Create self-signed certificates:

● Install a certificate after setting it up

Creating a new certificate
1. Activate the "Create a new certificate" option.

2. Enter a name of your choice.
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When the configuration is completed, a self-signed certificate is created. The certificate is valid 
for one year.

Note
Restricted authentication

The certificates that you create when you configure the WebUX website itself are not verified 
by an official certification body. Depending on your browser settings, a warning message is 
displayed when you access the website.

To better secure the server authentication, install the certificate of an official certification body.
Display of secure data sources only

For display of websites and external files, one of the following conditions must be met:
● Call via the HTTPS connection
● Call of a trusted site

See also
http://support.microsoft.com/kb/324069 (http://support.microsoft.com/kb/324069)

3.1.4 Installation

Software requirements
Certain requirements concerning operating system and software configuration must be met 
for the installation.

WebUX server: Operating system

Software Configuration Comments
Windows 7 Professional Service 

Pack 1
Enterprise Service Pack 1
Ultimate Service Pack 1

Standard installation
64-bit
Only a limited number of connections is possible. A maximum 
of three WebUX clients can connect to the WebUX server.

Windows 8.1 Pro
Enterprise

Standard installation
64-bit
Only a limited number of connections is possible. A maximum 
of three WebUX clients can connect to the WebUX server.
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Software Configuration Comments
Windows 10 Pro

Enterprise
Standard installation
64-bit
Only a limited number of connections is possible. A maximum 
of three WebUX clients can connect to the WebUX server.
Restricted release
Windows 10 only has restricted release. You can find detailed 
information in the Product Support under the entry num‐
ber="109482899":
● Internet: Windows 10 for WinCC V7.4 - FAQ (http://

support.automation.siemens.com/WW/view/en/
109482899)

Windows Server 2008 R2 Standard Service Pack 1 64-bit
Windows Server 2012 R2 Standard 64-bit

Additional software requirements

 Version / setting Relevant for Comments
Web browser The browser must support 

HTML5.
WebUX client / 
terminal

WebUX can be used with any browser.

WinCC version WinCC V7.4 WebUX server The WebUX server is installed on a WinCC 
system.

SIMATIC Logon ver‐
sion (optional)

SIMATIC Logon V1.5 SP3 WebUX server Only relevant if you are using SIMATIC Log‐
on for central user administration.

User rights for installa‐
tion

Administrator rights WebUX server Required rights for installing the WebUX 
server.

User rights for opera‐
tion

Default user rights WebUX client
WebUX server

Required rights on the WebUX server and 
WebUX client.

Microsoft Internet Infor‐
mation Service (IIS)

WWW Services > Common 
HTTP Features or Shared HTTP 
Features:
● HTTP error
● HTTP redirect
● Standard document
● Static content
WWW Services > Performance 
Features:
● Compression of dynamic 

content
● Compression of static content
WWW Services > Application De‐
velopment Features (only for Win‐
dows 8.1 / Windows Server 2012):
● WebSocket protocol

WebUX server The WebUX server requires the Microsoft 
Internet Information Service (IIS).
Enable the settings listed for the IIS.
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WebUX client (terminal)
You only need a HTML5-enabled Web browser such as Chrome, Firefox, Internet Explorer or 
Safari on a terminal that accesses the WebUX server.

Installation of the WebUX server
You can install WinCC/WebUX together with WinCC.

When you install the server WebUX at a later time, proceed as follows:

1. Start the WinCC installation DVD.

2. Select the installation type "Custom Installation".

3. In the "WinCC" group of the "Program" dialog, select the entry "WinCC WebUX".

4. Transfer the WebUX license. You can find additional information under:

– Licensing (Page 349)

After the installation and restarting the PC, the WinCC WebUX Configurator opens. 

You can find information about configuring WebUX under:

● Configuring the WebUX website (Page 354)

See also
Licensing (Page 349)

Communication: SSL certificate for HTTPS connections (Page 351)

Configuring the WebUX website (Page 354)

Internet: Windows 10 for WinCC V7.4 - FAQ (http://support.automation.siemens.com/WW/
view/en/109482899)

3.1.5 Configuring the WebUX website
Configure the WebUX website on the WebUX server and the connection via HTTPS to 
communicate with the WebUX clients.

WinCC WebUX Configurator
After WinCC and WinCC/WebUX are installed, the WinCC WebUX Configurator opens. 

To make changes later, you can find the WinCC WebUX Configurator in the "Siemens 
Automation" program group:

● SIMATIC > WinCC > Tools > WinCC WebUX Configuration Manager
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You use the WebUX Configurator to set up the standard configuration for the use of WebUX.

● Configuration of the Microsoft Internet Information Service

● Settings of the Web server

● SSL certificate for HTTPS connections

● Virtual folder

Read the information about digital certificates at:

● Communication: SSL certificate for HTTPS connections (Page 351)

Creating virtual folders
During the course of initial configuration, you specify whether you wish to create a new default 
website or a new virtual directory. 

If you would like to set up the website as a virtual directory, at least one website with activated 
SSL encryption must be present on the PC. The websites that meet this criterion are shown 
in the "Select the higher level website" selection list.

Procedure: Use virtual folders
1. Configuration 

Select a higher-level website. 
The WebUX Configurator takes the port number and the SSL settings from the IIS settings.

2. Access from the terminal (WebUX client):
To access the website, add the name of the virtual directory to the URL in the browser.

Requirement
● Microsoft Internet Information Service (IIS) is installed.

● The WinCC basic system is installed.

● The "WinCC WebUX" program package is installed.

● The "WinCC WebUX" license is installed.

Procedure
After installing WinCC/WebUX and restarting the PC, the WinCC WebUX Configurator opens.

1. Click "Apply configuration". 
The standard configuration is set up. 
The "IIS configuration" dialog opens.

2. Enter a name for the website.

3. If you only operate the WebUX web page on the server, select the "Create a new website" 
option.
If you work with virtual folders, proceed to step 6.
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4. Enter the number of the port used for access in the "Port" field. 
The HTTPS standard port "443" is set by default. 
If you select a different port number, the address must be adapted on the WebUX client: 
When logging on to the terminal, this number is added into the browser address bar after 
the server name.

5. Select the settings for the digital certificate of the server.

6. If you set up the website as a virtual directory, select a higher level website.
The WebUX Configurator takes the port number and the SSL settings from the IIS settings.

7. Confirm with "OK".

8. When the configuration has been set up, click "Exit".

9. Restart the computer.

Result
The WebUX server has been configured and the WebUX website set up.

The WinCC project must be activated in Runtime in order to access the WebUX server.

See also
Communication: SSL certificate for HTTPS connections (Page 351)

http://msdn.microsoft.com/en-US/library/ms751408(v=vs.110).aspx (http://
msdn.microsoft.com/de-de/library/ms751408(v=vs.110).aspx)

3.1.6 Functions supported in WebUX

3.1.6.1 Functions supported in WebUX

Restrictions compared to WinCC Runtime
The following restrictions apply as compared to the range of functions in WinCC:

● Touch operation is not optimized.
You can, however, use all touch gestures supported by WinCC.

● Design settings are not supported.
Note that the global design is activated by default in WinCC projects.

● Not all objects or properties are supported for graphic objects.
(For details, see "Supported functions: Graphic objects (Page 357)")
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● Not all controls or functions are supported for WinCC ActiveX controls
(For details, see "Supported functions: WinCC Controls (Page 359)")

● Dynamization (for details, see "Supported functions: Dynamization (Page 363)"):

– Global script: ANSI-C is not supported.

– Global script: VBScript is supported with restrictions.

– Dynamics dialog: Restrictions for complex formulas or scripts.

– Dynamization via the Dynamic Wizard is not supported.

All unsupported objects are hidden in WebUX.

You can find detailed information in the following sections.

See also
Configuring a WinCC project for WebUX (Page 366)

Supported functions: WinCC Controls (Page 359)

Supported functions: Dynamization (Page 363)

Supported functions: Graphic objects (Page 357)

3.1.6.2 Supported functions: Graphic objects
WebUX supports most of the graphic objects.

You can find additional information on limitations in the dynamization of object properties on 
the Customer Support pages on the Internet under entry ID=109481796:

● http://support.automation.siemens.com/WW/view/en/109481796 (http://
support.automation.siemens.com/WW/view/en/109481796)

Restrictions for all Graphics Designer objects
The following restrictions apply to all graphic objects in WebUX:

● The print function is not supported.

● Central color palette and global design are not supported.
The configured colors are displayed instead.

● Grouped objects: The "Tooltip Text" is not supported.

● The line ends do not flash

● Picture or background picture The graphic formats EMF and WMF are not supported.

The following object properties are generally not supported:

Object property OLE Automation Name Comment
Configured languages DataLanguage  
Draw inside frame DrawInsideFrame The border lines are always 

drawn inside the frame.
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Object property OLE Automation Name Comment
Global color scheme GlobalColorScheme  
Global shadow GlobalShadow The shadow is not sketched.
LocalID property LocaleID  
Server name ServerName  
WinCC style WinCCStyle The object is shown according to 

the respective settings instead.Windows style WindowsStyle

Supported Graphics Designer objects

Standard object WebUX Unsupported properties 1)

All objects except for "Con‐
nector"

Yes see "Restrictions for all Graphics Designer objects"

Connector No For dynamized user objects connected by means of the 
"Connector" object, dynamizations are not displayed via We‐
bUX.
The connector is handled in the same way as the static object 
"Line". The ends of a line can have a different design.

Smart object WebUX Unsupported properties 1)

Application window Yes ● Can only be used for script diagnostics.
The "Application" property is not supported.

Picture window Yes ● Window mode (WindowPositionMode)
● Monitor number (WindowMonitorNumber)
● Independent window (IndependentWindow)
● Menu/Toolbar configuration (MenuToolbBarConfig)

Control No -
OLE object No -
I/O field Yes ● Clear on New Input (Internet Explorer only)

● Apply on Full Input
● Clear on Invalid Input
● Limited cursor movement (RestrictedCursorMovement)

Bar Yes -
Graphic Object Yes ● Picture referenced (PicReferenced)
Status display Yes ● Basic picture transparent color (BasePicTransColor)

● Basic picture referenced (BasePicReferenced)
● Flash picture referenced (FlashPicReferenced)

Text list Yes ● Maximum of 512 entries
● Text reference (LanguageSwitch): 

Texts of a text list that are connected with a tag of the 
"Text reference" data type do not change into the 
selected language when the language is switched. The 
texts are still displayed in the Runtime language that is 
set in the computer properties.
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Smart object WebUX Unsupported properties 1)

Multi-line text Yes ● No input possibility
Combo box Yes ● Maximum of 512 entries
List box Yes ● Maximum of 512 entries
Faceplate instance No -
.NET Control No -
WPF Control No -
3D bar No -
Group Display No -
Status display (extended) No -
Analog display (extended) No -
DataSet object No -

Windows object WebUX Unsupported properties 1)

All objects Yes see "Restrictions for all Graphics Designer objects"
Button Yes ● Picture on referenced (PicDownReferenced)

● Picture off referenced (PicUpReferenced)
Round Button Yes ● Picture Deact. Referenced (PicDeactReferenced)

● Picture on referenced (PicDownReferenced)
● Picture off referenced (PicUpReferenced)

Slider object Yes ● Visualize tag status (ShowBadTagState)
● High limit color (HighLimitColor)
● Low limit color (LowLimitColor)

Tube object WebUX Unsupported properties 1)

All objects Yes see "Restrictions for all Graphics Designer objects"

1) Restrictions for all Graphics Designer objects are not listed again.

See also
Functions supported in WebUX (Page 356)

Supported functions: WinCC Controls (Page 359)

http://support.automation.siemens.com/WW/view/en/109481796 (http://
support.automation.siemens.com/WW/view/en/109481796)

3.1.6.3 Supported functions: WinCC Controls

WinCC ActiveX Controls
Most ActiveX controls are executable as Web controls in WebUX. 
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Restrictions on individual controls are listed below.

WinCC ActiveX Control WebUX Control Restriction 1)

WinCC AlarmControl WinCC Alarm Web Control Yes
WinCC OnlineTableControl WinCC OnlineTable Web Control Yes
WinCC OnlineTrendControl WinCC OnlineTrend Web Control Yes
WinCC FunctionTrendControl WinCC FunctionTrend Web Control Yes
WinCC RulerControl WinCC Ruler Web Control Yes
WinCC Slider Control WinCC Slider Control -
WinCC Digital/Analog Clock Control WinCC Digital/Analog Clock Control Yes
WinCC Gauge Control WinCC Gauge Control Yes
WebBrowser Control WebBrowser Control Yes
Unsupported WinCC controls:
WinCC BarChartControl -
WinCC SysDiagControl -
WinCC UserAdminControl -
WinCC UserArchiveControl -
WinCC Channel Diagnosis Control -
Siemens HMI Symbol Library -

1) Restrictions for all Graphics Designer objects are not listed again (see "Supported functions: 
Graphic objects (Page 357)").

ActiveX controls in WebUX: Restrictions
The following limitations apply to Web controls.

You can find additional information on limitations of object properties on the Customer Support 
pages on the Internet under entry ID=109481796:

● http://support.automation.siemens.com/WW/view/en/109481796 (http://
support.automation.siemens.com/WW/view/en/109481796)

Restriction applies to the following 
controls

Unsupported functions

All WinCC controls ● Object events
WinCC Alarm Web Control
WinCC OnlineTable Web Control
WinCC OnlineTrend Web Control
WinCC FunctionTrend Web Control
WinCC Ruler Web Control

● Exporting Runtime data
● Online configuration in Runtime
● Operator authorization for the key functions in the toolbar
● Configuring the key functions of the toolbar in Runtime
● Time base in Runtime (TimeBase): The local time zone is 

always displayed, regardless of the project properties.
● Print function
● VBScript: No methods

WinCC OnlineTrend Web Control
WinCC FunctionTrend Web Control

● Trend selection
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Restriction applies to the following 
controls

Unsupported functions

WinCC OnlineTrend Web Control ● User scaling
● Displaying trends:

– The trend type "Display values"
– Color coding of a value with uncertain status

WinCC FunctionTrend Web Control ● Data from user archives
WinCC Alarm Web Control ● Message blocks

– Daylight saving/standard time
– Archiving
– Logging
– Class priority
– Frequency
– Sum +/-, Sum +/*1, Sum +/*2, Sum +/+
– Average +/-, Average +/*1, Average +/*2, Average +/+
– Apply project settings

● Acknowledging a central signaling device
● Configuration of the filter in Runtime
● Configuration of the lock list in Runtime
● User-defined sorting of the displayed messages
● Paging through long-term archive list
● The contents of each of the "Class", "Type", "Date" and "Time" 

columns are displayed in one common column.
WebBrowser Control ● Only HTTPS connections are possible.

You can find additional information under "Displaying files in 
the Web browser control".

● The browse dialog for locating the URL is not offered.
● Depending on the Web browser, unsupported buttons and 

functions are grayed out.
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Restriction applies to the following 
controls

Unsupported functions

WinCC Digital/Analog Clock Con‐
trol

● Selection border (FocusRect)
● Foreground color (ForeColor)

WinCC Gauge Control ● Maximum angle (AngleMax)
● Minimum angle (AngleMin)
● Background color (Back Color)
● Background graphic (BackgroundPicture)
● Background style (BackStyle)
● Inner frame (BevelInner)
● Outer frame (BevelOuter)
● Frame width (BevelWidth)
● Border width (BorderWidth)
● Scale center point size (CenterScale)
● Frame color (FrameColor)
● Frame picture (FramePicture)
● Frame scale (FrameScale)
● Decimal point (ShowDecimalPoint)
● Dial offset (TicOffset)
● Dial text offset (TicTextOffset)
● Dial width (TicWidth)

Displaying files in the Web browser control
To display a file in the Web browser control, follow these steps:

1. Save the file in a subfolder in the following path

– C:\inetpub\wwwroot\siemens\WebRH\public\<folder>

2. Use the following call in the Web browser control:

– https://<server name>/<folder>/<file name>

Example
The PDF file "WinCC.pdf" is located in the subfolder "WebUXFiles":

● C:\inetpub\wwwroot\siemens\WebRH\public\WebUXFiles

Call using the following URL:

● https://localhost/WebUXFiles/WinCC.pdf
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Note
No access restrictions for the "public" folder

Note that files in the "C:\inetpub\wwwroot\siemens\WebRH\public" folder can be accessed by 
all users.

The WinCC authorizations do not have an effect on the files in this folder.

See also
Functions supported in WebUX (Page 356)

http://support.automation.siemens.com/WW/view/en/109481796 (http://
support.automation.siemens.com/WW/view/en/109481796)

3.1.6.4 Supported functions: Dynamization

Dynamization via scripts and the Dynamics dialog
WebUX supports graphics objects in which the following dynamics are configured:

● Trigger

● Tag connection

● Direct connection

● Dynamics dialog
Dynamics via the Dynamics dialog are converted to VBScript.

● VBS action

WinCC/WebUX
3.1 WinCC/WebUX - Documentation

WinCC Basic Options (WebNavigator, DataMonitor, WebUX)
System Manual, 02/2016, A5E37537386-AA 363

http://support.automation.siemens.com/WW/view/en/109481796
http://support.automation.siemens.com/WW/view/en/109481796


Restrictions
The following restrictions apply to the dynamization:

● VBScript:

– Scripts cannot open interactive applications, for example, MS Excel. The function is 
disabled by restrictions of the operating system.

– WebUX Web controls do not support methods.
Instead, address the elements of the controls through an assigned index.

– The following methods are not supported:
"HMIRuntime.Stop" to end WinCC Runtime
"item.Activate" to activate a picture or picture element

– Triggering the animation via the "Animation cycle" trigger type is not supported.

– Calling message fields with the "MsgBox" function is suppressed. (Messagebox)

– The VBS object "DataSet" must only include global variables with a scalar data type, 
e.g. "BOOL", "DOUBLE", "LONG INT".
OLE automation data types are not processed, e.g. "VARIANT" or an Excel table.

– Some object properties cannot be made dynamic or use a different value format.
You can find additional information on this on the Customer Support pages on the 
Internet under entry ID=109481796:
http://support.automation.siemens.com/WW/view/en/109481796 (http://
support.automation.siemens.com/WW/view/en/109481796)

● Dynamics dialog: 
Complex formulas and scripts are not supported.

● Dynamic Wizard: 
Dynamization via the Dynamic Wizard is not supported.

● ANSI-C: 
C actions are not supported.

● The behavior of the "Focus Change" event is different to that in WinCC Runtime.

Note
Scripts always run on the WebUX server

Scripts are not executed locally on a WebUX client. Scripts that run locally on a WinCC client 
are executed on the WebUX server in the case of access via WebUX.

This means that the following factors can affect the WebUX server performance:
● Number of running scripts
● Number of WebUX clients accessing the server

If necessary, reduce the scripts in the process pictures that are saved for WebUX.

Dynamization via the Dynamics dialog
The configuration of the Dynamics dialog is converted to VBScript for the display in the Web 
browser. The restrictions for complex formulas or scripts apply here (Details (Page 369)).
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The conversion takes place automatically when you save the process picture.

If the configuration cannot be implemented, the object and the dynamic property are listed in 
the output window.

You can jump from the message to the property and adapt the Dynamics dialog there.

Note
Script adaptation overwrites dynamization

If you adapt the dynamization in VBScript, the dynamization is overwritten in the Dynamics 
dialog.

The modified process pictures can then be displayed in WinCC Runtime. This also applies to 
the representation on WinCC clients and WinCC servers.

Procedure
1. Double-click on the object property listed in the output window of the Graphics Designer or 

select the object in the process picture.

2. Open the shortcut menu for the dynamic property listed in the message.

3. Select the entry "VBS action". 
A message indicates that the change is stored permanently for the dynamization of the 
property.
After the message is confirmed, the "Edit VB action" editor opens.
The script comments contain more information on the formulas that are not automatically 
converted.

4. Check the script and save the changes.
When you close the editor without saving the script, the original dynamization is retained 
via the Dynamics dialog.

See also
Functions supported in WebUX (Page 356)

http://support.automation.siemens.com/WW/view/en/109481796 (http://
support.automation.siemens.com/WW/view/en/109481796)
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3.1.7 Configuring a WinCC project for WebUX

Introduction
To use WinCC/WebUX on the terminal devices, the WinCC project must be configured 
accordingly:

● The WebUX users are set up.

● The process pictures are optimized for viewing on the Web.

Note
Windows 7 / Windows 8.1 / Windows 10: Limited number of WebUX clients

IIS on Windows 7, Windows 8.1 and Windows 10 supports a maximum of ten connections or 
instances. WebUX requires more than one connection for a client. Therefore, a maximum of 
three WebUX clients can connect to the WebUX server.

If the limit is exceeded, you can no longer operate the instances already connected.

Use a server operating system for Web applications with multiple WebUX clients.

Setting up WebUX users
You can also set up and manage users and user groups via SIMATIC Logon.

However, you always configure the settings for accessing the WebUX server in the WinCC 
User Administrator.

You can find additional information in the WinCC Information System under:

● Structure of the User Administration > Administering users > Administering users for Web 
access

Adjust process pictures for WebUX
To configure the display in WebUX, select the "Web-enabled" object property for the process 
pictures.

The pictures are additionally saved in "*.rdf" format. In the WinCC Explorer, however, only the 
process pictures in the "*.pdl" format are displayed.

Checking the process picture
When a process picture is saved as web-enabled, the properties of the picture and the objects 
are checked.

The result is shown in the output window of the Graphics Designer. Make sure that the following 
option is activated: "Tools > Settings > Options > Display performance warnings".

The messages included a list of graphic objects that have not been saved web-enabled for 
each process picture. Double-click on the entry in the output window to edit the objects.

Only web-enabled objects are displayed in WebUX Runtime.
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For this, refer to the information under:

● Functions supported in WebUX (Page 356)

Configuring the WinCC project for WebUX use
1. Configure the process pictures as executable for Web browsers in the Graphics Designer:

– Select "Yes" for the "Web-enabled" object property in the "Miscellaneous" group.

– Save the process picture. 

– If necessary, check the messages in the output window.

2. Configure the WebUX users in the WinCC User Administrator:

– Activate the "WebUX" option in the properties.

– Select the start picture from the list of process pictures that have been saved as "Web-
enabled".

– Select the Runtime language.
The runtime language cannot be changed at the terminal.

– If the user should be restricted to read-only access, select the authorization level 1002 
"Web access - monitoring only".

– If guaranteed access should be reserved for the user, activate the "Reserve license" 
option.

Configuring the dedicated WebUX server
With WinCC/WebUX, you can use a dedicated Web server for the central data supply of the 
WebUX clients.

Note the following requirements for this:

● WinCC/WebUX must be installed on the dedicated WebUX server.

● The WebUX start picture must be available locally on the dedicated WebUX server.

● Additional process pictures can only be called via a picture window in the start picture.
Configure the following object properties for the object "Picture Window":

– "Picture Name (PictureName)":
Configure the picture name without server prefix.

– "Server Prefix (ServerPrefix)":
Configure the server prefix for the dedicated WebUX server.

You can find additional information on using a dedicated Web server in the documentation for 
WinCC/WebNavigator:

● Possible applications of WinCC/WebNavigator > Dedicated Web Server

See also
Functions supported in WebUX (Page 356)
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3.1.8 How to use WebUX

Introduction
To use WinCC/WebUX on the terminals, you only need a Web browser with access to the 
network of the WebUX server.

Note
Windows 7 / Windows 8.1 / Windows 10 on the WebUX server: Limited number of WebUX 
clients

IIS on Windows 7, Windows 8.1 and Windows 10 supports a maximum of ten connections or 
instances. WebUX requires more than one connection for a client. Therefore, a maximum of 
three WebUX clients can connect to the WebUX server.

If the limit is exceeded, you can no longer operate the instances already connected.

Operation in Runtime
Note the following:

● Before you exit the browser, close the session to return an allocated license.

● Close the browser to reduce the power consumption and the transferred data volumes, 
particularly when using mobile devices.
As long as a process picture is open in the browser, its display will be constantly updated.

● Avoid the following operator inputs because they would end the session:

– Browser navigation (Back / Next)

– Reload website (Refresh or <F5>)

Requirements
● The "WinCC WebUX" license installed on WebUX server.

● The WinCC project is configured for WebUX.

● The WinCC project is in Runtime.

Procedure
1. Go to the address bar of the browser and enter the address of the WebUX server.

– https://<servername>

If you do not use the default port, add the port number to the URL:

– https://<servername>:<portnummer>

If you are using a virtual folder instead of a website, add the name of the virtual Web folder:

– https://<servername>/<directoryname>

2. Type in the user name and password.
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Result
Depending on the user rights, you can observe or operate the WinCC project.

3.1.9 Appendix

3.1.9.1 Dynamics dialog Restrictions on expressions / formulas
When you save a process picture for WinCC/WebUX, the dynamization of the Dynamics dialog 
is converted to VBScript. 

Complex expressions and formulas cannot be converted during the conversion. When you 
open the affected dynamization as VBScript, you can obtain detailed information in the Global 
Script Editor.

The following operators and formulas are not converted as a rule:

● Expressions with C function

● Assignment operators:  

● Bitwise operators:  

● Additional operators:  

● Logical operators if the expression is in parentheses:  

● Logical operators for the "Analog" data type:  

● Logical operators for the "Direct" data type for properties that belong to the "BOOLEAN" 
data type:  

========================================
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Publish plug-in, 127
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